


■■ editorial

Q. How do you know when a device has achieved ‘smart’ status?
A. When it has a ‘reset’ function, and an officially accepted security flaw.

Over the last couple of months, a slew of small, startling announcements
add up to a clear turning point for the still humble mobile phone. For
one, almost every phone manufacturer with Bluetooth-enabled phones

has at least one model that gives total strangers around you, complete access to
your phonebook and data. On some GPRS-enabled phones, they may even get
free Web access using your account.

Until recently, a smart phone was simply one that incorporated PDA-like
features. Now, they are busy pulling the ground from under the PDA scene, and
aiming for bigger.

One sign of the impending transformation is that computing resources and
battery power are available aplenty. Nokia announced upcoming support for Perl
and Python scripting languages on their latest models. Scripting languages are
resource hogs, but can be used to put together applications much more easily
than is possible with more traditional tools, and can be credited for making the
Web the accessible dynamic entity it is now.

Snake is passé, with a slew of adventure and strategy games being readied for the
serious gamer. Now, both ATi and nVidia have announced graphics accelerators
for pocket rockets. Pretty 3D effects and snappy graphics on 640 x 480 resolution
colour screens will define the next frontier in mobile entertainment.

And now, for something serious—Toshiba has announced a new 2 GB hard disk,
slightly more than 2 cm wide. That’s two gigabytes of data storage, enough to
comfortably carry an entire My Documents folder in a standard phone body.
This, more than anything else, pushes the smart phone into a new league. You
can actually carry around a useful amount of your work, and put all that
processing power to good use.

But, for a little reminder of reality, the most exciting new feature for phones in
the US is ‘Push To Talk’: A walkie-talkie-like service, which connects you—
instantly—to any individual, or a closed group, without the hassles of dialing
and waiting for a call to go through. 

However, for all the fancy features, smart phones are still communication
devices, and permanently busy phone networks the great leveler.

sumod_hajela@jasubhai.com

“One sign of the

impending

transformation is

that computing

resources and

battery power are

available aplenty”

Smart phone, anyone?

Sumod Hajela
Assistant Editor
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You get to choose what goes on Digit Interactive. 
This month, you have chosen:

Subscribe now...
Get 15 issues for Rs 1,000 (33% off)

or
Get 28 issues for Rs 1,800 (36% off)
Log on to www.thinkdigit.com/subscribe

WEB SPECIAL

WEB SPECIAL

taste technology at www.thinkdigit.com

Be the First 
to know
Paranoid about 
security flaws? We’ll
show you how to stay
informed, and keep
your system as secure
as possible

▼▼
▼▼

Coffee, Snacks and E-Mail   
While Baristas with Wi-Fi access may
seem an extreme proposition, cyber
cafes are looking to a blend of different
models to rein in and retain heir 
customers. We stir up the brew to 
freshen our perspective on this 
social business

Want to brainstorm? Start a discussion? Share an idea?
Log on to www.thinkdigit.com/forum

SUBSCRIBE

FORUM

BY DEMAND

Automize 5.5
Size: 7.86 MB
Mindware

Joan of Arc  
Size: 286 MB
Playware

Expect these on the April 2004 CDs

March 2004
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Abyss Web Server X1
Run a Web server from your desktop
DevTools

AIDA32 System Information 3.90
Know more about your hardware and soft-
ware
System

BootSkin
Change the boot screen of your OS to 
your liking
System

DivX bundle 5.1.1
Watch the latest videos with this codec 
Essentials

Email Effects 1.6
Make interesting graphics using text
Home

Jabber Messenger
Chat on various networks such as MSN, 
Yahoo and ICQ
Internet

JAlbum
Create engaging photo galleries 
Multimedia

myDoom virus removal
Test your PC for this viral infection
System

Peep Show 1.0
Cut see-through holes in windows and
wrap mouse pointer
System

Quintessential Player(QCD) 4.11
Enjoy this feature-filled multimedia player
Multimedia

RssReader 1.0.44
Be in the loop with the latest news at hand
Internet

Torrent Search 1.1
Search for Torrent sources of files you want
to download
Internet

FREEWARE

Play this cool new incarnation of the Pac-Man game in PacBomber. 
Watch the latest movie trailers including Shrek 2, Deewar, Hellboy and 
Around the World in 80 Days.
Listen to some funky new music from Hillbilly Hellcats and others.

The Developer Tools section in your
Digit Mindware CD brings you tools
that you can use for developing soft-
ware applications. The Developer
Tools that we feature this month are
the best tools that will aid you in
your work—Try a free Web server,
play around with a capable hexadec-
imal editor for binary files and cre-
ate standalone help files. Also use
software such as Resource Tuner to
edit the resources attached with a
binary file.

KNOW YOUR CD
MINDWARE\SOFTWARE\DEV TOOLS

ON THE CD

Resource Tuner 1.94 helps you inter-
act with the embedded resource in an
executable.

Winglobe 2.5 take you around the
world to collect various data in a jiffy.

Adobe Photoshop CS Trial is one of

the most feature packed and capable
image editors around.

Mindmanager will help you get bet-
ter organised, and hence more productive. 

Power OS Commandar is a good
alternative for managing files.

Mindware

Playware

MUST TRY SOFTWARE

This month we have a compilation of useful software across various categories and
genre. There’s something for everyone.

Bored with that drab PC of yours? Find on this CD, stuff to pamper you 
and your Windows.
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KKeesssslleerr  aa..kk..aa..  
EEnntteerrttaaiinnmmeenntt  PPCC
■■  WWhhaatt  iiss  iitt??
Intel wants to form a new
home computing platform,
powered by the 90 nm
Pentium 4 Prescott CPU and
supported by the upcoming
Grantsdale chipset. 

■■  HHooww  ddooeess  iitt  wwoorrkk??
Grantsdale features dual-
channel 400/533 MHz DDR 2
SDRAM support, PCI Express,
the next generation of Intel’s
Extreme Graphics and
Azalia—an audio sub-system
with Dolby 7.1 surround
sound. The graphics supports
dual independent-display
support, and the DirectX 9
API. Grantsdale will also
feature a software-based Wi-Fi
access point.

■■  WWhhaatt  ddooeess  iitt  ddoo??
A platform definition that lays
down what an Entertainment
PC (EPC) should contain:
primarily, a Prescott and
Grantsdale, all inside a
consumer electronics-style
casing. The EPC is designed
to work alongside consumer
electronics devices such as
big-screen TVs and hi-fi
speaker rigs, rather than sit
next to a monitor.

hypethesis

Community Web site,
Neowin.net, first
reported a source-code

leak of parts of Microsoft’s
operating systems. The code
was related to NT4 and Win-
dows 2000; Windows XP
inherits some of it. Another
community Web site,
Betanews, stated that the leak
was traced back to Microsoft

partner, Mainsoft, the compa-
ny has access to Win-
dows source-code,
enabling the
i n d u s t r y ’ s
highest level
of Windows
compliancy
on Unix.

Secur i ty
c o n c e r n s

turned real when a few days
later, a hacker
released an
exploit that
injects malicious
code to trigger an
integer overflow
and execute arbi-
trary code when a
special bitmap is
loaded by IE 5.

You may soon be able to
fold your desktop PC and

carry it between home and
office, underarm. At the time
of writing this, Intel plans to
unveil such a prototype.

The prototype has a 17-
inch LCD with a han-
dle on top to
afford porta-
bility. It will be
one of three
models to be
unveiled along-
side two business
notebooks—the
trio are collective-
ly termed Florence. The
system will feature a keyboard
that slides out of the back of
the display. Intel envisions the
unit to be used as a portable

television: Its bevelled LCD
hides a digital camera, speak-
ers and a microphone.

It allows for a telephone
handset for placing voice over
Internet Protocol phone calls,
and a remote for multimedia

functions. Securi-
ty is provided by
a fingerprint sen-
sor and a smart
card reader.

Mike Trainor,
chief technology
evangelist of the
Intel mobile plat-
form  indicated

that the units will be powered
by Sonoma, which comprises
Pentium M processor, a set 
of support chips and a 
wireless module.

Chinese newspaper, The
People’s Daily, claimed

that processors designed by
Chinese engineers will be mar-
keted worldwide, following a
deal with Wyse Technology.

The Arca 2 chips in question
have clock speeds of 400 MHz
and a power consumption of
0.4 W. Wyse will initially use
them in its network computers,
powered by the Blazers OS.

400 MHz dragons 

Sikkim resident, Mridul Seth,
is most likely the youngest

to earn the Microsoft Certified
Software Engineer (MCSE) cer-
tificate. A mere lad of eight, he
has accomplished what people
thrice his age struggle at. He is
believed to be the youngest
MCSE, as on February 12 2004,
he passed the Installing, Con-
figuring and Administering
Microsoft 2000 Professional
Examinations held in Banga-
lore. 

Mridul did not learn to
speak until about 4 years ago.
He was born without an 
external ear and his father,
M.K. Seth, added that he was
often sick when younger. At
four, he learned to count from
1 to 100 within 24 hours, after
which Mr Seth taught him
higher mathematics. 

Felicitated by Prime Minis-
ter A.B. Vajpayee, the family
has now written to the Guin-
ness Book of Records to
acknowledge Mridul as the
youngest person to earn the
Microsoft degree.

MCSE at
eight!

■ In February, Yahoo! dropped Google, and implemented Yahoo! Slurp, its own Web crawler ■  Cisco offers desktop video-conferencing via VoIP 

Mahesh Benkar

Don’t forget your 
desktop, dear!

Hey! You can’t do that…

119 million
LCDs and 30
million CRTs
will be shipped 

by 2007

snapshot

Source: IDC/CNET News.com ➜
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W32.Netsky.B@mm
This mass-mailing worm only
affects Windows 9x, Windows
NT, Windows 2000 and
Windows XP systems. It does
not affect Windows 3.x,
Macintosh, Linux and Unix
systems. A built-in SMTP
engine lets it propagate
through all e-mail addresses
obtained while scanning hard
drives and mapped drives. It
also infects files with
extensions such as  .TXT,
.HTML, .DOC, .VBS and .DBX.
It copies itself into the services
directory and many other
folders, makes registry changes
and degrades system
performance. Access its
removal tool from
http://www.symantec.com/
avcenter/venc/data/w32.netsky
.b@mm.removal.tool.html

Real trouble
Recently, RealNetworks
discovered that RealOne Player
and RealPlayer were vulnerable
to three specific exploits while
executing RealPlayer files with
the extensions .RP, .RT, .RAM,
.RMP and .SMIL. These files
render the user’s system
vulnerable to download and
run any malicious code. The
exploits include executing
remote JavaScript from the
domain of the URL opened by
the malicious file, download
and execute arbitrary code on
the user’s machine, and create
buffer overrun errors.
Download the fix from
www.real.com.

redalert

Source: NASA

Source: VeriSign

When the Mars rovers Landed 
on the Red Planet

Online Commerce
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■ Individuals counter sue RIAA under US government anti-racketeering laws ■ Lindows now features support for Intel’s mobile Centrino technology

A dash 
ridiculous

Lindows will now be
known as Lin---s (pro-

nounced as Lin-dash) in 
some European countries
where Microsoft has blocked
the availability of the desktop
distribution. 

“By removing three letters
from our product name, Lin-
dows.com will not be creating
any confusion regarding
Microsoft’s supposed trade-
mark on ‘Windows’, and still
offer choice in the market-
place,” said Lindows.com
CEO, Michael Robertson. “Any
action from Microsoft to block
Lin---s will show their true
intentions are not to protect
their trademark, but to elimi-
nate competition and main-
tain their monopoly.” This
step was taken by the compa-
ny to comply with an Amster-
dam court ruling. The compa-
ny has also opened new Web
sites—Lin---s.com and Lin-
dash.nl—to support the same.

60 per cent of

all e-mails sent in

January 2004
were identified 

as spam

snapshot

Source: Brightmail Logistics and
Operations Center

PalmSource recently
announced a partnership

with nVidia. It will provide
nVidia with Palm OS Garnet
and Cobalt tools that will
enable creation of drivers for
the GeForce family of media
processors, making them avail-
able to Palm OS licensees. 

The GeForce 2150 media
processor includes a 64-bit 
2D graphics accelerator,
embedded memory for LCD
frame buffer and a 1.3
megapixel camera support. It
also supports TFT and OLED
technology, at up to a 320 x
480 resolution.

Earlier, PalmSource
announced the release of 
Palm OS Garnet, while the
Palm OS 5.x release  has been
renamed Cobalt. 

nVidia for Palm

Microsoft has issued a
warning to users run-

ning its Windows NT, Win-
dows 2000, Windows XP or
Windows Server 2003 operat-
ing systems. The warning
encourages users to immedi-

ately patch their sys-
tems, or risk malicious
hacks through a security hole.
If left unpatched, the hole
could allow a worm to spread
throughout the Internet in a
manner similar to the MSBlast
attack last year.

The flaw exists in
Microsoft's implementation of
a networking protocol known
as Abstract Syntax Notation
One (ASN.1). The code under
consideration is shared by
many Windows applications,

each of which can hence be
used as an entry-point into an
unpatched system by a hacker.
Exploiting the flaw is much
easier if the attacker can access
a local network, an advisory

posted on Microsoft’s Web
site noted. 

The fact
t rans lates
into a large
number of
vulnerable
systems and
thus a good

candidate for
an Internet worm

attack.
The flaw was

first pointed out by
the software firm, eEye Digital
Security, and Microsoft issued
a fix two hundred days later.
Marc Maiffret, of the security
firm termed the  delay as
ridiculous, while Microsoft's
Toulouse said the fix took so
long to create because of the
difficulties posed by such a per-
vasive technology: “This is an
instance where we really had
to do our due diligence.”

Wrong ASN.1! No cookie
for you!

➜
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■  FBI to place piracy-warning seals on all audio and video media sold   ■  Microsoft to ship Windows security updates CDs at no charge

Intel is all set to follow in
AMD’s footsteps by bringing

64-bit extensions to both its
32-bit server chips (Xeon) and
desktop processors (Prescott).
Code-named Nocona, the
Xeons will support PCI
Express, DDR2 memory, the
64-bit extensions and SSE3.

Nocona chips for two-

processor servers will arrive in
the second quarter of 2004,
said CEO Craig Barrett, fol-
lowed by Prescott processors
with 32 and 64-bit capability
for single-processor servers
and workstations. Prescott
and Nocona are functionally
the same, but differ in cache
size and bus speed.

Meanwhile, AMD is ready
to put some money to its
mouth, and shout from the
rooftops that the Intel move is
a validation of its claims: The
future is x86-64. Intel’s 64-bit
extensions will be 100 per
cent compatible with
AMD’s—save a few extensions
to allow for extra registers, etc. 

heroes

Linux security
UK Security firm, mi2g,
analysed 17,074 successful
digital-hacker attacks and
found Linux servers accounted
for 13,654 breaches. BSD and
Mac OS X were at the bottom
of the list with 555 successful
attacks. Windows systems
accounted for 2,005 attacks.  

DVD-copying
software
A San Francisco District Court
judge ordered 321 Studios to
withdraw all copies of their
product and make changes to
their controversial DVD-
copying products. This would
prevent users from using the
descrambling tool to duplicate
copy-protected DVD movies.

zeroes

➜

An organic LED (OLED) is
made of semi-conducting

organic polymers and  is cheap-
er to fabricate. An OLED display
doesn’t require a backlight and
draws far less power. 

A  market research compa-
ny, iSuppli, offers that OLED
displays are becoming a credi-
ble alternative. The Inquirer
(www.theinquirer.net) quoted Kim-
berly Alton, director strategic
research at iSuppli, from a
report called Emerging Displays
Review. Kyocera will develop
colour passive and a-Si-based
active OLEDs . Chi Mei, ID Tech
and IBM demonstrated a 20-
inch OLED panel. Sony will
commercialise an OLED-based
panel in spring this year.

An OLED to
displays

64-bit computing
Microsoft has released a
public preview of the 64-bit
Windows XP for 64-bit
Extended Systems, signaling
a release later this year.
UT2004 will also feature 64-
bit support. Intel also plans
to release a 64-bit version of
their server-targeted Xeon. 

Home Networks
Intel and Microsoft, along
with Canon and BEA Systems,
are working on standardising
the Web services protocol
called WS-Discovery that will
let all sorts of home media
devices interconnect, forming
an ad-hoc network. 

The 2.6.x kernel
release brings a faster
GUI, in tow with

Advanced Linux Sound
Architecture (ALSA) sup-
port, amongst other good-
ies. 

Hot on its heels, is the
3.2 release of the KDE desk-
top environment system,
with improved speed, better
cross-application integra-
tion and a cleaner menu structure. The team
behind Gnome is also at work at a 2.5.x release.
One finds that its Nautilus file manager now
supports spatial browsing; also seen are audio-

mixers using ALSA and a
few tweaks to the
Epiphany browser. This
release branch is on 
its 2.5.5 Development
Release however, so a
usable version is some
ways off.

IBM has announced
its intent to migrate
Microsoft’s Office suite
to Linux.  Microsoft

however, denied any involvement, stating that
IBM is going solo on this ride, further stating
that no source code has exchanged hands to
facilitate such a transition. 

Some Linux with that?

Bluetooth has a serious con-
tender. At the time of writ-

ing this, Intel was all set to
demonstrate its Wireless USB
2.0 technology at the Intel
Developer Forum. The tech-
nology tows high-speed data

transfer up to 480 Mbps over 4
metres, and up to 110 Mbps
over 10 metres. The Bluetooth
1.1 standard can touch 1
Mbps for a distance ranging
from 10 to 100 metres, the

speed dropping with distance. 
Wireless USB will be based

on the multi-band Orthogo-
nal Frequency Division Mod-
ulation (OFDM) technology,
along with the Ultra-Wide
Band (UWB) radio platform

defined by
the WiMedia
alliance. 

Cameras,
camcorders
and MP3
players are
also not too
happy with

the slow transfer speeds
offered by current Bluetooth
implementations; an area 
that analysts clearly see the
Intel-backed wireless initiative 
take advantage of. 

Showdown after sundown

Intel follows AMD’s lead

NASA’s Web site

received 6.5 
billion page views

since January
2004 due to the

Mars mission

snapshot

Source: NASA
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After a personal nod from
President A. P. J. Kalam

Azad, Linux and the open-
source movement made fur-
ther inroads into India. Seven
government and private insti-
tutes plan to use Linux to run
Oracle applications, the com-
pany recently announced.
“2004 will be the year of Linux
in India,” Shekhar Dasgupta,
Managing Director of Oracle
India, said in a state-
ment. “We see the
b a n k i n g ,
g o v e r n -
ment and
e d u c a t i o n
sectors lead-
ing the adop-
tion of Linux
to run mission-
critical applica-
tions.”

The agencies
benefitting from
this move
include the state-owned Cen-
tral Bank of India, Bharat San-
char Nigam Ltd, the treasury
department of West Bengal
and two private banks. Indian
Railway Catering Services and
Tourism said it has chosen Red
Hat Linux to work with 
Oracle’s e-business suite. Linux
will allow for a 30 per cent sav-
ing in IT expenses—about 
Rs 180 million per year.

The major attraction for

government and large organi-
zations towards Linux is two-
fold: price is obviously a factor,
although not a large one, since
supporting an operating sys-
tem is a factor that needs to be
considered; the honey-pot is
the fact that the source-code of
the Linux kernel and its sup-
porting cast is freely and pub-

licly available for scrutiny
and modification. This is

a huge boost to insti-
tutes where
paranoia is a
positive trait,
and security is
paramount. 

To counter
this mindset,
Microsoft recent-
ly announced its
intent to share
the source-code

of its Windows family
of operating systems
with Asian governments
and institutes. Indeed,

after the success that Linux was
enjoying in the Thai market-
place, Microsoft began offering
Thai citizens a bundle of
Microsoft Windows XP Home
and Office XP Standard. Plat-
form-jumping is a rare event in
both a consumer’s and a busi-
nesses’ life-cycle; Microsoft
obviously wants to capture
upcoming markets before
Linux gets a toe-hold.

Linux shining

■ Adobe server software to help restrict access to electronic documents in workplaces  ■ StreamCast Networks to unfurl low cost Net telephony service 

Canon India recently set
up India’s first two Digi-

tal Imaging Solutions Labora-
tories for enterprise users in
New Delhi and Bangalore.
The lab is going to be a testing
ground to try out new inno-
vations and ideas for busi-
nesses of all sorts. It will sim-
ulate real business environ-
ments and allow their cus-

tomers to inspect, test and try
out proposed ideas and solu-
tions in the fields of docu-
ment management, transac-
tion printing, and colour
applications for offices and
enterprises. This can be done
at minimal costs. Canon
claims to have spent Rs 60
crores on the lab, and has
expansion plans in mind. 

Enterprise shutterbugs, only

Dragooning spam 
The Chinese government is
taking the problem of spam
seriously and is fighting hard
against it. Recently, the
Ministries of Public Security,
Education and Information
announced an anti-spam
campaign that also targets
reactionary spam.
‘Reactionary’ is a political term
used for individuals and
content considered to be
threats to the Chinese
government. 

In February this year, the
Internet Society of China (ISC)
identified 626 servers,
including 68 in China and 6 in
Hong Kong as sources of
spam. ISC said that they have
taken some measures such as
getting e-mail providers to
adopt anti-spam technologies. 
However,many Chinese
servers are working as spam
relays due to the rapid
Internet expansion. Thus,
those run by China Telecom
and China Netcom
Communication Group have
also been blacklisted as 
spam relays. 

Spam over the Instant
Messaging (IM) or SPIM is not a
big problem now because the
username list for IM clients as
well as the tools to mass
message are not commonly
available. 

Yahoo! has already taken
measures to prevent misuse.
First, while registering, you have
to go through an image-
verification test that automated
systems cannot pass. It also
blocks users who send
unusually high number of
messages.  

Microsoft also lets you see
the list of people who have
added you on their list in its
new version (6.1). You can
choose to block messages. 

Spam
Now it’s IM’s turn

➜

Google currently

indexes over

6 billion 
documents;

4,28,51,99,
774 of which are

Web pages

snapshot

Source: Google, Inc

64-bit computing for con-
sumers is now several steps

closer to fruition. The con-
tenders are: The x86-64 solu-
tions from AMD, i.e., the server
chip, Opteron, and the desktop
chip, AMD 64, an x86-64 Intel
Pentium 4-based Prescott chip
for the desktop, and IBM’s Pow-
erPC 970FX for Apple-based
solutions. 

The IBM solution won the
Microprocessor Report Analyst’s
Choice Award for Best Desktop
Processor. It is a 90-nm, but
unlike the Intel processor, it
consumes far less power. IBM
claims that the 970FX draws
about 25 W running generic
applications at a speed of 
2.0 GHz—50 per cent lesser
than the PowerPC chip that
powers the Apple G5. Compare
this to Pentium 4 3.00E (the
Prescott), which puts out 89 W
of heat and the efficiency
becomes apparent.

The Pentium 4 CPUs, with
1 MB L2 cache on the 90 nm
process, will be tweaked to
improve its power rating. At the
Intel Developer Forum, Febru-
ary 2004, Craig Barrett of Intel
confirmed that Nocona, its
next generation of server
processors—Xeons and desktop
Prescotts will both get 64-bit
extensions later this year. Sup-
porting the move is Microsoft’s
OS-level support: A beta version
of Windows XP for the x86-64
is already doing the rounds.

The 64-bit itch
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"I may have
invented
[Control]+[Alt]+
[Delete], but Bill
Gates made it 
really famous"

David Bradley, now retired
IBM employee who did
pioneering work on the
original IBM PC. Bradley 
was speaking to a gathering
on the 20th anniversary of
the PC. 

"I never expected 
it to be precise.
It turned out to 
be much more
precise than I 
ever imagined" 

Gordon Moore, 
Co-founder of Intel, 
who formulated Moore’s
Law, which states that 
the number of transistors on
a chip would double every
year, and later, 20 months;
Intel executive, David House,
later accurately re-calculated 
it as 18 months. 

"There’s no reason
to wait 
for any other x86,
64-bit technology,
because we have 
it now, we’re
shipping it now"

John Robinson, AMD’s
country manager for
Australia and New Zealand,
talking to iTnews Australia.
Robinson claimed to 
be baffled after Intel
announced its plans of
shipping new Xeon
processors with 64-bit
extensions on the 
existing 32-bit core by 
the next quarter. AMD 
has already got a 64-bit
processor for the desktop,
the Athlon 64.  

quoteworthy

Intel researchers have devel-
oped a silicon-based optical

modulator operating at 1
GHz—an increase of over 50
times the previous research
record of about 20 MHz. The
device incorporates a transis-
tor-like structure to encode
data onto a wavelength of
light. The modulator splits the
incoming light beam into
two. These are then phase-
shifted to change the ampli-
tude of the resulting, recom-
bined beam. The result is the
ability to change light from
bright to dark and thus,
encode data. 

This allows for faster con-
nections between PCs, servers,

and manufacturing of faster
buses and interconnects inside
a PC. While CPUs are project-
ed to meet future bandwidth
demands, the bandwidth of
the interconnects needs to be
increased to prevent bottle-
necks. Photonics (using pho-
tons as data carriers instead of
electrons) offers greater band-
width than copper networks,
and carries multiple signals
simultaneously without inter-
ference. However, commercial
photonic devices are difficult
to assemble and expensive.
This high cost limits the their
use to special applications
such as telecommunications
and wide-area networks. 

Siliconnect

There’s been a lot of India-
related news in the inter-

national job and outsourcing
front. The American state of
Colorado voted to postpone a
bill that prevented jobs from
going to offshore workers,
especially for state contracts.
US businesses find outsourcing
to India a cheaper deal than
getting work done locally.
Moreover, India’s big pool of
talented and highly skilled
workers works for far less than
their American counterparts.

In related news, the US
government has exhausted
their current quota of H1-B
visas for the current fiscal year,
with no visa applications
being accepted until April
2004, and none being issued
till October of this year. The
H1-B visa programme attracts
large numbers of skilled Indi-
an technologists, and has been
very controversial in the US. 

In yet another develop-
ment, a US Congressional
panel raised concerns on the
apparent misuse of L-1 visas
that allow companies to get in
skilled workers in executive
and managerial positions, with
no limits on the numbers
issued, or a required pay limit.
Witnesses allege large-scale
cases of fraud to get in tempo-
rary workers into the US, 
and the associated loss of jobs
for locals. 

India Inc.’s
roll

Take a digital camera, and
you have found yourself a

Charge Coupled Device
(CCD); move lower down the
digital chain to that camera-
phone you have been eyeing,
and a Complementary Metal-
Oxide Semiconductor
(CMOS) stares back.
Both the technologies
are meant to capture
images, but they differ
in cost and quality
offered.

A CCD is ideal for
high-quality captures,
and has good low-
light sensitivity. How-
ever, it is expensive to
produce and a drain on the
batteries. A CMOS is cheap to
make, and lighter on the bat-
teries. Its image quality how-
ever, leaves much to be
desired. Can’t have it all… or
can you?

Japanese major Matsushi-
ta has taken the first step
toward creating Maicovicon, a

hybrid sensor that has the
advantages of both the chips.
EETimes reported that Maicov-
icon consumes less power
than a CCD, and offers high-
er image quality than a CMOS
sensor. It will be available in

1.3 megapixel and 2 megapix-
el versions with a pixel size of
2.8 mm square. Photosensi-
tivity is about three times that
of CMOS sensors and almost
equal to that of CCD sensors. 

This hybrid should herald
a new wave of low-powered
devices sporting affordable
and better-quality cameras.

Smile, you’re on CCD

■ Intel committed to offering full-scale Linux driver support for their hardware using the same driver update and release cycle as that for Windows   

The value of Time
Warner Inc.
is now US$ 42
billion lesser than

their value before

merger with AOL

snapshot

Source: Fortune

tomorrow’s technology
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Your vote counts
This month’s question:
Have you bought a new PC or a laptop, or upgraded your 
system, after low prices following the mini-budget?

! Yes, I bought a PC ! Yes, I bought a laptop
! Yes, I upgraded ! None of the above

Log on to www.thinkdigit.com and vote

Price, please!I bought a branded PC last September, and it was also

the day I bought Digit for the first time. I have not

missed a single copy of the magazine ever since. Well, 

I just could not afford to. May I suggest something?

Digit should include prices of major PC components

such as RAM, motherboards, graphics cards, etc. 

It will be a great value-add for readers like me.

Abhishek SoodVia e-mail

Dear Abhishek,
Your suggestion is priceless.At Digit, we have contemplated print-
ing prices of components a lot of times, and which is why we
have the A-list (found on page 86 and 87). Here, we list the prices
and the contact information of components in two categories—
Best Value and Best Performance. However, we are hampered by
the fact that these prices fluctuate at regular intervals, usually
within days. And because Digit is a monthly magazine, the prices
at the time of printing may not be the same as when you receive
the copy at home, or when you pick it up from the newsstand.

No - 3.9%

Only if the
prices dropped

87.2%

I already 
own one!
3.2%

Responses: 6480

Nahi CDsi baat
I was disappointed with the February 2004 issue.The CDs did not auto-play. I installed the Flashplayer, yet the CDs didnot run, and all I got wasa blank white screen. Asa last resort, I went backto the basics—opened myWindows Explorer andright-clicked the CD driveto open. I got all the

software I needed, but itwas a boring experience,since I missed your
design.
Upneet Shah
Via e-mail

Cell ‘n’ accelerator

Firstly, my heartiest congratulations for three great

issues in a row—December, January and February.

Every issue was packed with cool stuff, including

extra CDs, the Zero1 awards and of course, the 

Ice Age VCD. Now I am eagerly awaiting a 

full-fledged edition on cell phones. Hope you won’t

disappoint me. 

Ashish Pawar

Via e-mail

I am studying to be a computer engineer, and I

make it a point to go through all the PC and

technology magazines available at the newsstand.

But the Digit February issue was the best. Does it

rock, or what! I found the reviews of motherboards,

RAM chips and processors quite helpful. 

When are you reviewing graphics accelerators,

especially since they are now affordable? One more

observation: The article on LiLo was brilliant, and it

is a good beginning!

Avik Chakraborty

Via e-mail

Hello Upneet,
The reason your CDs did not run despite
installing the Flash player from the CD is
because some of the components are still
missing on your PC. The best option, in this
case, would be to download the Flash player
directly from the Macromedia site. It is only a
480 KB plug-in, and should not take more than
a minute to download. Once installed, please
close your browser window, and start the CD
interface again.

Dear Ashish and Avik,
First of all, thank you for those kind words. Of course we will
review cellphones, Ashish. Since we cover the entire gamut of
technology, we were bound to cover a lot other things too. But if
you read our Bazaar section for the last six months or so, we
have been reviewing cell phones regularly. This month, too, we
have tested and reviewed the Handspring Treo 180 PDA phone
and the Nokia 6600 camera phone (turn to Page 88 of this issue
for more).

Nothing pleases us more than to hear that our readers 
liked Digit, and found it useful. We will definitely incorporate 
your suggestion in the forthcoming issues.

pulse ■
■ letters

Q. Would you buy a high-end graphics card?

Jai Hind
With the launch of MicrosoftOffice in Hindi, the companyhas fulfilled a long-standingdemand of the Indian market.India is a country where onlyfive per cent of the populationcan communicate and work usingEnglish. Yet, all the softwareavailable was essentially for thissmall minority.
The readership of Hindinewspapers far outnumbers readership ofEnglish newspapers, yet Hindi readerscould not communicate well with themedia companies because they lacked agood Hindi interface on their PCs. Since Microsoft Office (Hindi)

allows use of English, as well as nine other Indian languages in the
same system, union and state governments should instruct their
departments and undertakings to switch over to this for effective e-
governance.
Madhu Agrawal
Via e-mail

Dear Madhu,
You could not have been more accurate in your assessment.
Communicating in the peoples’ language is the hallmark of any e-
governance model. Both, state and union governments in India,
have been using regional language software for some time now, so
Microsoft's Hindi language tool is not groundbreaking. Yet, it is also
true that Microsoft’s Office suite is the most commonly used PC
application. Your suggestion, in that sense, definitely holds merit.

Mahesh Benkar

Yes - 5.7%
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E-mail: readersletters@jasubhai.com
Send your letters marked ‘Readers Letters’ to the Digit office: 

D-222/2, Om Sagar Building, MIDC, TTC Industrial Estate,  Nerul, Navi Mumbai 400 706 
Phone: 022-27629191/9200  Fax: 022-27629224

" On the contents page,
the image for Own your
E-mail, erroneously states
its page number as 74. It
is, in fact, 82.
" The winner in the
Intel low-end mother-
board category is the
Mercury Pi845GLM-L
board, not the Mercury
PS650GXM-L as the 
caption on page 48 
suggests.

Notice any goof-ups? 
Write to goof@jasubhai.com

Goof Ups

Map for Lam’ Rd
Dear Sir,
I am a Sri Lankan citi-zen, and a regularreader of Digit.Sometime ago, Iread about thesecondhand

dealer shops
in Lamington
Road in Mumbai. Iplan to be in Mumbaisometime soon. I’d like Digit’s helpin understanding 1) Where is Lamington Road

and 2) Are shops on Lamington Road open on
Sundays?
Darrel Silva, Sri LankaVia e-mail

Dear Darrel,
Lamington Road is a fairly large area in South
Central Mumbai where you would find all 
kinds of electronics and IT dealers. Indeed, for
Mumbai’s citizens or even for others, this place
is a virtual IT paradise as far as buying goods
are concerned. If you are in Mumbai, all you
need to do is hop into any cab, and ask him to
head straight for Lamington Road. And oh, don’t
go on a Sunday—most shops will be closed.

Planet Digit Feedback

Karan Mehta
Adios amigos,
take care

The Winner of the ‘Post your best Planet Digit Experience’ contest is...

Howdy fellow techies! Planet Digit is the place to be. You have to be here 
to see what a 61-inch flat screen by Samsung looks like. Anyway, my best expe-
rience is as follows... 

As I was waiting for my father to fill up the forum, my eyes fell on the 
‘I will sketch you too!’ poster, to get sketches made by Mr Mahesh Benkar. 
As a great fan of Mr Benkar’s illustrations in Digit, I waited my turn. I grabbed
the opportunity to meet him, greet him and congratulate him for all the
wonderful illustrations that have made the dullest of articles interesting.
Meeting him has been an amazing experience, which I will not forget. 
To top it all, Mr Benkar has invited me to visit him at his Digit office... 
like a cherry on the cake!

Posted: Sun Feb 01, 2004 5:35 pm

Gentlemen, kudos for the
magnificent non-performance of
Planet Digit Chennai. 

The least one would have
expected is a small ad in
newspapers announcing the
cancellation, whatever may be the
real intentions. Who is the real

culprit—Digit or the participants?
Whatever the cause for this

Event of Jokers 2004, today I am
ashamed to call myself a Digit 
subscriber.
In disgust, 

P C Vaidyanathan
Via e-mail

First the brickbats—the event was
hyped beyond reason, and as a 
result, I was disappointed. Your
advertisements in newspapers were
misleading. The Samsung pavilion
had a lot of cool stuff, but occupied
almost the entire ground floor. Then, 
your Gaming Drome was not as
advertised. OK, now for the good
stuff: I had a ball playing Unreal
Tournament 2003 while it lasted. 
I even won two or three rounds. 
The small games were a nice touch,
but honestly, you should have priced
the coupons lower. 

Vivek Singh
Via e-mail

The cancellation of the Chennai
Planet Digit was a pity because I did
not get your e-mail about the
cancellation. I was disappointed
because there was nobody from
Digit there. All I could see was a
message on the wall regarding the
postponement, and something
about a gift to make up for the
disappointment. But how could you
have given away gifts if there was
no one around. Moreover, no one
knew where TNTPO is. And very
few people knew that it’s popularly
called the Chennai Trade Centre.

K P Gopal
Via e-mail

Planet Digit, a technology event by Jasubhai Digital Media, the parent 
company of Digit, was held successfully in Mumbai and Bangalore, where more
than 20,000 people visited. However, it was cancelled in three cities—Chennai,
Delhi and Kolkata, which led to some readers complaining about it. Here is some
feedback we received.

Planet Digit’s aim was to create a live demonstration of cutting edge technology applications that
Digit's readers only got to read about. While the who's who of India's IT sector participated in Planet Digit,
there were only a few companies such as AMD, Samsung, Apple and HP who could demonstrate the
practical applications of technology.

Based on reader feedback in the first two cities—Mumbai and Bangalore—we found it was not worth
our readers’ time to just come and see products on display without any applications shown on it by a
majority of the companies.

Rather than disappoint our readers in Kolkata, Delhi and Chennai, we decided to suspend Planet Digit
at these venues and come back with a show where our partners truly live up to the promise of delivering
great technology solutions through demonstrations, rather than build a product gallery for our audiences
who already know their product range well.

Team Digit
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Michael P. Frank, as a graduate at MIT,
designed one of the first universal DNA
computers, and discovered that it 

had to be reversible for fundamental thermochem-
ical reasons. Since his graduation from MIT in 1999,
Mike has been continuing his reversible computing
research as an Assistant professor at the University
of Florida’s Department of Computer and Informa-
tion Science and Engineering. Digit caught up with
him to speak about reversible computing.

■ What is reversible computing?
Reversible computing—revcomp for short—is the
application of principles of recycling to computing.
When a computer performs a logical operation, the
unwanted bits after the operation are thrown away,
and dissipated as heat. There is a limit on how far
we can keep doing this. If we want computer
speeds to keep on increasing, we need to ‘uncom-
pute’ the unwanted bits. 

Reversible computing means computing using
a physical mechanism that is thermodynamically
reversible—one that ballistically coasts along
through its computation with low friction. Thus, it
will dissipate only a small fraction of a bit’s energy
to heat with each logic operation.

If a computation is thermodynamically rever-
sible, it would need to be logically reversible as well.
Performing any desired computation is still possi-
ble, despite this constraint. But it strongly affects
digital logic designs. In the long term, it will impact
instruction sets and high-level programming lan-
guages as well. Eventually, these will also have to be
reversible to provide optimal efficiency.

■ Why do we need reversible computing?
With device sizes fast approaching atomic-scale
limits, more energy efficiency is essential. Energy 
efficiency fundamentally affects the speed of cir-
cuits—such as nanocircuits—and therefore the
speed of most computing applications. Ballistic cir-
cuits that conserve information, by uncomputing
bits instead of throwing them away, will soon offer
the only physically possible way to keep improving
energy efficiency.

■ What is a ballistic circuit?
A ballistic process is a process in which a system
proceeds forward under its own momentum, with
only a small fraction of the free energy in the sys-
tem being lost to heat. For example, when an ICBM
(Inter-Continental Ballistic Missile) makes a flight
between continents, it ‘coasts’ (movement of a
vehicle with hardly any generation of heat) for most

of its journey, with only a small portion of its poten-
tial and kinetic energy being lost to friction during
its trajectory through the atmosphere.

■ How soon do you think revcomp is going
to become important?
It will become important when the chip-making
industry runs out of other tricks for reducing the
energy cost of logic operations. Throughout the
history of the industry, it has been reducing the
energy cost of logic operations by reducing bit
energies; but, there are some absolutely irrevoca-
ble limits to this process. These limits will be
reached within the next three decades. This has
to do with the fact that the density of all of the
physical information that is present in materials at
normal temperatures and pressures is finite, and
moreover, it is quite limited—at most, a small
handful of bits per atom. We can never store a log-
ical bit using less than 1 physical bit, and the irre-
versible transformation of a physical bit results in
heat energy that must be expelled into the envi-
ronment. In room-temperature environments, this
results in a strict maximum of about 300 billion
billion irreversible bit-operations that can be per-
formed per Joule of energy consumed. This may
sound like a lot, but we are only about a factor of
1,00,000 below this point. If past trends continue,
we would expect to reach this point in only anoth-
er 25 years, or so.

■ Why do we need to bother about it now?
To make reversible computing practical, there are
many difficult engineering research problems that
remain to be solved, such as the design of extreme-
ly high-quality oscillators. If we don’t start working
hard on developing solutions for these now, there
is a significant danger that solutions will not be
ready when traditional approaches run out of
steam. If this happens, the development of com-
puter technology will stall—no longer will we be
able to expect that every year we will be able to get
a more powerful processor with lower power con-
sumption, which can be utilised for new applica-
tions not previously possible.

This can have a significant braking effect 
on the growth of the entire world economy, 
since productivity growth in many industries today
relies largely on the increasingly extensive applica-
tion of information technology. The rate at which IT
can penetrate into new application areas will dras-
tically slow down, if the performance-per-
unit-power-consumption of digital technology
stops improving. 

RReevveerrssiibbllee  CCoommppuuttiinngg

Our 
civilisation 
will depend on
exploring the
problems that
reversible 
computing
poses

“ “

➜



30 MARCH 2004

pulse ■
■ spotlight

■ If we do see a reversible computing device
in as soon as 25 years, what will it look like?
If not a desktop or a laptop, what will it be?
I believe that desktop and laptop—or maybe
wearable, or even implanted—personal comput-
ers, will be a major potential area for application
of revcomp technology. For example, powerful
‘personal assistant’ and ‘intelligent agent’ type
applications might be built, using sophisticated
artificial intelligence techniques. These algorithms
require extremely high-performance computing
capabilities. The more performance you have, the
‘smarter’ these techniques can become—with
essentially no limit. Reversible computing is ideal-
ly suited for running these artificial intelligence
algorithms, because they can all leverage a very
high degree of massive parallelism. 

If this is available, these algorithms do not even
require extraordinarily high sequential perform-
ance. For comparison, individual neurons in the
human brain, fire at frequencies of only about
1 KHz. Because there are on the order of 1 billion
billion synapses packed into your skull, this trans-
lates to a total rate of about 1 quintillion (1018 ) syn-
patic operations per second. This is about a thou-
sand times greater than today’s desktop computers.
So, we can expect that achieving capabilities com-
parable to the human brain will require at least a
thousand times greater performance than any
desktop computer has today, as well as sophisti-
cated AI algorithms. However, the example of the
brain teaches us that intelligence does not neces-
sarily require the individual devices to operate at
extremely high frequencies.

The goal of AI, thus, fits perfectly what
reversible computing offers, which is a much larg-
er overall rate of operations within a given power
budget. This will be achieved through massive
parallelism of large numbers of extremely energy-
efficient micro- or nano-scale devices. These can
individually operate at only a moderate speed,
which is required in order to maintain their high
energy efficiency.

■ How realistic is the 25-year timeframe you
spoke about for reversible computing to
become mainstream?
I do not know for certain whether the semicon-
ductor industry will continue to find it economical
to continue taking conventional computer tech-
nology forward for as long as 25 years at the same
rate that the technology has been progressing for
the last 40 years or so. It is very difficult to say,
because many problems to further progress loom
close ahead, yet many ingenious ideas have been
proposed that may push the limits a bit farther out.
However, the point is that at whatever time the
conventional approaches run out of steam and stop
improving so quickly, reversible computing will
then be the only way to rapidly introduce further
reductions in power dissipated per unit of per-

formance. If the traditional approaches hit a 
practical limit and stall in considerably less 
than 25 years, then so much the better for 
reversible computing!

■ You spoke about micro- or nano-scale
devices, and massive parallelism. Where is
the intersection between nanotechnology
and reversible computing?
The fundamental limits on the energy efficiency of
conventional semiconductor-based computing also
apply identically to all possible nanotechnologies.
As a result, nanotechnology, if not augmented by
reversible computing, can only inch us a bit closer
to the limits of irreversible computing than semi-
conductors might be able to get, but it cannot take
us beyond these limits. The only way that nan-
otechnology can possibly circumvent energy dissi-
pation limits, and keep computer performance
improving beyond the next two or three decades,
is if it wholeheartedly and thoroughly adopts
reversible computing principles. 

In the 1980s and 1990s, K. Eric Drexler and
Ralph Merkle, the pioneers of nanotechnology, 
discussed the need for reversible computing in nan-
otechnology, and designed a wide variety of
nanoscale mechanical and electronic reversible 
logic mechanisms.

■ If reversible computing is so fundamental
and important, how come we’ve never
heard about it until now?
The lack of attention to reversible computing has
been due to a stew of misconceptions about
revcomp that have been floating around. For
instance, myths circulate that reversible comput-
ing has been proven impossible, or that it violates
some law of thermodynamics, or that it is funda-
mentally impractical. None of these myths are
true—no valid proof of any of these claims exists
anywhere in the literature. I know, because I have
spent years searching for one—since I have no
desire to waste my career pursuing an impossible
goal! There have been a number of attempted
proofs of the impossibility of reversible comput-
ing, but all of them contain either fatally-flawed
assumptions, or logical fallacles. 

It is not an exaggeration to say that the entire
long-term future of computing technology, and
indeed of our entire civilisation, will depend on
exploring the problems that revcomp poses. We
need to start seriously tackling these problems
today, or we risk hitting a technological plateau
within the next 30 years. And, if the industry ever
becomes accustomed to a state of stagnation rather
than of growth, who knows how long it will take us
start things up again? For us to ignore reversible
computing today seems a far more dangerous
strategy than for us to pursue it with vigour.

RAM MOHAN RAO

ram_mohan@thinkdigit.com
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The world’s hunger for processing
power is insatiable, and for storage
capacity and speed, even more so.

Storage devices—both volatile, as in
RAM, and non-volatile, as in hard disks—
are always getting larger and faster. New
technologies and methodologies seem to
be forever on the horizon. Recall that
when Intel released the original Pentium,
it was believed by many that a limit on
the number of transistors that could be
crammed onto a chip was being
approached. Will there ever be some sort
of fundamental impediment to further
development? 

Not if research continues at the cur-
rent rate, driven by worldwide, expo-
nentially ever-increasing demand. Stor-

age research is looking at everything—
from materials to fabrication methods, 
to novel techniques. And every once 
in a while, something comes up that
takes performance up by an order 
of magnitude.

It seems that the industry will 
continue to deliver—you’ll have a 
terabyte hard disk a few years from 
now, and a pentabyte one a decade later,
with RAM to match. 

Hard disks
The hard disk, the mainstay of personal
and corporate storage, has faithfully
obeyed the exponential law. This has

happened largely due to increases in
areal density, that is, how many bits are
crammed into, say, a square inch. A lot
of research in storage focuses on how to
improve areal, and therefore data, den-
sities. However, in a couple of years, a
limit on the areal density that disks can
achieve will be reached. This limit will
be due to the superparamagnetic effect.

Bits on a hard disk are encoded by
changing a magnetic property of the disk
material—the spin. The superparamag-
netic effect (SPE) happens when bits are
crammed too close together. When this
happens, the energy holding the mag-
netic spin in the atoms making up a bit
becomes smaller, and comparable to the
thermal energy of the atoms. This means

that the bits may get demagnetised—
they may randomly change (flip) from
zeroes to ones, or vice-versa, leading to
data corruption. The SPE may become
important as early as next year.

Perpendicular recording
Several techniques are being looked into
to overcome the SPE, and therefore allow
one to cram more bits together, while
preventing them from flipping. These
include using different magnetic mate-
rials more resistant to the SPE, using an
entirely different kind of material such
as plastic, and changing the bit orienta-
tion on the disk from longitudinal to

perpendicular. Of these, the last—called
perpendicular recording—holds the
most promise, and is widely believed to
be the recording technology of the
future. The concept is simple: in con-
ventional-longitudinal-recording, the
magnetisation of the bits is parallel to
the direction of the movement of the
head. With perpendicular recording, the
bit magnetisations would be perpendi-
cular to the head movement.

Dr Mark Kryder, Director of Seagate
Research, says there’s time before longi-
tudinal recording will need to be widely
employed. According to Dr Kryder, the
switch to perpendicular recording will
occur at an areal density of somewhere
between 100 and 200 gigabits per square

inch. This switch would open up the
potential for unprecedented areal densi-
ty increases. He says, “We estimate that
perpendicular recording methods may
take us all the way to one terabit per
square inch. When that level is reached,
a single 3.5-inch disk will store over one
terabyte of information.”

OAW technology
Quinta Corporation, a subsidiary of Sea-
gate, combated the SPE limit in 1999
with its Optically Assisted Winchester
(OAW) technology. In OAW, instead of
using a regular head to read and write
data off a hard disk platter, a laser is

M
ah

es
h 

Be
nk

ar

features ■
■ technology next

Store?Store?WHAT’S 
in

...for hard drives and memory



MARCH 200433

used—this makes for extreme precision.
The polarisation of a light beam is twist-
ed when it bounces off a magnetised sur-
face. When this is passed through a
polarising filter, the intensity of the
beam gives the magnetic alignment of
the part of the surface that it touched—
this is how the disk is read. For writing,
the same laser heats a dot on the disk to
a temperature at which the material’s
magnetic properties can be changed—to
reflect either a one or a zero—using a
magnetic coil.

Essentially, since a laser is so precise,
it can focus on areas much smaller than
are used to represent a bit on a tradi-
tional hard disk. This makes for higher
data densities.

AFC media
In 2001, IBM demonstrated yet another
way to get round the SPE: a three-atom-
thick layer of ruthenium, sandwiched
between two magnetic layers. Known as
Anti-Ferromagnetically-Coupled (AFC)
media, the multi-layer coating permits
disks to store 100 gigabits per square
inch, as of now. The ruthenium layer
makes the adjacent layers orient them-
selves magnetically in opposite direc-
tions. When bits are written onto layers,
they can be placed closer together than
if a single layer were used—meaning
higher areal density.

Patterned-media recording
One bit on a disk is stored as a group of
several small grains. Each of these grains
is thermally unstable, and the SPE comes
into play. In patterned-media recording,
one bit is stored by one grain; a grain
can, therefore, afford to be larger. Thus,
data integrity can be maintained at very
high densities, ranging from 100 gigabits
per square inch to tens of terabits per
square inch.

Patterned media refers to ultra-high
density magnetic storage media consist-
ing of arrays of discrete, lithographical-
ly patterned magnetic elements, each of
which can store one bit of data. Each
discrete element is isolated from other
elements, but inside each one, polycrys-
talline grains are strongly coupled,
behaving more like a larger, single mag-
netic grain. Because the SPE limit applies
to the entire bit, not to each of the
grains, the single bit in patterned media
can be much larger than the one in con-
ventional media. The problem with pat-
terned media is that there are no cheap
mass-manufacturing procedures.

Probe storage: IBM’s Millipede
The tip at the end of a cantilever makes
for the ultimate in local confinement 
of interaction. This makes tip-based stor-
age technologies natural candidates for
extending the physical limits being
approached by conventional magnetic
storage. Probe storage technology makes
indentations 10 nm (nano metres) in
diameter on a plastic film. Each inden-

tation is a bit, which can be heated back
to its original shape. Thousands of tiny
probes—tips at the end of a cantilever—
move back and forth over the film.
Because of the many probes (‘feet’),
IBM’s codename for this technology is
‘Millipede’. There are problems inherent
in this idea, and IBM’s solution was to
use micro-electro-mechanical systems
(MEMS)-based arrays of cantilevers oper-
ating in parallel, with each cantilever
performing write, read and erase opera-
tions in an individual storage field.
Probe storage is expected to use just
about as much power as a flash card, but 
store up to 100 times as many bits as tra-
ditional disks.

Flash memory
Companies need to keep shrinking Flash
memory as portable devices get smaller—
cell phones and digital cameras, for exam-
ple. Flash sticks transfer data fast and, 
like hard disks, don’t need to be powered
on to retain data. These sticks don’t 
have moving parts, so they’re much 
more rugged.

! Holographic Storage: Holograms,
unlike, say, regular cameras, record not
only the intensity and colour of light, but
also its direction. As a result, holographic
crystals record data in three dimensions.
This means that data is stored over the
volume of the crystal, not its surface.
Holographic storage has promised
storage densities of one terabyte per
cubic cm.
! Areal density: The areal density refers
to how densely bits are packed on the
surface of a material or device, for
example, a hard disk platter.
! Cantilever: A cantilever is a horizontal

fixture, such as a mechanical arm, that
projects beyond a vertical support, and is
unsupported at one end.
! Nanocrystals: Nanometre-sized
semiconductor particles. Due to their size,
they don’t behave like bulk materials, but
like atom-sized quantum entities.
! Pipelined operation: Say an
instruction has three parts to it: fetch,
read data and execute. A processing 
unit is doing pipelined operation if, for
example, it routinely does the ‘read data’
part of instruction #2 while doing the
'fetch' part of instruction #3, like in an
assembly line.

Jargon Buster
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It’s becoming increasingly difficult for Flash memory to
shrink, and therefore, to obey the exponential law. The reason
hinges upon the way Flash memory works: memory cells in
Flash sticks are transistors whose gates are wrapped in a layer of
silicon dioxide that prevents electrons from escaping. The cell
holds a one or a zero, depending on the charge in the transis-
tor. The problem is that the silicon dioxide insulating layers are
about 90 angstroms thick; and at 80 angstroms, the layer will
no longer be as effective.

Although companies such as Intel agree that the issue 
is currently manageable, making Flash chips with a component
size of 45 nm will be difficult. And the 45-nm manufacturing
process is set to begin in 2007. Companies, therefore, are 
looking at alternatives—nanocrystals, Ferroelectric RAM
(FeRAM), Magnetic Random Access Memory (MRAM), Ovonics,
and polymers.

The use of nanocrystals promises to halve chip sizes by
using a lattice of silicon crystals as the insulator, instead of the
silicon dioxide layer. At the nanoscale, silicon behaves as an
insulator. Silicon-Oxide-Nitride-Oxide-Silicon (SONOS) is
another similar alternative that’s being researched.

FeRAM is non-volatile, like Flash. However, it’s much faster,
and consumes less power. The disadvantages include lower den-
sity and higher cost. FeRAM stores data by using an electric field
to shift the position of individual atoms in crystals.

Ovonics is very different from traditional electron-based stor-
age; it induces a charge by a chemical process. After rapidly heat-
ing an alloy substrate similar to the material used in CD-RWs,
dots representing ones and zeroes are created in the alloy: a one
is encoded by creating a crystalline dot, and a zero is encoded by
creating an amorphous dot. The bits are retrieved by measuring
the change in electrical resistance between the alloy’s crystalline
and amorphous states. Ovonics promises to be much faster than
Flash, and can be re-written many more times. The problem, cur-
rently, is that its fabrication process is expensive.

Intel and other companies are developing polymeric ferro-
electric RAM (PFRAM), also known as plastic RAM. The tech-
nology involves sandwiching a thin polymer sheet between two
perpendicular layers of metal strands. A memory cell is formed
at the intersection of these strands, and data is stored by chang-
ing the polarisation of the polymer between the strands. PFRAM
is a low-power technology. The manufacturing process is sim-
ple. And there are cost advantages too: PFRAM requires only a
single layer of CMOS circuitry, and can stack up eight layers of
inexpensive polymer material. The drawback is speed—read and
write speeds don’t compare with that of today’s Flash chips.
Hence, application may be limited to memory sticks.

RAM
Double Data RAM 2 (DDR2) and Graphics DDR3 (GDDR3) 
are already here, and you can expect to see them in desktop
systems very soon. Other new and experimental technologies
are on the horizon, all promising that the exponential law for
RAM continues for at least a couple of decades to come. It
remains to be seen whether RAM will replace the hard disk as
mainstream storage.

DDR2
DDR is the current memory standard for most personal com-
puting systems; and DDR2 DIMMs have already been manu-
factured. DDR2 starts where DDR left off; it’s faster, and

1/2 page V AD
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consumes less power. The first DDR2
modules to hit the market were faster
than the fastest DDR modules available
now. DDR2 is not without its drawbacks,
though, at least initially: it’s not back-
ward-compatible with DDR, and moth-
erboards need to be specifically designed
to support the standard. This is not a
small problem; not many motherboard
manufacturers have shown interest in
the new standard, because of the rela-
tively large initial price difference
between DDR and DDR2. However, as
an indicator of the importance of the
emergence of the standard, AMD will
build support for DDR2 into the
Opteron’s on-board memory controller,
later this year.

GDDR3
GDDR3 is RAM optimised for graphics pro-
cessing. It is the fastest memory available
today. Speed and power are the important
factors when it comes to graphics designs;
GDDR3, therefore, delivers four data bits
every two cycles, and consumes half the
power, of graphics DDR2. The first prod-
ucts you can expect to see using GDDR3
chips will be high-end graphics cards.

RLDRAM
Reduced Latency DRAM (RLDRAM) fea-
tures a new design that minimises the time
between the beginning of the access cycle
and the first appearance of the data.
RLDRAM is thus all about persformance—
it combines fast access due to low latency
with high density and high bandwidth.
The technology optimises performance 

for cache and networking applications.
Although lower latency would certainly
mean better performance for personal
computers, RLDRAM is being targeted
mostly at the networking equipment seg-
ment, such as routers and switches.

FCRAM
Fast Cycle RAM (FCRAM) was developed
by Fujitsu in 1999. It’s radical in its

approach; it changes the core of the
DRAM architecture, whereas other
technologies have obtained speed
improvements by enhancing the
components that accessed the memory
core. Changes to the DRAM core include
core segmentation and pipelined
operation. This is the first time the 
core of the DRAM technology has 
been changed, in more than twenty
years. And the changes make for
amazing possibilities: row and column
information can be sent at the same time
in FCRAM, and, because of pipelined
operation, a secondary command can 
be issued without waiting for the
primary command to be fully executed.
The interface to FCRAM can be both
SRAM-like, which will be used in 
mobile phone applications, and Single
Data Rate (SDR) or DDR, which can be
used in PC systems.

IRAM
One approach to reduce the problem of
processor-memory communication
delay is Intelligent RAM (IRAM)—inte-
grating processor and memory on a sin-
gle die. Of course, for the solution to be
complete, memory latency needs to be
reduced, too. Currently, IRAM products
are not commercially available; however,

Researchers at Princeton University and
Hewlett-Packard Laboratories have
constructed a low-cost storage device
that combines the properties of 
solid-state silicon memory devices and
plastic storage devices. It consists of thin-
film silicon, covered with a conductive
polymer coating that’s been dubbed
Pedot. This combination can potentially
store one hundred megabits per square
centimetre. Pedot is conductive only at
low voltages, and permanently loses its
conductivity when exposed to higher
voltages. As a result, squares of
conducting and non-conducting Pedot
can be ones and zeroes. A memory card
constructed using this method would
have no moving parts, and would be like
ROM—writable once, and readable many
times. According to the researchers at
Princeton and HP, the memory cards
could be commercially viable in 
five years.

Researchers now say that hybrid

organic-semiconductor memory could
become viable in as little as two years. One
possibility is to use layers of molecules as
bits, with the challenge being to find
molecules that can withstand high
temperatures and other harsh conditions
typical of the silicon manufacturing
process, as well as the process of writing
and re-writing data. Researchers from the
University of California have shown that a
type of ‘porphyrin’ molecule holds up
under temperatures as high as 400
degrees Celsius, even after being written to
and read from trillions of times. The
molecule can be used to store charge, so
charged and uncharged molecules can 
be ones and zeroes. It has also been
shown that one memory element—a
group of molecules—can store two or
three bits, instead of one. As a result,
current 0.13 micron memory chips would
be able to store as many bits as chips
fabricated using the 0.09 or 0.07 micron
processes of the future.

Futuristic Storage Material

How Much Storage are We Talking?

Data that can be stored on a CD-size object with
various technologies



several university and company research labs are working on
IRAM architectures.

MRAM
Magnetic Random Access Memory (MRAM) is non-volatile, like
Flash. It holds promise because, when designs are complete, it
can combine the high speeds of SRAM, the capacities of DRAM,
and the non-volatile nature of Flash. In an MRAM chip, the
memory cells are the intersections of the rows and columns.
Electric signals polarise the cells into ones and zeroes. MRAM is
like a Flash stick—there are no moving parts; besides, power con-
sumption is lower. It’s therefore likely that MRAM and Flash will
compete in the portable-device arena. MRAM has the edge
because it will prolong battery life. As mainstream storage,
MRAM chips are unlikely to hit the market anytime soon. IBM,
however, is working on a combination of MRAM and holo-
graphic memory.

Looking forth
With so many materials and techniques being explored, one can’t
assume that storage will always be magnetic disks, or that mem-
ory will always be dynamic RAM. Systems of the future may build
upon the concepts that exist today, or they may employ entirely
new technologies such as holographic memory, or they may even
bring back old ideas. Is tape the storage of the future? It is, accord-
ing to Pat Martin, CEO of StorageTek! Predictions vary.

But we can be sure of a few things—for example, perpendi-
cular recording will happen very soon; MRAM will be researched
more aggressively, because of its promise as a replacement for
Flash as well as becoming a PC RAM solution, etc.

Whatever happens in the future, we’re quite far off from the
day you’ll be able to buy a computing system and live with it
happily ever after—sans upgrades.

RAM MOHAN RAO

ram_mohan@thinkdigit.com
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www.ddr2.org
The Web site for DDR2 news, technology updates, white papers,
press releases, etc.

http://www.seagate.com/newsinfo/technology/research/D4b1.html
A Web site about the Seagate Research centre, and its activities;
Seagate is at the cutting edge of storage technologies.

http://www.storagesearch.com/ssd.html
News about solid-state storage devices; includes articles and links
to company Web sites.

http://www.pcguide.com/ref/hdd/op/heads/
An interesting Web site about hard disk heads; Contains both
basic as well as advanced information.

http://uk.computers.toshiba-europe.com/cgi-bin/ToshibaCSG/
future_techs. jsp?z=64&service=UK
This page has links to lots of storage technology articles, from
RAID to DVD and emerging technologies.

http://www.inphase-technologies.com/technology/
Read about holographic storage technology in detail.
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Who needs clunky, knotty cables,
when you can have these!

Samsung HT-DB390 Wireless Home Theatre In-a-Box 
A box office hit

With Bluetooth being the flavour of the season, can home theatres be far behind?
Introducing the Samsung HT-DB390, which has a DVD player and can play

most compressed audio formats, as well as display still
images. It’s Dolby Digital, Dolby Pro Logic II and

DTS certified, and yields 400 W of
power from its 5.1-channel setup.

Price: US$ 499.99
▲▲

D-Link DSM-320R Wireless 
Media Player with Flash Reader 

Shindig streams
The D-Link DSM-320R wireless media player can stream images from
AOL’s online photo gallery, video, audio and Internet radio from

your wireless home PC network onto your idiotbox. It supports most
popular audio and video formats, and five different memory

cards—Compact Flash (CF), Smart Media (SM), Secure Digital
(SD), Memory Stick and MultiMedia Card (MMC).

Price: US$ 129 (approx)

▲▲

SMCWAA-B EZ-Stream 11 Mbps 
Wireless Audio Adapter
Fine-tuning harmony
The SMCWAA-B EZ-Stream seamlessly integrates into your 802.11b and g Wi-Fi
home network, and connects it to your entertainment centre. Stream music from
your PC and listen to it using headphones or a surround-sound system. And if you
get bored of your collection, switch to Internet radio. The LCD display helps you
navigate your music collection.  
Price: NA

UnWire 
My Sphere

▲ ▲
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Philips LX3950W  
Cine in style

Time to upgrade you home theatre to
the Philips LX3950W: This

instalment of the DVD
home theatre has Dolby
Digital 5.1 and Dolby
ProLogic II. You can
playback all your DVDs, as
well as Super Audio CDs. 
Price: US$ 399 (approx)

Jazz Hipster Wireless
Home Theatre J9618B 
Maudlin beauties
With a name like this, everything else
seems a let down! Yet, the Jazz Hipster
impresses you by working at the 2.4
GHz frequency band and yields 280 W
of power through its aircraft-grade
(nothing less!), aluminium cabinets. It
has dual 8-inch woofers rated at 120
W, and front, centre and rear speakers
with two-way drivers. Shielded against
magnetic interference and other RF
equipment, it has a re-chargeable
battery and a remote control. 
Price: NA

NETGEAR MP101 Wireless
Digital Music Player

For your musicale
Turn on the NETGEAR MP101, and prance around your
home. Wi-Fi encryption is built with support for Wired

Equivalent Privacy (WEP), letting you groove to your
MP3s and WMAs anywhere within a given area. The

supplied software automatically creates a database of your
music. To navigate, use the display or the remote control. 

Price: US$ 159.99

▲▲

▲ ▲

▲ ▲
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Look ma,
no film
SSSSiiiixxxx    ooooffff     IIIInnnnddddiiiiaaaa '''' ssss     bbbbeeeesssstttt     pppphhhhoooottttooooggggrrrraaaapppphhhheeeerrrrssss    ttttaaaallllkkkk    oooonnnn
hhhhoooowwww    ddddiiiiggggiiii ttttaaaallll     pppphhhhoooottttooooggggrrrraaaapppphhhhyyyy    hhhhaaaassss    cccchhhhaaaannnnggggeeeedddd    tttthhhheeee
wwwwaaaayyyy    tttthhhheeeeyyyy    sssshhhhooooooootttt

Look ma,
no film
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“Fashion
photographers
today can’t live
without digital
techniques” Usage: Occasionally, but will move to full-time digital photography this year. 

These pictures, in his words: I shot these two for the Kingfisher Swimsuit calendar, and
here a digital camera was a must. Underwater photography fascinates me because the
light fades quite fast, and the surface creates a mirror effect. Digital photography
enhanced these effects.
Oh, we didn’t know: Suppose you need three elements in one photo—the model’s hair
flying, her shining face and a mirror. With a traditional camera, this one is a tough task—
all three elements just won’t gel simultaneously. I would have to shoot lots of pictures
before I get the perfect shot. With digital cameras, these problems can be overcome faster.
Frustrations: I shoot really fast. But a digital camera hangs for some time after seven to
eight pictures as it takes time to write the images to the memory card. Since I shoot
images in high resolutions, this problem becomes worse.

Who: Atul Kasbekar
Field: Fashion, advertising, personalities
His camera: Fuji S2 Pro: 6.17 megapixels,
maximum image size 3,024 x 2,016 pixels,
sensitivity ISO equivalency 100 to 1,600,
can shoot up to 7 frames per second,
Firewire and USB 1.1 dual interface
Price: Rs 1.65 lakh

Who: Mukesh Parpiani
Field: News (Parpiani is the photo-edi-
tor of Mid Day, a Mumbai newspaper)
His camera: Nikon 1DX: 5.3
megapixels, maximum image size
3,008 x 1,960 pixels, 2-inch LCD, sen-
sitivity ISO equivalency 125 to 800
Price: Rs 2.9 lakh

Usage: Everyday. Moved
to digital photography a
year ago.
This picture, in his
words: Kuala Lumpur’s
(Malaysia) Petronas
Twin Towers are not
only beautiful to look at,

they are also supremely photogenic. Here, you see
the perfect colour balance between the building
and the leaves in the foreground. This can be
achieved with ease only with digital cameras. 
Oh, we didn’t know: For photo-journalists, digi-

tal photography is a boon. Shooting pictures, and then filing them fast was
a Herculean task. To send pictures before e-mail happened, we had to rush
to the telegraph office. Now, newspapers have the latest pictures because
shooting and filing them has become so easy. The cost has also come

down drastically. 
Recommendations: I suppose every
enthusiast should opt for a digital cam-
era. Go in for the cheaper brands, if
there are budget constraints. 

“Digital
cameras
can give
you
perfect
colour 
balance”
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“Combine digital cam-
eras with cell phones...
and time is not an
issue”
Who: Aijaz Rahi
Field: News and current affairs
(South Asia photographer for
Associated Press)
His camera: Nikon 1DX: 5.3
megapixels, maximum image
size of 3,008 x 1,960 pixels, 2-
inch LCD, sensitivity ISO
equivalency 125 to 800
Price: Rs 2.9 lakh

Usage: Everyday. Is a devotee of digital
photography.
This picture, in his words: I shot this pic-
ture during a local school boxing tourna-
ment in Mumbai in 2003. Any sports
photographer is concerned with only the
‘moment’. I found the moment here, but
to get it, I had to wait for a long time. But
because of the high shutter speed, I could
get the moment I was looking for. More-
over, I could see the result immediately,
and not wait in suspense until I reached
my dark room.
Oh, we didn’t know: Digital cameras
allow you to experiment a lot, something
that is a no-no with traditional cameras,

where the cost of
experimentation is
extremely high.
Next step: I would
want to upgrade to
a higher-end model
such as the Nikon
D1X. And then, like
any sports photog-
rapher, would like to
experiment much
more than what I
am doing right now.

Usage: Everyday. Swears by digital photography. Moved to digital photography in 1998
and was one of India's early adopters. 
This picture, in his words: The Gateway of India blast in Mumbai redefined new-age
terrorism in India. For a news photographer, there are no second chances in such cases.
Here, a policeman is surveying a car damaged in the blast that killed 40 people.
Oh, we didn't know: Working for a news-wire service is one of the most demanding
jobs in journalism. Since our revenue depends on our clients, and they buy only those
pictures that came first, speed is the most important factor. Now, combine digital cam-
eras with cell phones or satellite phones, and time is not an issue anymore.
Memories: In the US-Afghan war, I had to rush to a remote place where a bus carrying
children was bombed. I was the only wire photographer there, and if not for my digital
camera and satellite phone, covering the calamity would have been impossible.

“I found 
the moment
here...
because of
the high
shutter
speed”

Courtesy: Associated Press

Who: Atul Kamble
Field: Freelance sports photographer (The Hindu, Sportstar,
Mid Day)
His camera: Nikon D100: 6.1 megapixels, maximum image
size 3,008 x 2,000 pixels, 1.8-inch LCD, top shutter speed
1/4,000 seconds
Price: Rs 1.2 lakh
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Usage: Occasional, but will switch to full-time use in the next two months.
This picture, in his words: During the Cricket World Cup 2003 in South Africa,
actress and presenter, Mandira Bedi, had become as popular as the Indian team.
She was bubbly and vivacious, and represented the new Indian woman. I had
to shoot her doing something that would reflect her personality. With a digital
camera, getting that right picture was not tough at all.
Oh, we didn’t know: Digital cameras allow you to learn photography fast. You
can experiment a lot with your camera. With film cameras, that is not the case.
You have to note down every setting you used, so that you can cross check later
when the photos are finally developed.
Impact: Until recently, I had to hire digital cameras. Companies have realised
the benefits of digital photography and have provided photographers with dig-
ital cameras.

“Digital
cameras allow you
to experiment and 
learn fast”

Usage: Newly acquired camera, will
switch to full-time use in March.
This picture, in his words: I was in
the Maldives in the Indian Ocean
recently on assignment. Maldives
probably has the most beautiful
beaches in the world. As I was
strolling past one day after shooting
a few pictures, I spotted this girl who
was playing on the beach. It did not
take me long to take this picture.
The digital camera allowed me to
take lots of shots before finally pin-
ning this one down.
Oh, we didn’t know: A professional
photographer these days has to have
a digital camera. It saves time, and

affords a lot of flexibility.
The penetration of digital
cameras will only
increase. I guess, in two
years, digital cameras
will be ubiquitous.
Benefits: With a digital
camera, you don’t have
to wait for film to be
developed before you
can see the image, 
making it ideal for news
photography.

Who: Atul Loke (Senior photographer, Outlook)
Field: News, personalities, travel, sports (occasionally)
Uses: Nikon D100: 6.1 megapixels, maximum image size
3,008 x 2,000 pixels, 1.8-inch LCD, top shutter speed
1/4,000 seconds
Price: Rs 1.2 lakh

Who: Fawzan Hussain
Field: News, current affairs, travel, personalities
(Principal photographer, India Today)
Uses: Nikon D100: 6.1 megapixels, maximum
image size 3,008 x 2,000 pixels, 1.8-inch 
LCD, top shutter speed 1/4,000 seconds
Price: Rs 1.2 lakh

Courtesy: Outlook

“In two
years, digital 
cameras 
will be 
ubiquitous”
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To ensure that our readers have all the infor-
mation they need to make an informed buy-
ing decision, reviewers at the Digit Test Cen-

tre conduct comprehensive tests to evaluate the lat-
est hardware, software and technology services in
accordance with international standard evaluation
processes and methodologies. 

Our test results may be presented either as
Comparison Tests, or as individual reviews in the
Bazaar section. The representation of the results is
different for each in the interests of clarity, but the
test process for both is identical in all respects. 

Of all the products we test, only the best make
it to the A-List.

Comparison Tests
In the comparison tests, we compare the perform-
ance of products within a particular category. Each
product is evaluated under different parameters
such as performance, value for money, features,
ergonomics, etc. 

Weightages are then applied to the various test
parameters according to their importance for that
particular category of products. These weightages
are then used to arrive at scores for features,
ergonomics and performance for each individual
product. A detailed test process is included with
each comparison test, and explains the parameters
that were taken into consideration, along with
weightage allocation and reasons for the same.

In Bazaar
The evaluation of products in Bazaar also covers the
same parameters such as performance, ease of use,
value for money, build quality and features of the
product. 

Here, each of these parameters is rated on a
scale of 5, which is represented by arrows (->). 

The greater the number of arrows, the better
the product. This simple five-point rating system is
designed to give you an easy-to-interpret assess-
ment of a product. For example, a product that

receives a value for money score of five arrows 
signifies an outstanding buy. 

The Awards
Digit awards outstanding products by selecting 
a Best Performance and Best Value winner in 
each comparison test. The winner of the Best 
Performance Award will be the product that scored
the highest in the performance segment combined
with rest of the package including features,
ergonomics, bundled accessories etc. This award
represents the best performing product in our tests
in terms of the complete package that is offered to
a customer. The winner of the Best Value Award will
be the product that scores the highest in our value
for money parameter which is derived taking into
account the ratio of a product's ergonomics, per-
formance and features to its price. The product
winning this award offers a good combination of
performance and features at a great price. Since
value for money takes into account all scores for all
parameters including the price, this score will be
used to arrive at a grade (e.g. A+) for each product.

How we Test
It looks good and the technology is glitzy, but does it do the job?

Excellent: A brilliant combination of price, performance and features—far beyond 
expectations
Good: A good buy, better than most products in its category
Average: Reasonably competent but nothing spectacular about the product
Mediocre: Does not live up to expectations, needs improvement in many areas
Poor: has serious drawbacks and needs improvement before it can be used for its target
application

The 5-point Rating System used in Bazaar



CONTENTS
■ Components of a Home theatre  . . . . .48

■ Components of a Media Center PC  . .50

■ PC to TV workshop  . . . . . . . . . . . . . . . . .52

■ TV tuners . . . . . . . . . . . . . . . . . . . . . . . . . .54

■ PVR software  . . . . . . . . . . . . . . . . . . . . . .60

■ Speakers . . . . . . . . . . . . . . . . . . . . . . . . . .64

■ Miscellaneous components  . . . . . . . .81
Solomon Lewis

Entertainment
Unlimited

Entertainment
Unlimited

Imagine a Pink Floyd concert in seven-channel surround
sound, a Tom Cruise movie on an LCD screen, and DVD
audio on five-channel headphones in your living room.
Are you on the way to digital entertainment nirvana? >>



>> What Makes a Home Theatre 

Media Center PC: This is the
hub of all your computing

activities. Since it has an inbuilt
TV tuner, you can watch TV on
your PC, which can be re-
directed to your wide-screen
plasma TV display. Use the one-
touch remote to control all
functions such as playing TV, FM-
radio etc, and also capture
programs.

1 Display: An important
component of a home-theatre

setup. It can be your CRT or LCD
monitor, hooked up to the Media
Center PC, or a regular TV. You can also
opt for a High Definition TV (HDTV), a
rear-projection TV, or a plasma TV
display for better experience.

2 Speakers: Those
thumps, booms and

clinks need sound to be as
life-like as possible. You can
choose from a wide range of
speakers, ranging from
normal stereo speakers, 2.1s,
to 7.1 systems for a surround-
sound experience.

3

DVD player: The Media Center PC
comes with a DVD drive. However, if you
love lining your DVDs one after the other,
then a five-disc DVD changer is what you
need. 

4

Wireless peripherals: All the devices mentioned above come
with their own remotes. So when you sit down to watch a

movie, you will have at least four remotes in your hand. Doesn’t
leave much room for the popcorn now, does it? The universal remote
is what you need.

An upgrade would be the learning remote that has an LCD
display, does everything what the universal remote does, and also
learns the patterns in which you use your remote. Oh, let’s not forget
the wireless keyboard and mouse that controls the Media Center PC.
After all, you’re not going to be watching movies all the time.
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Memory: While Windows XP is rumoured to
work with 128 MB RAM, 256 MB guarantees
smoother video playback and less stressful
recordings—a significant boost in performance
that costs only Rs 1,000.

Processor: A Media Center PC
will work on a 300 MHz

processor, but won’t be
able to cope with the

stress generated due to real-
time MPEG compression.

Consider at least a 1 GHz processor
to handle the stress. If your motherboard

supports it, consider moving to a 2 GHz
processor for Rs 4,500.

Remote Control: Ever thought of
a TV without a remote control?
Then why should things be
different here? Make sure your TV
tuner comes bundled with a
couch potato’s best friend.

Optical drive: With a well-configured audio and
video configuration, it stands to reason that you
should use the best-quality recorded media. While
high-quality DivX and VCDs look great on your
Media Center PC, nothing beats the quality of a
DVD movie with multi-channel sound. Consider
an upgrade to a DVD-combo drive for Rs 3,500.

High-capacity storage: As your Media Center
PC will be recording your favourite shows daily,
the system should have enough storage space.
Since hard disk prices have reached rock
bottom, you can consider at least an 80 GB
upgrade for Rs 5,000.

MARCH 2004

Graphics card: For a video card that shows
full-screen video in true colour, any modern
graphics card should do. If you need to
upgrade, a Rs 2,500-solution will set you on
the path to gorgeous graphics.

>> Deconstructing your PC TV
Sound Card: A good sound card completes a
home-surround system. A good one shouldn’t cost
you more than Rs 3,000.

TV tuner: This is probably the most
important component you need to get
your favourite channel on the PC. Ideally, a
card with hardware MPEG-2 compression is
recommended, but keeping in mind the
price factor, a card without hardware
compression will fulfil the need, but if your
processor’s fast enough. The cost? Rs 2,000
to Rs 4,500.
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Encased in a cubic chassis, the AQ265
runs the Media Center Edition of
Windows XP, and offers a complete

home entertainment solution in a single
package.

Powered by Intel P4 2.6 GHz, 256 MB
DDRRAM, 845GE, 128 MB nVidia
GeForce 5200 AGP card, combo drive, 15-
inch LCD screen, Altec Lansing ATP3 2.1
speakers and an 80 GB hard drive that’s
enough to store approximately 80,000
minutes of music in 128 KB lame MP3
format, or approximately 120 hours of
video in MPEG-1 format. Armed with an
onboard MPEG2 encoder and an FM
tuner, the internal Hauppauge TV-tuner
card provides media functionality.

Other package contents include
gamepad, internal fax modem, etc. It also
bundles along Windows XP Media Center
Edition and Norton AntiVirus.

On the performance front, it put
forth its best foot in some areas, but did
not do well in the others. For example,
the poor SiSoft Sandra disk index indi-
cated a poor hard drive system. This was
also reflected in the Content Creation
and Business Winstone tests that logged
18 and 17.3 respectively. Collectively, 
it implies that it's an average PC for busi-
ness users. 

However, on the gaming front, it was
an entirely different story. It pitched in
259 fps at 640 x 480 for Quake III and
129.82 (flyby) at the same resolution in
the case of UT 2003—these indicate that
it does well in performance. It came out
with brilliant scores in the video-encod-
ing test too, thus showing itself worthy

of its job. As far as the actual recording
format is concerned, you have four
options—fair, good, better, or best.

The big, bold font used in the Media
Center interface lets you read text from
as far as 10 feet from the screen. Use the
neat and clean remote control interface
to navigate throughout the software with-
out the slightest bit of strain. And you'll
hardly exert yourself configuring it. 

Features-wise, it has time-shifting 
TV, advertisement-skipping, scheduled
recording and instant replay of 10 sec-
onds. While scheduling, recordings may
overlap then you can manually resolve
this conflict, or set the software to do so
automatically. 

The Media Center software also helps
you link a series of episodes. It provides
you options to keep the recorded file until
space needed. It also lets you specify
whether you wish to keep the recorded
file for one week or until you have
watched the recording. Thus, it lets you
manage your recorded files and do away
with recordings that are not necessary.
Management functionality is provided
for music as well as image files.

If you find the price tag to be on the
higher side, opt for a slightly low-end
model.  Featuring a 17-inch flat CRT dis-
play, 40 GB hard drive and a P4 2.5 GHz
processor, it's priced at Rs 50,000. 

In all, the Beanstalk AQ265 has 
all the components of basic capture 
software, along with advanced features
such as Instant Replay, Play/Pause 
Live TV, etc, which makes TV-viewing
more thrilling.  

Price: Rs 74,999 
Company: HCL Infosystems Ltd
Tel: 0120-2520977
E-mail: response@hclinsys.com
Web site: www.hclinfosystems.com

Capturing video, listening to FM or music, is
all just a mouse click away, thanks to the easy
to use software interface

This media center PC enables you to watch TV
as well as tune in to your favorite FM channel
all with a click on the remote

HCL Beanstalk AQ265 Media Center
The infotainer
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If you have a decently configured PC with good
speakers and a DVD drive, converting it to
serve as a media entertainment centre is a sim-

ple matter of installing a good TV tuner card and
the appropriate software.

All you need to do is plug the TV tuner card,
install the drivers and software, connect the cable
to the card and scan for channels. You can also
prioritise and name channels as you please. Of
course, the installation and configuration does
take a while, but nothing beats having a person-
al TV in your room!

As this project requires setting up both
hardware and software, the first step con-

sists opening the cabinet, finding a suitable free
PCI slot and inserting the TV tuner card—in our
case the Compro VideoMate TV Gold+. Once the
card is attached, start the computer.

As soon as you start the computer, the
operating system will display a message

saying “Multimedia Controller Found”.
If you view the device manager at this

moment, you will find a number of devices
marked with question marks or exclamations.
You will be asked to insert the driver CD to con-
tinue installing the drivers—insert the CD pro-
vided by the manufacturer, and press Next.

Windows will try to search for the drivers
from the CD-ROM drive, and then list all

the suitable ones. If the list shows more than one,
then choose the right one, according to the OS
installed. Select the driver, and press Next again. 

Windows may show a warning pop-up say-
ing that the drivers are not digitally signed, this
means that Microsoft hasn’t approved the  driv-
er, but it’s generally alright to go ahead and con-
tinue the driver installation. If you face a problem
later, you can use system restore, and roll back

the drivers in Windows XP. When you press Next,
the driver installation process begins. Once it’s
done, press Finish to complete installation.

If you check the device manager, you’ll see
that due to the add-on drivers that are

needed, the list of devices with question marks
and exclamations has increased. Windows should
remedy this automatically, but if it asks for the
driver CD, repeat the previous step.

Once the process is completed, all the
unknown devices will have vanished, and the list
in ‘Sound, Video and game controllers’ will dis-
play the new set of hardware installed.

Now, we go back to the hardware level, to
do the wiring properly. To capture TV sig-

nals, connect the TV cable to the tuner card.
To get a video signal via composite, connect

the Audio Out of the Video player to the Audio
In jack, and connect the composite out jack of
the player to the Composite In of the tuner card.

If your card does not have Audio In, you need
to connect the Audio Out of the video player to

From PC to
TV in 12 Steps

By clicking this button, you can
change the video source from TV
to S-Video, or Composite

The nail and hammer symbol
opens the settings window, 
where by you change the differ-
ent parameters.

Click this button to take snap-
shots of your favourite TV
moments

These panels represent the
normal TV functionaility,
while in time-shifting mode.
The same enables you 
to Pause/Resume Live 
TV signals.

In this screen, you can observe lots of useful information such
as the compression format used currently, the size of the
recording file, as well as the amount of time that can still be
recorded with the current free space. Finally, in time-shifting
mode, it shows two time intervals—one in the extreme top-
right corner with the live signal timing, and the other in the
centre showing the point where the user paused.
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the Line In of the sound card. If it has Audio
In, connect the Audio Out of player to it;
connect the Composite Out of the video
player to the Composite In of the tuner.
Now, using a small male-male stereo cable,
connect the Audio Out of the tuner card to
the Mic In of the sound card.

Now that you’ve installed the hard-
ware and drivers, you’re ready to

install the capture software—we used
PowerVCR. When installing PowerVCR,
you’re asked to specify a program directo-
ry and a working directory where all the
recorded video will be stored. You are also
asked whether you want to back up your
system files, or just install the software;
choose to back up the files, as this will
help you revert to your system’s previous
state if you want to uninstall the soft-
ware. All the necessary codecs are also
installed. Restart the machine once
you’re done installing.

The very first thing you have to
do is configure the channels.

As soon as you start the software,
you’re asked to do this. The lazy way
out is to press the Auto Scan option,
and let the software set the channels
automatically. You will, however, need
to fine-tune a bit here and there to get
optimum picture and sound quality.
You can also spend a little time naming
the channels, but remember that these
names are stored in the software. So, if
your cable operator changes the fre-

quencies of the channels, you’re going to
have wrongly labelled channels—a predica-
ment that we all endure with TVs, when
our favourite channel is changed from
the easily accessible channel number 1 to
number 104.

Now you need to configure some of
the other parameters depending upon

your needs. Click on the button with the
nail and hammer image—you will see a list
of tabs, each showing a list of parameters
to be configured.

The first tab is V/A devices, where you
can set the proper Video/Audio parameters
such as video capture device, audio capture
device, video source, audio source, etc. In
this case, the video and audio capture
devices are the TV tuner card itself. If your

TV tuner card does not have Audio In,
remember that the audio capture device
has to be set as your sound card.

You also need to specify the signal source
as TV, S-Video, or Composite. This will be TV
mostly, and when you want to connect a video
player, change this to Composite or S-Video.
You also need to set the Audio Input to Mic In.

In the Video tab, set the actual video
adjustment options such as brightness,

hue, contrast, sharpness and saturation.
The software supports profiles for
capture formats, so this step

involves selecting the appropriate one
in the Profiles tab. You have a wide variety
to choose from—PAL, NTSC, MPEG-1,
MPEG-2, etc.

The next tab deals with configuring
the default options that you need for

recording, say, the time, and some
advance options such as Noise Removal,

Video Smoothing, etc.
In the Snapshot tab, specify which
folder to save the snapshot images

you take. The last tab, TV Replay, lets
you configure the Replay Buffer Time Limit
that decides how much the software caches
to show you when you demand an
Instant Replay.

Draw the curtains, hang the ‘Don’t Dis-
turb’ sign on the door, put up your feet and
tune into your favourite show.

Selecting the video and audio device, as well as the
video and audio input, is critical to proper viewing
and recording

If you find that the video-quality is poor,
tweak the advanced options. Observe what
each change does to the video in order to get
the perfect setting

Once you’re done connecting everything, it
should look like the figure on the left.

Composite Out (TV) connects to Compos-
ite In (TV Tuner).
Audio Out (TV) connects to Audio In (TV
Tuner).
Audio Out (TV Tuner) connects to Audio In
(soundcard).
Audio Out (soundcard) connects to the
speakers.
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Though some TV tuner cards offer more than others, it
doesn’t necessarily make them better. We got 10 cards
for our comparison from all the major players in the

market including Pinnacle, PixelView, Mercury, Compro and
a new entrant—Aviosys. 

Package contents
Package contents are important when buying a TV tuner card.
The bundled software should include Personal Video
Recording (PVR) software; tried and tested utilities such as
WinDVR and Cyberlink PowerVCR are the most commonly
bundled software. Pinnacle stuck to their proprietary software,
and bundled only the trial version of Studio 7 with both, the
PCTV Plus and PCTV PRO. A toned-down version of the expen-
sive Studio 7 software would have definitely been welcome;
they offered all the necessary wires and a remote control. Pin-
nacle only bundled a quick start guide in the form of docu-
mentation—the manual is on the CD. The remote is handy
and works well.

Aviosys only provided a quick start guide, unlike the Pix-
elview TV cards which came with an extensive manual and a

test drive ■
■ tv tuner
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Definitely the best of the lot, this is the only card that
had markings on the back panel of the Printed Cir-
cuit Board (PCB) to indicate what goes where while

inserting it. The faulty drivers led to some hiccups in its
configuration. The channels were not detected properly,
and ran into each other with jumbled characters appearing
onscreen. However, all was fine after we installed the patch
downloaded from www.comprousa.com. This was tedious, but
definitely worth it.

The bundled software lets you write directly to DVDs.
The bundled application is intuitive, easy to use and has a
satchel of features. The feature to enhance the picture qual-
ity is very natty, and comes in handy while capturing con-
tent. You can take snapshots of various channels, but these
look icky on a 14-inch screen. The channels are also not
updated fast enough. Scheduled recording brings your sys-
tem out of Standby or Hibernate mode when it’s time to
record. It also has an option to turn off the system after

completing the job. This is useful
for late-night recordings. Good
software bundled with cool fea-

tures made this card
our performance

winner.

Compro VideoMate
TV Gold Plus
A winning package

Instead of spending thousands of rupees on a TV, you can buy
a TV tuner card and watch TV on your computer. If you don’t
want to capture content, and only want to watch TV, you can
buy a set-top-box. These boxes do not connect to your PC,
just to your monitor. They can’t capture content, but instead,
let you use your monitor as a full-fledged TV. Though some
manufacturers sent a few of these in to be tested, we didn’t
include them in our test—they just don’t fit into the PVR
category. But in case you are looking, there are cheaper no-
frills alternatives for watching TV on your monitor.

Suitable Alternatives

T V  T U N E R

Don’t you wish life had a rewind or instant replay function?
Have you ever thought of killing your boss, burning your
company, divorcing your significant other, sending your

kids to boarding school, moving out from home, or just becom-
ing a recluse? All because you missed that one program on TV that
you’d waited forever to see, and something more important came
up? It happens to all of us, TV addicts or not-be it that must-see
episode of Kyunki Saas Bhi Kabhi Bahu Thi, Jassi Jaise Koi Nahi, or
a cricket match. But who says that’s the way life has to be?

Enter, Stage Right, TV tuner cards and PVR (Personal Video
Recording) software; their role used to be played by the now out-
dated VCR. These gadgets make sure you never miss another pro-
gramme ever again—barring power failures, hurricanes, fires and
acts of divinity, of course. All you need is a decent computer setup,
a cable connection and decent speakers, and you can turn your PC

into a media centre. Think of it as buying a second TV for the fam-
ily, for as little as Rs 1,700.

As always, there are so many options. Though brands such as
Hauppauge are still not available, others do the job to satisfaction.
Some local brands that only let you watch TV on your monitor are
available, but as usual, yeh dil maange more. So, we decided to look
for cards that do more than just display a few channels on your
PC monitor. We looked for cards that let you capture video, in real
time; cards that can capture MPEG-2 on the fly; PVR software that’s
easy to set up, and even easier to use; software that can convert
between file formats later, and anything more on the offer.

The latest breed of cards offer advanced features such as time
shifting, MPEG-2 capture, FM radio, NICAM stereo capture, and
more. They’re connected via a PCI or USB interface, and have
impressive capabilities. How impressive? Read on to find out.

tion and a cleaner menu structure. The team

however, denied any involvement, stating that



good remote control. Most PixelView cards had the drivers, its
native application called PlayTV and Cyberlink PowerVCR on
the same CD. The Pixelview PlayTV XP was the only excep-
tion—it has WinDVR and Powerdirector SE.

Compro was the best product as far as software bundles
were concerned—they gave both Ulead VideoStudio and Ulead
DVD Movie Factory; the Compro DVD software looks suspi-
ciously like Cyberlink PowerDVD—it has the same configura-
tion features. A sound editing tool would have been a welcome
addition. Pixelview also supplied all the necessary wires, and
the drivers and software came in one CD. Mercury needs to
gather its wits on the packaging front—a detailed manual is
necessary to explain the driver installation and software con-
figuration, since they don’t bundle any third-party utilities.
Even the remote doesn’t offer much in terms of usability, but
is really sleek.

Ease of use
A product that’s really easy to use is obviously more desirable.
Driver and application crashes during use, reduced points here.
The Pinnacle software configuration is one of the best. It can
be configured easily; all we had to do was follow the instruc-
tions that the wizard gave. When a problem occurred, the wiz-
ard told us exactly what was wrong. Once the configuration is
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Using a TV tuner isn’t really as simple as plugging it in,
loading the drivers and sitting back, and forgetting about it.
There are certain precautions to be taken. While doing this
test, we came across three things that you should keep an
eye out for:
■ Those with VIA chipset motherboards, with the onboard
Savage 3D video controller, need to remember that the Savage
3D chips have an overlay problem, because the older drivers
aren’t DirectDraw compliant. Get a driver fix from the
manufacturers Web site, or your hardware is likely to ruin your
captured footage.
■ RealTek ALC-650 onboard chips can distort captured sound,
but help is at hand. Download the latest drivers and a patch
from the RealTek Web site to fix this problem.
■ Lastly, and most importantly, remember that your TV
cable carries a small electrical charge along with your favourite
programmess. This charge is small enough to ignore, but if it
surges, you might have yourself with a fried PC. Unfortunately,
there’s nothing much you can do, as only your local cable guy
has control over his wires. All you can do is cross your fingers,
pray a lot and disconnect the cable during storms.

Heads Up

A TV-Tuner card is just another PCI card.
Most cards have a very simple layout with a
RF (Radio Frequency) Tuner unit and an
ADC (Analog To Digital Converter) chip.
The ADC chips are mostly manufactured by
Brooktree (Conexant) or Philips; and most
tuner units are made by Philips. The RF
tuner unit is just like the one you have in
your TV. The frequency of TV signals lie
between 40 MHz and 300 MHz for VHF,
and about 800 MHz for UHF. FM radio
bandwidth is also between 88 MHz and 109
MHz, hence the name RF.

The cable wire is plugged in to the
Tuner unit, where the RF signal is separated
from the carrier signal and then passed to
the ADC. The converter then samples this
data, depending on the signal—either NTSC
or PAL. The data is then passed on to the
video card, where it is overlaid on the
frame-buffer. This saves a lot on the system
resources. However, capturing content will
definitely hog system resources, and affect
any other tasks you may be doing. This
includes playing games, or working with
multimedia applications. Working in Word
or Excel, or surfing the Net while capturing
content shouldn’t be a problem.

What is a TV Tuner? 

Cable TV connector

FM connector

IR Port

Composite In
S-video In

Audio In

To Monitor

Audio Out

RF Tuner

ADC

PC I  Bus

VGA card

Mahesh Benkar
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MPEG: MPEG is a group (Moving Picture Experts Group) that
develops standards for digital audio and video compression. There
are several versions of this standard, including MPEG-1, MPEG-2
and MPEG-4.
MPEG-1: This standard was designed to code progressive video at
a transmission rate of 1.5 Mbps. It is used in Video CDs, but is
giving way to the new MPEG-2 standard. MPEG-1 Layer 3 is the
audio compression format popularly known as MP3.
MPEG-2: This standard was designed to code transmission rates
above 4 Mbps, and is used in DVD and digital broadcast TV. It is
superior to MPEG-1 in terms of picture quality and sound clarity.
MPEG-4: This is a relatively new standard, and is aimed at
converging streaming media from different sources. Speech and
video synthesis, fractal geometry and an AI approach to
reconstruct images with better, yet lossless, compression. 
NTSC: This stands for National Television Standards Committee
that developed the protocol for broadcast transmission and
reception in the US. NTSC signals are used in the US and Japan,
and have hardly been altered since their inception, except for the
addition of new parameters for colour signals. NTSC signals are

interlaced, and an NTSC TV image has 525 horizontal lines per
frame. Every other line is dropped, and thus it takes two screen
scans to complete one image. One complete frame is scanned
every 1/30 second. NTSC signals are not directly compatible with
computer systems, but there are adapters available that let you
view an NTSC signal on a PC monitor.
PAL: Phase Alternation Line is the standard that is used in India and
Europe. In the PAL standard, the horizontal image has 625 horizontal
lines per frame. A slight colour variation is seen between the PAL and
NTSC standards. This standard was developed in Germany. 
SECAM: This stands for Sequential Couleur avec Memoire, and is
prevalent in some parts of Europe—mainly in Russia and countries
of the former Soviet Union. Similar to the PAL standard, it is an
interlaced transmission signal for TV.
NICAM stereo: This stands for Near Instantaneous Companded
Audio Multiplex, and was developed by the BBC Research Centre
in the early 1980s. It was first transmitted with the PAL colour
broadcasting system in Britain. This technology improves on the
sound quality of the transmitted TV signal. The Compro and
Pinnacle TV tuners feature NICAM stereo.

Jargon Buster

CATEGORY

AAvviioossyyss
TV-EZ

Philips 7134

Internal
✔ / ✔

✖

✔ / ✔ / ✔ / ✔
720 x 576

✔

✔

✔ / ✔ / ✔
✖

VCD DVD Plus, 
Ulead VideoStudio

✔ / ✔

4 / 4 / 4

0
78
✖

21
4 / 4

19.70
58.50
78.20
3.13

2,500

CCoommpprroo
TV Gold+

Philips 7134

Internal
✔ / ✔

✖

✔ / ✔ / ✔ / ✔
720 x 576

✔

✔

✔ / ✔ / ✔
NICAM Stereo

Ulead DVD 
Movie Factory, 

Ulead VideoStudio,
Compro Internal software

✔ / ✔

4 / 4 / 4

0
78
✔

21
4 / 4.5

19.50
62.50
82.00
2.09

3,925

MMeerrccuurryy
TV Tuner

Philips 7130

Internal
✔ / ✔

✖

✔ / ✔ / ✔ / ✔
720 x 576

✔

✔

✔ / ✔ / ✔
✖

Mercury proprietary
software

✔ / ✔

3 / 3 / 3

3
60
✔

22
2.5 / 2

11.02
46.00
57.02
3.35
1,700

PPiinnnnaaccllee
PC TV PRO

Conexant BT878

Internal
✔ / ✔

✖

✔ / ✔ / ✔ / ✔
720 x 576

✔

✔

✔ / ✔ / ✔
NICAM Stereo

Pinnacle proprietary
PCTV Vision, 

Studio 7 Trial, 
T-Rex Multimedia 

file converter
✔ / ✔

4 / 4 / 4

0
78
✖

21
4 / 4

20.50
61.00
81.50
2.33

3,500

PPiinnnnaaccllee
PC TV Plus

Conexant BT878

Internal
✔ / ✔

✖

✔ / ✔ / ✔ / ✔
720 x 576

✖

✔

✔ / ✔ / ✔
NICAM Stereo

Pinnacle proprietary 
PCTV Vision, 

Studio 7 Trial, 
T-Rex Multimedia 

file converter
✔ / ✔

4 / 4 / 4

0
78
✖

21
4 / 4

19.70
55.50
75.20
2.51

3,000

PPiixxeellVViieeww
PlayTV MPEG-2

Conexant BT878A

Internal
✔ / ✔

✖

✔ / ✔ / ✔ / ✔
720 x 576

✔

✔

✔ / ✔ / ✔
✖

Cyberlink PowerVCR

✔ / ✔

3 / 3 / 3

0
78
✖

21
3 / 3

16.50
53.50
70.00
2.00

3,500

TV TUNER CARD
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FM Tuner
Time-shifting software
TV Standards Supported (NTSC / PAL / SECAM)
Other features
Package Contents (15%)
Software bundled

Manuals / Remote Control
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Installation / Driver support / Configuration

Quality Of Encoding (Dropped Frames)
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done, you can start capturing content with your card. We did-
n’t have any driver or software issues when testing these cards.
Aviosys also did well—there were no configuration, or driver
installation issues. The Aviosys application needs to look a
whole lot better though. Don’t expect to be able to plug in
this card and start capturing content immediately, as learn-
ing your way around the application will take some effort.

The Pixelview cards had some major drawbacks in terms of
driver support and software incompatibility. The PixelView
PlayTV PRO crashed our test system till a driver update came to
our rescue. The native PixelView application takes a little getting
used to, but the bundled PowerVCR software more than makes
up for that. The irritating bit is that you need to get the native
software settings right before configuring PowerVCR. The Com-
pro and Mercury cards also didn’t work out of the box, and need-
ed a driver update and a patch fix in order to work.

Features 
All the cards supported stereo capturing, and had the
S-Video and Composite input ports. Certain features, such as
NICAM stereo, were only provided on the Aviosys,
Compro and Pinnacle cards. The Compro card could
achieve advanced tasks such as bringing the PC out of
standby for a scheduled recording, and then shutting down
after the recording is completed.

The PixelView cards offered standard MPEG-1 and
MPEG-2 capture, except the USB PRO, which lacked
MPEG-2 capture capability. The native PixelView application
needs a bit of getting used to, and Cyberlink PowerVCR
gives you the freedom of shutting down the PC after a sched-
uled recording.

Only Pinnacle and Compro offered software to convert
captured content between formats. All the TV Tuners, except
the Pixelview USB PRO and Pinnacle PCTV Plus, provided FM
tuners. The Mercury video card lost out on features, as it only
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The Mercury TV Tuner Card is the most widely avail-
able card in the market. It’s ideal for those who just
want to watch TV on their computer, with no fancy

trimmings. However, this card does capture content, and
can also play the late night FM for you. As for the section
that pertains to TV signals, channel-scanning ran into
problems, but the driver fix resolved that.

The application that comes bundled keeps
crashing, unless you get the update from their Web

site. The interface is unintuitive, but clear. New users will
take some time to get used to it, and configure the chan-
nels. You can save your channel preferences after detecting
them. Also, remember to fine-tune after the channel scan
for proper display. You can even make a list of your
favourite channels in a particular order, and leave out the
rest. It lets you take snapshots, but doesn’t provide a matrix
of them showing all the channels at a glance.

FM-reception is pretty good, but cannot be captured.
You can also connect devices such as PlayStation2  and
video cameras to this card using the S-Video or composite
inputs to play games, or edit video. Content capturing was
not up to the mark, and it definitely suffered when trying
to capture images at a resolution of 640 x 480—the maxi-
mum value that it can go to in Ulead. Priced the lowest at
Rs 1,700, it’s based on the aging Philips 7130 chip with a
Philips tuner. Though it’s a plain card with no frills and
features, it’s definitely easy on the pocket, with decent cap-
turing to boot. 

Mercury TV Tuner Card
The price is right

PPiixxeellvviieeww
PlayTV PRO

Conexant BT878

Internal
✔ / ✖

✔

✔ / ✔ / ✔ / ✔
640 x 480

✔

✔

✔ / ✔ / ✔
✖

Cyberlink PowerVCR

✔ / ✔

3 / 3 / 3

2
78
✔

21
3 / 3

14.50
47.50
62.00
2.38

2,600

PPiixxeellvviieeww
Play TV PRO Ultra

Conexant Fusion878

Internal
✔ / ✔

✔

✔ / ✔ / ✔ / ✔
720 x 576

✔

✔

✔ / ✔ / ✔
✖

Cyberlink PowerVCR

✔ / ✔

3 / 3 / 3

3
78
✔

22
4 / 3.5

15.82
53.50
69.32
2.48

2,800

PPiixxeellvviieeww
PlayTV USB PRO

Conexant Fusion878

External
✔ / ✖

✔

✔ / ✔ / ✔ / ✔
640 x 480

✖

✔

✔ / ✔ / ✔
✖

Cyberlink PowerVCR

✔ / ✔

3 / 3 / 3

3
78
✔

21
3 / 3

13.42
41.50
54.92
1.22

4,500

PPiixxeellVViieeww
PlayTV XP

Conexant Fusion878A

Internal
✔ / ✔

✖

✔ / ✔ / ✔ / ✔
640 x 480

✔

✔

✔ / ✔ / ✔
✖

WinDVR,
PowerDirector SE

✔ / ✔

3 / 3 / 3

0
78
✖

21
3 / 3

16.50
51.50
68.00
1.84

3,700

TV TUNER CARD
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bundled its own software. Any feature such as picture improv-
isation or NICAM stereo, would have definitely given this lit-
tle card a boost in the scores here.

Performance
Performance finally decided which card was the best. We cap-
tured content in MPEG-2, for the cards that supported it, and
in MPEG-1 for the cards that didn’t. This was done to test a
card’s capabilities, including dropped frames and processor
usage. Processor usage is a factor that needs attention, because
a computer with low resources may not be able to directly 
capture data in the MPEG-2 format. A Pentium III 700 MHz
processor is good enough, but for MPEG-2 recording, a Pen-
tium III 1 GHz system is recommended. Another important
aspect is the cable reception signal—often a weak signal results
in considerable frames being dropped when capturing data in
the RAW format (RGB 16).

Other factors also come into play (See box, ‘Heads-up’ on
page 55). The software bundled with tuner cards is very utili-
tarian—you can do PVR work, as well as minor video editing,
without having to pay more for software. All the cards cap-

tured content at the highest resolution that PAL supports. A
cable signal is transmitted at a resolution of 720 x 576, and if
content is captured at 640 x 480, it looks decent enough. The
amount of dropped frames count, and the overall captured
content quality may not be impressive, but a little tweaking
will definitely get you satisfactory results. 

The Compro and Pinnacle cards were neck-to-neck in terms
of content capture and processor usage. The overall quality of
content of both the cards was similar, and we had a tough time
choosing between them. Aviosys was another card that per-
formed well. The Pixelview’s lost badly—except for the PlayTV
XP, which put up a decent show. Some cards required fine-tun-
ing after the automatic channel—the Mercury and Compro
yielded grainy pictures, which cleared when we fine-tuned.
The Pixelview PlayTV PRO also required fine-tuning, but gave
pretty decent content quality. The processor usage remained
the same across the board—all the cards utilised 21 per cent
processor time, when capturing data. 

Overall, the Compro and the Mercury came out as our per-
formance and value winners, but the Pinnacle duo does deserve
a worthy mention for their commendable performance. The

Compro won because of the fea-
tures it packed and the perform-
ance it showed, while the Mercury
won because of its extremely com-
petitive price of just Rs 1,700 that
no other card was able to match.

Compro

Mediatech India

022- 26361111

sales@media-techindia.com

www.comprousa.com

Mercury

Kobian India Ltd

080-5566626

rohit_varma@kobian.com

www.kobian.com

Pinnacle

Aditya Infotech P.ltd

022-26338555

vijay_singhal@adityagroup.com

www.pinnaclesys.com

Pixelview

Rashi Peripherals

022-28260258

ho@rptechindia.com

www.prolink.com.tw

Testing TV tuners is a very subjective process, as we try to
compare the quality of captured content amongst all the
contenders. Some aspects of TV tuners—such as MPEG-II
encoding in real-time—are hardware specific, but this process
also hogs CPU time. Video encoding takes a heavy toll on
system resources, irrespective of your configuration.

The test bench consisted of a Pentium 4, 2 GHz, on an Intel
D850EMV motherboard, with 256 MB of RD RAM. The video
card was a GeForce4 440MX, and the sound card used was a
Creative 1373. We tested the cards to capture content using
both, cable and S-Video, as the input sources. We used Ulead
Media Studio to capture content from the S-Video input in raw
format-RGB (24-bit) with CD quality audio (wav files). This was
done to check the quality of the captured content without any
changes or compression, made by either the hardware or
software. We also used the cards to capture regular cable
content using the applications and software supplied by the
manufacturers. This was done to check both, the quality of
content, and also the real-world performance of the card. Any
issues such as crashing of applications and drivers, or dropping
of frames were duly noted. 

A restore point of a fresh installation of Windows XP, with all
the necessary drivers and patches installed, was made. The

system was restored to this point each time we installed a new
card, to avoid any possible driver and software conflicts. 

Needless to say, the cards performed as they were meant to,
however it was the features and the final content quality that
separated the good from the mediocre.

Coming to the software aspect of this month’s tests, the PVR
(Personal Video Recording) software test looked for noticeable
differences or advantages over bundled software. As all PVR
software rely on the same hardware device—the TV tuner
card—they can only be adjudged on the basis of the features
they offer. However, we noted a software’s effort towards
improving the quality of captured images in terms of noise
reduction, video smoothing, etc.

We looked to answer all the questions you ask when buying
PVR software: Can I play or pause a Live TV signal? Does it have
the Instant Replay function? Can I skip the commercials, and
catch up with the live TV signal? How long can the instant
replay be? In what formats can I store the captured video? 

We also tested each software for ease of use, to answer a
few more questions you might have: How much time will I
spend configuring the software? How easy it is to locate and set
parameters? How good is the documentation? How good are
the software’s default settings?

How We Tested
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iuVCR's friendly and simple interface allows you to capture
video in any format, frame size and duration. At the same
time, because of its integration with Windows scheduler, it

starts and stops recording automatically.
It is strategically made—parameters such as 'Max file size'

and 'Max file time', ensure that the file size does not exceed that
of the recording media, or eat up the entire free space. These
parameters also help you avoid the maximum size limitation of
file systems such as FAT32, which restrict the file size to 4 GB.
You can even specify partitions across which to span the record-
ing. This leads to efficient disk space usage.

By default, iuVCR captures video in the AVI format using
either the huffyuv compressor, or the PICVideo MJPEG com-
pressor. You need to install the necessary encoder, if you wish to
record in Microsoft Windows Media Format. The recording
options also provide control over audio-video synchronisation.
To enhance image quality as it gets captured, create filters with-
in the application. There is also support for additional plug-ins
to process real-time video streams.

A natty feature is the one-touch button that captures your
favourite television moments. Unable to snap that shot at the
right time? Capture the entire live video in a series of bmp files,
and later choose the one you need. The Info tab shows you use-
ful real-time statistics such as the number of frames recorded or

skipped, the output file size, free drive space and the current
CPU usage.

Lastly, a simple presets manager allows you to set and save
all the current program settings under a unique name. You can
use this name in the scheduler, or when starting iuVCR with
command-line parameters. 

While it did well in the performance department, iuVCR
lacked features such as real-time TV functionality to pause and
resume the TV signal at will. Thus, it did not differentiate itself
from the rest of the products in the market.
Price: US$ 27.50

Web site: www.iulabs.com

iuVCR
Good, but not the best

+ Span the video capture across drives; apply filters in real-time
– Lacks real-time TV functionality

Armed with top-of-the-line features such as time-shifting and
instant replay, PowerVCR II makes TV-viewing enjoyable.
With the time-shifting feature, you need not wait for a com-

mercial to answer nature's call. Use the Instant Replay button to
watch the fall of wickets in a cricket match. The instant replay inter-
val could be anywhere between 10 to 70 minutes.

PowerVCR II is very user-friendly—a small window pops up
after its installation, to help you set up the channels. It provides
pre-defined profiles—MPEG-2 Excellent, MPEG-2 Superior, MPEG-
2 Good and MPEG-2 Average—to capture video. It has similar
options for MPEG-1 too. VCD profiles such as VCD NTSC, VCD
PAL and VCD Film are also available. It can convert the captured
video from, or to, any of these formats, without the need for a
third-party converter. It also has controls to tweak image bright-
ness, hue, etc, while recording.  The button on the TV-controls
panel lets you snap a funky TV visual. An image file is automati-
cally created in a default folder. You can also change the storage
folder location.

Another useful feature is the automatic naming of files.
Were it not for this, accidental double-clicks on the Record 
button would have overwritten the current recording session in

the preceding file.
Apart from the all-important inbuilt scheduler, a significant

feature present is Stop Condition, that stops the recording after a
time interval that you define. 

Thus, a mélange of features, topped with great functionality,
makes PowerVCR II the winner in this category.
Price: US$ 49.95

Web site: : http://www.gocyberlink.com/english/index.jsp

PowerVCR II Standard Version
Truly professional 

Use the Capture Format settings to modify colour format, frame size
and frame rate

+ Live-TV options; wide variety of formats to capture video
– A drab time-based stop condition

S O F T W A R E

test drive ■
■ pvr

Setting up the audio-video
source, as well as its format, 
is the most important task in
PowerVCR II
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The best thing about VirtualDub is its range of stop condi-
tions. Stop capture if the capture time, the file size, or the
dropped frame ratio exceeds, or the free space drops below

a specified limit. 
Like others in the fray, VirtualDub lets you apply filters, or

rather a sequence of filters, to the capturing process. Its video fil-
ter dialog allows you to string together a chain of filters that blur
images, re-size the image frame and reduce noise in the captured
frame sequentially.

The software puts a lot of stress, and rightly so, on the prop-
er capture of video—capture video minus jitters, noise, etc. To do
so, it has a variety of settings such as the noise reduction, field-
swapping, cropping, etc.

By default, VirtualDub records in the VCD format. As in
iuVCR, you will need to install the appropriate codecs to record
in other formats. Sadly, it also does not provide any video com-
pression of its own. A volume meter helpfully gauges the audio
input level, and controls the audio level of the recording.

Like iuVCR, VirtualDub names the captured file automati-

cally. It applies a numeric suffix to the filename, which is incre-
mented every time the recording is completed. However, you
need to turn this feature after the software is installed.

And yes, it's absolutely free! 
Price: Free
Web site: www.virtualdub.org

VirtualDub
Only if it knew how to win

+ A variety of stop conditions; provides controls to monitor quality and noise
– Does not have video compression

Out of its satchel of features, one that is unique to WinDVR
is transcoding. This transforms the captured video from
MPEG to AVI, and vice-versa. Another of its exclusive assets

is its inbuilt support to burn recorded movies onto CDs.
Like PowerVCR, WinDVR lets you have that much-needed

control over TV signals. It supports both instant replay, as well
as the pause-and-resume functionality for live video. While the
instant replay time interval could be anything in the range of 1
to 600 seconds, the time-shifting interval can be any value
between 1 to 6,000 minutes.

Another similar feature, is the list of pre-defined profiles such
as MPEG-2 Good, MPEG-2 Better and MPEG-2 Best, and a vari-
ety of PAL/NTSC recording formats.

You are bound to get into the habit of skipping commercials
using WinDVR. The parameter that makes this possible is com-
pletely customisable, and its value can be anything between 1 to
600 seconds.

Apart from features such as snapshot, scheduling, compres-
sion and previewing while you record, you can also password-
protect adult channels. Incidentally, only WinDVR's developers
were thoughtful enough to include this feature.

If you have set up two monitors, you can configure the soft-
ware to play recorded video on one screen, and a TV signal on
the other simultaneously!

You can also specify the minimum space needed by Windows
in the worst-case scenario wherein WinDVR starts to hog nearly
all the available space to record a signal.

All said and done, WinDVR lacks the advanced recording

parameters present
in PowerVCR.  It's
just another record-
ing software that
you may want to consider if you have children running around
the house.
Price: US$ 395 (20 users)

Web site: www.intervideo.com/jsp/WinDVR_Profile.jsp

WinDVR
A near miss

VirtualDub has a number of stop conditions as compared to the rest of
the gang

The 'burn to disc' feature
makes the task of 
creating Video CDs
much simpler

+ Transcoding and burn-to-disc features; live-TV options
– No advance recording parameters such as noise reduction
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Swap two letters in the name of the previous software and
you get WinVDR. However, barring the name, which is
somewhat similar, both software are far apart in terms of

features and user-friendliness.
Windows Video Disk Recorder (WinVDR) itself has variants

that capture video in the AVI or the WMV formats. A better ver-
sion, WinVDR Pro, captures video in DivX, WMV, AVI, MPG and
MP4 formats.

The software has a mixer similar to VirtualDub that is useful
to monitor, as well as control audio input levels. WinVDR pro-
vides an excellent way to capture video from the TV-Tuner card
directly to a variety of formats in real-time mode. Generally, Win-
VDR supports any PCI-bus mastering capture device that uses
the Brooktree (Bt848/878) chipset.

Stop conditions depend only on time; disk space is not taken
into account. Hence, there's no way to stop the capture, in case of
lack of space; all WinVDR displays is an unhelpful error message.

Apart from
features such as
preview and
scheduler, it also
has helpful little
settings that let
you prevent the
screensaver and
the power man-
ager from run-
ning when cap-
turing video. 

H o w e v e r,
you cannot pause
and resume a TV
signal at will, nor
watch an instant
replay—a point
that went against it. Also, it records just one show at a time.
Hence, you will have to narrow down your choice to a single
show if your favourite television soaps overlap. 
Price: US$ 39

Web site: www.artech365.com

WinVDR
Nothing but formats

+ Captured files named automatically based on system date or time; control
audio input level
– Lacks real-time TV functions

End of the show
Well, as they say it on TV, that’s all folks! We took you through
10 TV-tuner cards and five personal video recording software
along with the big Media Center PC. 

WinDVR and Cyberlink PowerVCR II happen to be the most
commonly bundled PVR software. When pitted against each
other and three more, in our tests, PowerVCR II won the battle
hands down. Though WinDVR had unique features such as
transcoding, Power VCR II powered further ahead in the race,
thanks to the advanced recording parameters that let it reduce
noise and enhance picture quality. 

In the TV-tuners section, the cards from Pinnacle and Com-
pro fought for the top slot. The Compro VideoMate TV Gold
Plus, with intuitive software and nifty features, proved itself wor-
thy of the performance crown. On the other hand, the Mercury
TV Tuner Card had enough features that did justice to its low
price and walked away with the crown for Best Value.

The HCL Beanstalk AQ265 Media Center PC is one big enter-
tainment solution. Complete with speakers and an LCD screen,
you won’t need anything else to complete the experience of
watching a movie or playing games. Oh yes, it comes with a
gamepad too! Easily configurable, with just a few wires to plug
in, this Beanstalk is sure to give you a rollicking time! 

A common misconception is that you have to sacrifice comfort
when you switch to watching TV on your PC. Though this may
have been true a few years ago, today, almost all TV tuner cards
come with remote controls to enrich your experience. All you
have to do is spend the first hour configuring the channels, then
sit back and enjoy the show—with the added advantage of being
able to pause live TV, and watch instant replays.

In fact, if you have the Windows XP Media Center edition, you
don't even need to spend that first hour using the mouse. The
navigation is designed to be used from a remote control, instead
of a keyboard-mouse combination. It uses a simple list of
functions instead of the standard Windows menus with buttons all
over dialog boxes.

Just like Media Center Edition, most TV tuner cards bundle PVR
software that work well with the bundled remote control. Though
the software interface may not be viewable from a distance, most

remote controls have neatly labelled
buttons—just as TVs do—so operation
is a snap. The sad truth is that most
third-party software do not support

remotes, and are a pain to use. 

Make that Switch

By default, Win-
VDR Pro provides
a wide variety of
file formats to
save the captured video
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4 . 1  S P E A K E R S

We tested 14 speakers in the 4.1 category, including the
popular picks, and even the select expensive ones. Let’s
take a look at how they fared.

Performance
Sure, it’s great to have FM radio or remote controls, but what real-
ly matters is the quality of sound. So let’s put aside the features,
documentation and ease of use for later, and jump straight to the
performance scores.

In our gaming tests, the Creative Inspire shone, and though
the Odyssey and the Artis speakers performed decently, they
couldn’t match Creative in the boom and thump department.
The Intex IT 2600W speakers were disappointing, and Quake III
sounded more like Quack III on them. The rest were just about
average. Most of the speakers lacked full-bodied, ambient

atmospheric sounds—the sounds were just tinny and sharp.
Another reason for the dismal performance is that most of
these speakers are pseudo 4.1—they don’t actually have four
discreet channels, but instead replicate the two stereo chan-
nels in both the front and rear speakers, which just isn’t
enough for gaming.

Almost all the speakers were washouts in the movie test, bar-
ring the superb Creative set, the Philips and the Odyssey. The
Philips made up for its poor gaming scores with good sound qual-
ity for movies. The Odyssey also performed well here, but the Cre-
ative was the best again. 

Now for the real meat of the tests—the music tests. The Artis
played With or without you by U2 beautifully, with bass that was
tight and punchy, and no booming. The Creative subwoofer
failed and started distorting at higher volumes—it gave up long

before the Artis could even show
signs of distortion. Though not con-
sidered to be in the class of Artis or
Creative, the Adcom also did pretty
well with this song. It needs to
improve its gaming and movie per-
formances tremendously, though. 

The Artis stayed in the lead for
Bullet the blue sky, also by U2—the
mids stayed sharp, and didn’t go
muddy (mixing of the mids and
highs) at higher volumes. Both, the
Adcom and Creative Inspire, went
muddy at higher volumes. There
was also a high amount of distor-
tion evident with most of the speak-
ers when playing this song. Even
the Philips wasn’t able to do the
song justice.

For the both the Hindi songs—
film music and the classical piece—

Tom Cruise is trying to escape the authorities, but they aren’t
giving up on him. Their footsteps echo on the metal floor.
One of them gets his hand on Cruise, but gets a fist in his

face instead. Thump. Tom picks up the shockwave gun dropped
by him and loads it up. A metallic creaking sound emanates as he
loads, and fires it. A deep rumbling sound rattles the glass win-
dows. Had it not been for the pillow that you tore to bits in sheer
excitement, you would not have known that you are in the con-
fines of your room! Cruise shot shockwaves right in front of you!
This is exactly the kind of experience you should expect from a

good speaker set—sound that fills your senses and overwhelms
you. Be it music, movies or games, anything will sound good, pro-
vided you have the right set of speakers. And this month we help
you make a sound choice. 

We didn’t include 2.1 systems, as they can’t really be compared
to the quality of, say, a 4.1 or 5.1 system. We have top-of-the-line
PC speakers, ranging from the Altec Lansing 641 in the 4.1 catego-
ry, to the Megaworks in the 5.1, and the Creative Inspire T7700 in
the 7.1 category. Go through our comparison, and get rid of those
tinny stubs sitting on your desktop.

>> Sound Unbound

Here’s the entire 4.1 range of speakers, lined up for a photo shoot
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the Artis S400 lead the pack. Following closely were the Odyssey
and the Creative. The Artis S800 was surprisingly behind the
S400 in terms of performance, although it is priced about 600
rupees more than the S400. The Frontech did a pretty good ren-
dition of the Hindi songs—especially the classical piece, Rachna
Teen Taal, by Ustad Amjad Ali Khan—where it held its own
against the biggies. In fact, it beat the Inspire, and was second
only to the S400.

The Inspire clearly led the pack in the DVD-Audio tests, with
richer and distinctive sound. The Philips was another set of speak-
ers that excelled in the DVD-Audio department. Surprisingly, the
Philips sound much better when DVD content—movies or
music—is played.

The Typhoon and the Intex were just in the wrong league here,
and were disappointing. What sounded like a bass drum on the
Creative or Philips set, sounded like someone kicking a tin-can on
the Intex IT3000W.

In our audio frequency file tests, there was a wide spec-
trum of variance among the speakers. The Intex IT3000W

scored the lowest, while the S400 was the winner in the tests.
The overall bass champion’s crown was shared by the S400 and
Creative. The Altec Lansing was the winner in the overall tre-
ble scores, followed closely by the Creative, Artis S400, S800,
Frontech and the Odyssey.

The Creative Inspire 4400 has a sub-woofer that com-
prises a wooden enclosure finished in black. A thin
black veil protects the woofer cone from dust. 

A small-wired remote control lets you handle the vol-
ume. The sub-woofer has a rather discouraging bass control
knob—you have to bend your back to access it. Unlike
other Creative speakers, this set is powered by a small, neat-
looking power adapter. The long wires allow you to place
the speakers at the right distance. 

On the performance front, the only speaker set that
completely outshone the Inspire 4400 was the Altec
Lansing 641. The Inspire 440 was a great sport in the gam-
ing arena. The bass was undistorted, and the punch, tight.
The highs were clear and distinct. It hit a similar note in
the music tests. The effects in the DVD test, though, not all
that inspiring, were better than the crowd. The speaker
response is true to the input, until the 75 per cent mark of
the volume level. Push it beyond that, and distortions and
sound clipping from the woofer gets noticed.

Priced at Rs 3,500, the Inspire 4400 provides a bang for
the buck as far as 4.1 sets are concerned. Therefore, geeks
and gals, we are pleased to crown the Creative Inspire 4400
as our performance winner. 

Creative Inspire
4400
Lord of the sounds

Price: Rs 3,500
+ Good response
– Slightly under-powered sub-
woofer

Creative Inspire 4400

Performance
Features
Build quality
Value for money

B-B-

The reproduction of low bass, as well as the upper highs is
good. It gives dynamic image for overall sound. Though the
wattage rating in total is only 41 W, they deliver more fuller
sound. I enjoyed them

— NISSAR ALI CHIKATE

““

We got NISSAR ALI CHIKATE to give us a professional’s opinion on the
speakers we tested. He started out a assistant engineer for Akashwani,
Mumbai in 1989. He then joined Radio Mid-Day as production engineer

in 1995. He is now the
technical-in charge
(station engineer) of
Go 92.5 FM—Radio
Mid-Day’s new avatar.
Well-known in the
recording industry, he
was responsible for a
live broadcast of the
Zubin Mehta concert
on AIR FM from the
Brabourne Stadium.

Profile

OOvveerraallll  MMoovviiee  PPeerrffoorrmmaannccee
Scale of 5
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The testing of speakers was completely subjective. Our test-bed con-
sisted of an Intel 875PBZ motherboard running a Pentium 4 3 GHz
with 512 MB 333 MHz DDR RAM. The sound card used was the
SoundBlaster Audigy2 ZS Platinum PRO that supports 7.1 speakers,
while the video card used was the Radeon 9600 PRO.

Our tests involved two steps—first, we kept the sound control
volume—bass, treble, master, wave, speaker master, etc.—at 50
per cent and ran the tests to check the quality of the sound out-
put. Then we increased the volume to the maximum for both,
sound card and speakers, and carried out the same tests. We used
the native sound control panel for the sound card, and the vol-
ume control on the speakers. Equalizers were never turned on, to
avoid any effects.

Features, Ease of Use, and Manuals and Documentation were
assigned 15 per cent, 10 per cent and 5 per cent of the total scores
respectively. The most important, performance, earned 70 per cent. 

We carried out tests that involved everyday media plus some
special frequency tests. Ratings were given, on a scale of 5, for
each test by three different reviewers, and then we calculated an
average score to reduce subjectivity. Our tests involved the fol-
lowing benchmarks.
Gaming tests: We carried out two gaming benchmarks—Aquamark3
and Quake III—and the sound quality for each was noted. We ran the
complete Aquamark3 demo and the Quake III Intro movie. 
Movie test: This involved DVD playback of the Minority Report auto-
mobile assembly fight sequence. This scene is noted for low frequen-
cy effects of the shockwave gun, and the general atmosphere involv-
ing metallic objects and lasers in the plant, which have a sharp tone.

Music tests: Three separate tests were run here—an Audio CD test,
MP3 playback and DVD audio—comprising both Hindi and
English songs. The songs we chose for the Audio CD test were
‘With or Without You’ and ‘Bullet the Blue Sky’ by U2 from the
album The Joshua Tree, ‘O Rey Chhori’ from Lagaan and ‘Rachna
Teen Taal’ from Ustad Amjad Ali Khan’s album Raag Yaman. The
MP3s we played were ‘Hotel California’ by the Eagles and ‘Duur’
(Reprise)’ by Strings. For the DVD audio test, we played Shut Up
by Vanessa Lausdei.

Each Audio CD song was chosen for a reason: With or Without
You has deep percussive bass that test the subwoofer; Bullet the Blue
Sky has guitar fireworks that test the mids and highs at full volume;
O Rey Chhori tests the reproduction of vocals while the sprinkling of
piano pieces simultaneously tests the highs; Rachna Teen Taal tests
all the speakers with the Santoor and Tabla combination. 

MP3s are compressed audio that generally sound good on any
speaker. We used the normal 128 Kbps, joint-stereo format. Hotel
California tested the subwoofer with its deep bass notes, and Duur
checked the treble reproduction. 

The DVD audio song is encoded in five discrete channels, and fea-
tures excellent mid-range, treble and vocals.
Frequency Tests: These tests involved the playback of special
wav files corresponding to the frequencies of 50 Hz, 100 Hz,
250 Hz, 500 Hz (left and right channels), 1 KHz, 10 KHz and 15
KHz. Points were given to the speakers the could reproduce the
tones perfectly.
Overall Bass and Treble Tests: We played an audio file to check the
overall bass reproduction, and did the same to check the treble.

How We Tested

Four point one, Five point one... stuck in decimals? Here’s a small
primer on the different surround formats out there: 
4/4.1 format: This is a psuedo-surround format as it simulates the
surround effect to a certain degree. It utilises two channels—the
left and right stereo channels. The surround channel information
for the rear speakers is encoded on to the original stereo channels
at a set phase difference and then supplied to the rear speakers. In
case of a separate sub-woofer, all bass effects are diverted to it via
a suitable crossover that’s located on the sub-woofer itself or the
amplifier. This format is on its way out, especially with the falling
prices of 5.1 and higher certified audio systems.
5.1 surround: Also known as Dolby Digital, this surround-sound
format was introduced by Dolby Systems and was first utilised in
the soundtrack of Batman in 1992. It was the first to feature a
dedicated centre channel, as well as a low frequency effects (LFE)
channel, in addition to the four existing channels. Also, this was
the first true surround format that had truly discrete channels, i.e.,
all the speakers received an independent signal without any
distortion or channel mixing. Dolby Digital was followed by

Digital Theatre System (DTS), which offered better compression
than Dolby Digital, giving better audio quality. Today, most
movies and many games are encoded using either the Dolby
Digital or DTS formats. The centre channel here assumes a good
deal of importance, as all human voices are channelled through it
to provide a centralised listening experience.
6.1 surround: In this surround setup, an additional rear centre
speaker is connected to the existing five plus one setup. The
signal for this speaker is obtained by separating a central rear
channel from the original left and right rear signals. The Dolby
Digital EX and DTS Pro Neo 6 can output 6.1 channel signals. As
this is a comparatively newer format, there are only a limited
number of movie soundtracks that feature this.
7.1 surround: This is a top-of-the-line setup, with three speakers
in the front, including the centre unit, two speakers on each side
of the listener, and two rear speakers to complete the surround
effect. Currently, there are no applications or movies that can
utilise such a setup, but some decoders have the ability to upmix
5.1 or 6.1 sound to give a 7.1 output.

Point One Out
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Frontech’s JIL-1870 was the cheapest 4.1 speak-
er set that made it to this comparison. In the looks
department, its heavy dash of unnecessary chrome

raised some eyebrows. The wooden satellites wear a classic
look, with ebony-black finish and a black satin veil on the
front. The sub-woofer sports a nicely brushed aluminium fin-
ish. However, a big, cheap-looking chrome plastic line
around the sub-woofer port mars its looks. The chrome-fin-
ished control knobs are straight out of a classic radio. The set
also comes with a built-in FM tuner. The push buttons that
let you skip through stations are hard and tacky, and require
quite an effort. The wires for the rear satellite are long
enough, but the front satellite wires are quite short. Hook up
the external wire antenna at the back of the sub-woofer for
proper FM reception.

In the gaming test, the speaker performed decently with
the volume at 50 per cent. When we raised it above that, dis-
tortions were clearly audible from the satellites, as well as
the sub-woofer. The effects in the DVD-video test lacked spa-
tial resolution due to its pseudo 4.1 nature. However, in the
Hindi-CD audio and MP3 test, the audio quality was much
better, and the response more balanced. Overall, the
Frontech JIL-1870 speakers sound well till the master vol-
ume is kept below the 70 per cent mark. 

Priced at Rs 1,750, they offer decent audio quality and
good features. Except for the Mercury SW1980, no other 4.1
speaker set can really come close to the Frontech JIL-1870 in
terms of value for money. 

Frontech JIL-1870
Radio ga ga 

Price: Rs 1,750
+ Good value for money
– Distortion sets in too early

Frontech JIL-1870

Performance
Features
Build quality
Value for money

A-A-

1/2 page V AD

The sensitivity of these speakers is very low, so, input should
be such that it will give the correct audio. They sound tinnier, i.e., the
high mid-frequencies (2 to 3 KHz) are boosted. I can say the
bandwidth of the audio is little better than analog telephone lines.
The CD-audio sound on these speakers sound like audio is
compressed at 64 Kbps.

— NISSAR ALI CHIKATE

““
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Manuals and documentation
All the speakers provided a leaflet with information about the
specifications and setup instructions. Creative, however, pro-
vided a quick setup guide with detailed instructions, while
Altec Lansing provided a detailed manual with specifications,
setup and troubleshooting instructions for the 641, and just a
manual with setup instructions and precautions for the AVS
500. Frontech was the worst of the lot—they didn’t provide
any documentation at all. Odyssey followed the same trend
and provided just a quick setup guide, but no specifications.
The rest—Artis, Adcom Mercury, Typhoon and Intex—
provided just a leaflet mentioning the specifications and speaker
setup instructions.

Features
The Adcom, Frontech and Mercury speakers had inbuilt FM
tuners, which is cool because you can listen to the radio even
when the PC’s turned off. Otherwise, none of the speaker sets
were anything to write home about. The Intex had a PC/VCD
button that toggles sound input between the PC and external
VCD player that you can connect to it.

RMS (Root Mean Square) power represents the average sustained
power output by an amplifier while Peak Music Power Output
(PMPO) is its peak power, or maximum power output. They are
related to each other using the dynamic headroom specification
given in dB. So, an amplifier with 3 dB of dynamic headroom
has a peak power that’s double its RMS or average power.
Hence, a 100 W RMS amplifier, with a dynamic headroom of
3 dB has a peak power output of 200 W. A 3 dB increase doubles
the power output. So, for 6 dB and an RMS power rating of 100
W, an amplifier’s PMPO would be 400 watts. Note that you need
to bother only about the RMS power rating. 

Peak power is a relatively useless value in every day life, as
it is only used for very short periods of time. For loud sounds
that need a lot of power, the amplifier may output a peak
power of a lot more than 125 watts, maybe even 400 watts
for just a short period—a fraction of a second. High RMS
power provides the punch needed to play sound at higher
volumes without distortion.

RMS Vs PMPO: The Real Deal

CATEGORY 4.1 SPEAKERS 

FE
A

T
U

R
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BBrraanndd
Model
SSppeeaakkeerr  SSppeecciiffiiccaattiioonnss
Speaker Setup 
Total RMS Power (W) 

Subwoofer (W)
Satellites (W-per channel)
Frequency response

CCoonnttrroollss  pprroovviiddeedd  oonn  ssppeeaakkeerr  sseett  //  RReemmoottee  ccoonnttrrooll
Volume / Bass / Treble / Surround Effects

Miscellaneous
Build Quality (So5*)
MMaannuuaall  &&  ddooccuummeennttaattiioonn  ((YY//NN))
Listing of specifications / Quick setup guide /
Troubleshooting
Ease of Use (So5*)
IInn--ggaammee  aauuddiioo  qquuaalliittyy
AquaMark3 / Quake III
DVD Movie audio quality – VOB File
DVD-Audio:  Treble / Vocals / Bass
AAuuddiioo  CCDD  qquuaalliittyy
English: Song 1 / Song 2
Hindi:  Song 1 / Song 2
MP3 quality: Song 1 / Song 2
Special frequency test files – overall response
Ultimate Bass Test / Ultimate Treble Test

Performance
Features + Ease of use + Documentation
Grand Total (Performance + Features)
VFM 
Prices (Rs)
Grade
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AAddccoomm
ACSP-2910

Pseudo 4.1
40
20
5

30 Hz–20 KHz

✔ / ✔ / ✖ / ✔
FM tuner

3

✔ / ✔ / 
✖

1.5

2.5 / 2
2.5

2 / 2.5 / 1.5

3 / 2.5
3 / 2.5
2 / 2.5

2
1.5 / 2.5

32.49
9.90

42.39
2.79

2,275

AAddccoomm
ACSP-2300

Pseudo 4.1
40
20
5

20 Hz–20 KHz

✔ / ✔ / ✖ / ✔
NA
2.5

✔ / ✔ / 
✖

1.5

2.5 / 2
2.5

2.5 / 2 / 1.5

2 / 2
2 / 2.5
2.5 / 2

2
2 / 2.5

30.16
7.95
38.11
3.19

1,790

AAlltteecc  LLaannssiinngg
641

4.1
200
100
25

27 Hz–20 KHz

✔ / ✔ / ✔ / ✔
Wired Remote

4

✔ / ✔ / 
✔

3.5

4 / 4.5
4.25

4 / 4 / 4.5

4 / 4
3.5 / 4
4.5 / 4

4
4.5 / 4

59.72
17.70
77.42
0.58

20,000

AArrttiiss
S400

Pseudo 4.1
32
NA
NA

40 Hz–80 KHz

✔ / ✔ / ✖ / ✖
NA
3.5

✔ / ✔ / 
✖

2.5

2.5 / 3
3.5

3.5 / 3.5 / 3

3.5 / 3.5
4 / 3.5
3.5 / 4

2.5
3 / 3

44.58
10.85
55.43
3.78

2,200

AAlltteecc  LLaannssiinngg
AVS 500

4.1
30

13.7
3.6

38 Hz–18 KHz

✔ / ✔ / ✖ / ✖
NA
4.5

✔ / ✔ /
✖

2.5

2 / 2.5
2.5

3 / 3 / 2.5

2 / 1.5
2.5 / 2.5
2.5 / 2.5 

2
1.5 / 3.5

32.18
11.30
43.48
2.17

3,000

AArrttiiss
S800

Pseudo 4.1
34
NA
NA

40 Hz–18 KHz

✔ / ✔ / ✖ / ✔
NA
3.5

✔ / ✔ / 
✖

2.5

2.5 / 2.5
2.5

3 / 3.5 / 3

3 / 3
3.5 / 3.5

3 / 3
2

2.5 / 3

38.31
12.10
50.41
2.70

2,800

* Scale of 5
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Ease of Use
Much to our satisfaction, all the speakers came with colour coded
cables—except the Typhoon, which can be a pain to set up. Set-
ting up the speakers was a snap, with no problems that a quick ref-
erence to the leaflet couldn’t solve.

Most of the speakers that made to our Test Centre, came
without remotes, and only had controls for the subwoofer.
Though the Adcom, Mercury, Frontech, Artis, Typhoon and
Intex speakers had the controls on the front of the subwoofer,
the Creative, Philips and Odyssey speakers had theirs behind.
Controls on subwoofers are very irritating, especially if you
place your woofer on the ground, behind your cabinet, or
some place just as inaccessible. The saving grace is that the

The Altec Lansing 641’s bass and treble power are balanced,
so it gives good quality listening. These speakers are best for
quality listening at an affordable price, although I did not quite
like the look of the speakers.

— NISSAR ALI CHIKATE

““

4.1 SPEAKERS 

TTyypphhoooonn
Acoustic 4.1

4.1
42
20
5.5

48 Hz–20 KHz

✔ / ✖ / ✖ / ✖
NA
2.5

✖ / ✖ / 
✖

2

2 / 2
2

2 / 2 / 1.5

2.5 / 2.5
1.5 / 1

1.5 / 1.5
2

2 / 2

27.20
7.80

35.00
2.63

2,000

PPhhiilliippss
A2.510

4.1
35
17

4.5
40 Hz–20 KHz

✔ / ✔ / ✖ / ✖
NA
3

✔ / ✔ / 
✔

2.5

2.5 / 2
3

3.5 / 3.5 / 3

2.5 / 2.5
2 / 2.5
2.5 / 2

2
2 / 3

35.08
11.85
46.93
1.47

4,795

IInntteexx
IT2600W

Pseudo 4.1
130
50
20

40 Hz–20 KHz

✔ / ✔ / ✔ / ✖
NA
3.5

✖ / ✖ / 
✖

2

1.5 / 1.5
2

2.5 / 2.5 / 2

2.5 / 2.5
2 / 2.5
2.5 / 2

2
2 / 2.5

29.61
8.90
38.51
2.75
2,100

MMeerrccuurryy
SW1980

Pseudo 4.1
30
NA
NA

40 Hz–18 KHz

✔ / ✔ / ✔ / ✖
FM Tuner

3

✔ / ✔ / 
✖

3

2.5 / 2.5
2.5

2.5 / 2.5 / 2

2.5 / 2.5
3 / 3

2.5 / 3
2

2 / 2.5

33.66
8.00
41.66
3.47
1,800

OOddyysssseeyy
2200W

4.1
NA
NA
NA

20 Hz–20 KHz

✔ / ✔ / ✖ / ✖
NA
3.5

✔ / ✔ / 
✖

2

3 / 3
3

3 / 2.5 / 2.5

3 / 3
3.5 / 3
2.5 / 3

2
2.5 / 3

39.10
10.80
49.90
3.25

2,300

CCrreeaattiivvee
Inspire 4400

4.1
41
17
6

40 Hz–20 KHz

✔ / ✔ / ✖ / ✖
Wired Remote

4.5

✔ / ✔ /
✖

3.5

3.5 / 3.5
3.5

3 / 3.5 / 3

3 / 3.5
3.5 / 3.5

3 / 3
1.5

3 / 3

42.51
15.70
58.21
2.49

3,500

FFrroonntteecchh
JIL-1870

Pseudo 4.1
37
15
5.5

30 Hz–20 KHz

✔ / ✔ / ✔ / ✖
FM tuner

3

✖ / ✖ / 
✖

2

2 / 2.5
2.5

3 / 3 / 2.5

2.5 / 2.5
3 / 2.5
3.5 / 3

3
2.5 / 3

37.90
8.25
46.15
3.96
1,750

IInntteexx
IT3000W

4.1
150
50
25

20 Hz–20 KHz

✔ / ✔ / ✔ / ✔
NA
2.8

✔ / ✔ / 
✖

1.5

2 / 2.5
2.5

1.5 / 2 / 1.5

2 / 2
1.5 / 2
2.5 / 2

1
2 / 2

27.24
10.30
37.54
1.91

2,950

OOvveerraallll  MMuussiicc  PPeerrffoorrmmaannccee
Scale of 5
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Philips has its main volume control on the front right satel-
lite, while the Creative has a wired remote.

Conclusion
Though the RMS rating and performance of the Altec Lansing 641
4.1 was way above all the other contenders, its price is just as
steep—almost four times more than the rest. This is definitely the
best 4.1 speaker system money can buy, but for Rs 4,000 more, you
can get the Creative Megaworks 5.1, which offers a higher RMS,
performance and the 5.1 channel experience. 

We awarded the performance crown to the Creative Inspire
4.1. It can play anything you want with aplomb, and has rich
sound. The Frontech JIL-1870 was the value winner. It was aver-
age in terms of performance, but for just Rs 1750, the speaker is a
good deal if you aren’t too much into gaming or movies. Music is
okay on these speakers, but don’t even think of turning the vol-
ume all the way up.

The one major advantage 5.1 speakers have over the 4.1
variety, is the centre channel. This channel is used for the
vocals, and performs a crucial part when viewing a DVD

movie. Overall, a decent set of 5.1 speakers is better than any
4.1 set of speakers, in terms of sound quality. Let’s find out
which 5.1 set triumphed.

Performance
In our gaming tests, the Artis X10 and the Creative Megaworks
ruled the roost. Nothing can beat the Quake III scene where the
cigar falls on the ground—the boom shook the Test Centre’s win-
dows! The Artis did not achieve the fidelity that the Creative was
capable of, but gave it a fair run for its money. The Creative 5700D
could not match either in terms of muscle power, but its acoustic
clarity was simply amazing. We used the optical out to test the

speakers, and give it two thumbs up for reproducing the finest of
sounds. However, pumping up the volume resulted in distortion
that was disappointing. We did not expect it to hold its own against
the monsters, but it did a pretty good job. The Philips A3.610 was
another good entrant, but the flat panel satellites ruined the show
when the volume was turned up. The subwoofer provided deep
percussive beats, but the satellites sounded too harsh, and we had
to turn it down almost immediately. 

Our movie tests were a display of audio prowess. The Creative
5700D was unmatched by any speaker in terms of clarity and qual-

5 . 1  S P E A K E R S
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The 5.1 sets say “Cheese”, as they pose for a photograph
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ity of sound. These speakers are truly a delight to listen to when you
play a DVD. Not even the Creative GD580 could match it in terms
of audio reproduction. The Artis did a pretty good job, along with
Odyssey. The Megaworks’ missing tweeters could not match the
5700D in terms of clarity, but the thump at high volumes is enough
to make you reel. The Philips A3.610 put up a magnificent display,
but again went tinny when turned up.

In our music tests, while playing With or Without You,
the Artis X10 produced bass with an almighty thump, but the satel-
lites couldn’t complement the subwoofer. When we turned up the
volume, the subwoofer pumped the bass higher, but the satellites
almost killed the song. Much higher power rated satellites are
required. Next, we moved on to the Creative Megaworks 5.1 550.
The higher you go, the better it sounds. The satellites and subwoofer
are completely in-sync. And the song couldn’t have been played on
much a better speaker to realize the percussions that it has. The
Adcom speakers suffered from the same problem as the Artis. Turn
up the volume, and the neighbours are sure to dial 100 and report
the massacre of their eardrums by the under-powered satellites. The
Odyssey also crashed, and burned at higher volumes. Ditto for the
Philips A 3.610. In fact, its cousin—the A5.600—did better than the
sleek flat panel speakers. 

1/2 pg VAD

No true home-theatre system can ever be complete without
the addition of a high quality powerful sub-woofer. Its ability
to produce rich and powerful bass, and low frequency sounds,
not only enhances the surround effect in a multi-channel
setup, but also gives the listener a more realistic and satisfying
audio experience. Also, with the presence of a special low
frequency effects (LFE) channel in both the Dolby and DTS
digital surround formats, the sub-woofer becomes an essential
element in a high-end digital audio system.

Sub-woofers are very distinct from ordinary speakers in
terms of functionality and design. They are designed to
specifically reproduce sounds with frequencies 80 Hz and
below, such as the rumble of thunder, the growl of a tank’s
engine or explosions. To produce such low frequency tones,
the woofer’s driver has to vibrate slowly, and therefore, is
comparatively larger than the other speakers. Therefore, the
diameter of a normal sub-woofer is within the range of 8 to 12
inches. More powerful sub-woofers, with power outputs of
nearly 800 W, have drivers measuring almost 18 inches across. 

However, the catch with larger drivers is that as their size
increases, the amount of power needed to operate them
increases too. This can be rectified to an extent by providing
an amplifier in the sub-woofer unit itself, but then the costs
shoot up astronomically.

The Woof of The Underdog



In the Hindi audio test, we just didn’t want to test any other
speakers after listening to the Creative 5700D play. If you overlook
its lower RMS output, this is the perfect speaker system. 

In the DVD-audio test, we had to connect to the analogue out
of the DVD, and not the digital out. The Megaworks led the pack
here, and the same went for the MP3 tests. There was only a dif-
ference of a couple of points between all the speakers.

The audio frequency file tests sent the entire test scurrying
for ear plugs. The Philips duo shone in this category, and tied
with the Creative and Altec Lansing speakers. The Adcom seemed
to suffer from acoustic diarrhoea, and we got a few angry shouts
from across the office. 

Manuals and documentation
All the speakers that we received had some form or the
other, of documentation—be it verbose manuals, or
quick start guides. The Creative 5700D and the Creative
GD580 had extensive manuals, in addition to the quick
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Creative’s Inspire 5700D comes with an external Digital
decoder, and is filled to the brim with features not seen

on any other speaker in this comparison. 
It comes in classy black, and has excellent build quality.

The four satellites and the unusually large, curved centre
speaker are made of plastic, but the sub-woofer is made of
wood, lending great depth and punch to the bass. The sub-
woofer isn’t ported, and hence offers tight and deep bass
output that doesn’t distort at high volumes. The most entic-
ing feature of this speaker is the supplied decoder. The
decoder allows you to discretely control the output of cen-
tre and rear satellites, as well as the sub-woofer, thus offer-
ing better hardware control over various outputs. The
‘Effect’ button presents the select predefined modes of
music, movie, four point and stereo. You can also choose
between Dolby Digital, Dolby Pro Logic and DTS output.
The decoder also has three types of inputs—Analogue,
Digital DIN, and both SPDIF coaxial and Optical. All the
connectors are gold plated.  

A full-featured infra-red remote is bundled, and you can
control all the features mentioned above with it. The pack-
age includes a Digital DIN cable, SPDIF Optical cable, coaxi-
al cable, speaker stands and power adapter.

We connected the speaker using the SPDIF optical, as
this offers the best quality. On the performance front, the
speaker was simply fantastic. In the gaming tests, the bass
was perfect, with not a hint of distortion—even at full vol-
ume. At high volumes, the highs seemed clipped. In the
DVD test, the effects were superbly reproduced; but due to
the limited RMS power, it was not as impressive as the
Megaworks 550. In the music test, the overall frequency
response was acceptable, especially the treble response. In
the special frequency test, all tones were reproduced dis-
tinctly, without any audible harmonics.

At Rs 23,999, the Inspire 5700D is the same price as the
Megaworks 550, which made our final decision harder.
If you’re a gamer, and want deep thumping bass, the
Megaworks 550 is your answer. If you’re an audiophile,
nothing beats the versatility that the Inspire 5700D offers,
with various input options
and remote control.

Creative Inspire 5700D
Something for everyone

Price: Rs 23,999
+ Superb clarity
– Comparitively low power

Creative Inspire 5700D

Performance
Features
Build quality
Value for money

C-C-
There is accuracy in the sound; the bass and treble are

clean. It is good for listening to music, watching movies and
playing games. With six speakers and maximum total
power-handling capacity, the sound is enough for your 10 x 12 sq ft
room. If you are interested in clear sound reproduction, these
speakers are the best.

— NISSAR ALI CHIKATE

““
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The Odyssey 4800 watts 5.1 speakers con-
sist of five satellite speakers, a small wood-

en sub-woofer and an external amplifying unit.
The satellites are small and cube-shaped, with spring

latches for the wiring. The sub-woofer was the smallest in
the entire category and was flimsily constructed. The clum-
sy external amplifying unit has provisions for input and
output connectors—input from the PC and output to the
speakers. The unit offers discrete control knobs for all the
channels, and a master volume knob and power switch. The
connectors are properly marked for foolproof installation. 

These speakers performed decently, displaying decent
overall frequency response across the audible spectrum. 
In the gaming test, the higher frequency notes were dis-
tinctly reproduced, but the bass was lifeless, thanks to the
ultra slim subwoofer. Of course, all this holds true for
about halfway on the volume dial, after that, all you hear
is distortion. 

In the DVD video test, the effects were reproduced per-
fectly, but again the sound-quality lacked the depth for
those heart stopping effects. In the music test, especially the
Hindi audio-CD test, the reproduction was good. Though
the MP3s sounded good, it wasn’t the kind of experience
you’d expect from 5.1 speakers. 

In the special frequency test, the speaker set gave decent
audio output, reproducing each frequency with minimal
harmonics. The subwoofer was the weakest link in the
chain. Nevertheless at just Rs 2,800, if you want dirt cheap
5.1 speakers, with acceptable performance, look no further.

Odyssey 4800 Watts 5.1
Almost famous

Price: Rs 2,800
+ Great value for money
– Shoddy build quality

Odyssey 4800 Watts 5.1

Performance
Features
Build quality
Value for money

A-A-

Good at reproducing mid-range frequencies, and for MP3 or VCD
audio. Listening to audio CDs or DVDs may not be a good experience.
The audio reproduction is okay. With the help of the equaliser on the
PC, the performance can be increased. But do not go beyond 10 KHz,
it will add more hiss..

— NISSAR ALI CHIKATE

““
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start guide. However, the Odyssey and the Typhoon
had pretty flimsy documentation; the manuals that
came with the speakers were capable of hand-holding even
a first-time user.

Features
In this department, some speakers definitely had something to
show off. The first thing that strikes you about the Artis X10
is the size of the sub-woofer. Featuring a 12-inch woofer in a
wooden cabinet, it is as heavy to pick-up as it looks. Artis has
gone the whole hog with these speakers providing a wireless
remote, which controls the motorised main volume dial on
the subwoofer. The Creative GD580 and the Creative 5700D
feature external decoders for DTS, Dolby Prologic and Dolby

5.1 decoding, and also wireless remotes that can be used to
control the decoder.

The Adcom set has an external volume control, which had
several controls, including those for the bass, centre and rear
speakers. The control box looks neat, but doesn’t really match
up to the gizmo-ish looks of the Creative 5700D external
decoder. The Altec Lansing XA-3051 features a wired remote,
which has different modes for gaming, music and surround.
Fader controls are on the pod, so you can control the rear and
front channel volume. The Megaworks monsters missed out
on the features part as they only had raw RMS power, but no
digital connectors. The Philips set was pretty good with a wire-
less remote control, but that’s about all it offered. The other
speakers were the usual run-of-the-mill.

Adcom

Advantage 

Computers

011-51618611

info@adcomIT.

com

www.adcomit

.com

Altec Lansing

Zeta 

Technologies

022-24102288

tejas@zetaindia

.com

www.alteclansing

.com

Artis

Kunhar 

Peripherals P. ltd

022-56345758

salesbom@

kunhar.com

NA

Creative

Creative 

Technology Ltd

98203 57713

rajshekhar_bhatt@

ctl.creative.com

www.creative.com

Frontech

Jupiter 

International

022-22001211

frontech@bom5

.vsnl.net.in

NA

Odyssey

Compuage 

Infocom Ltd

022-23842200

mehul@compua-

geindia.com

www.compua-

geindia.com

Philips

Philips India Ltd

9520-27124196,

27120541  

pss.sales.marketing

@philips.com

www.philips.com

Typhoon

Hitech 

Computers

080-23442948

blr@hitechit.

com

www.hitechit.

com

Intex

Intex Technologies Ltd

011-51610224

info@intextechnologies.

com

www.intextechnologies.

com

C
on

ta
ct

s

CATEGORY 5.1 SPEAKERS 

FE
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Brand
Model
SSppeeaakkeerr  SSppeecciiffiiccaattiioonnss
Speaker Setup 
Total RMS Power (W) 

Subwoofer (W)
Centre (W)
Satellites (W-per channel)
Frequency response

External Decoder
Remote (Wired/ Wireless)
CCoonnttrroollss  pprroovviiddeedd  oonn  ssppeeaakkeerr  sseett  //  RReemmoottee  ccoonnttrrooll

Volume / Bass / Treble / Surround Effects
Build Quality (So5*)
MMaannuuaall  &&  ddooccuummeennttaattiioonn  ((YY//NN))
Listing of specifications / Quick setup guide / Troubleshooting
Ease of Use (So5*)
IInn--ggaammee  aauuddiioo  qquuaalliittyy
AquaMark3 / Quake III
DVD Movie audio quality – VOB File
DVD-Audio:  Treble / Vocals / Bass
AAuuddiioo  CCDD  qquuaalliittyy
English: Song 1 / Song 2
Hindi:  Song 1 / Song 2
MP3 quality: Song 1 / Song 2
Special frequency test files – overall response
Ultimate Bass Test / Ultimate Treble Test

Performance
Features + Ease of use + Documentation
Grand Total (Performance + Features)
VFM (So5*)
Prices (Rs)
Grade

O
VE

RA
LL

 S
CO

RE
P

ER
FO

R
M

A
N

C
E 

(S
o

5
*)

AAddccoomm
Home Theater

5.1
NA
NA
NA
NA

40 Hz–20 KHz
✖

✖

✔ / ✔ / ✖ / ✔
3.5

✔ / ✔ /✖
2

2.5 / 3
2.5

2.5 / 2 / 2.5

2.5 / 2.5
2.5 / 2.5
2 / 2.5

2.5
2.5 / 2.5

35
13.7

48.68
2.5

4,050

AAlltteecc  LLaannssiinngg
XA-3051

5.1
56

18.25
17.5

5
32 Hz–18 KHz

✖

Wired

✔ / ✔ / ✔ / ✔
4

✔ / ✔ / ✔
4

3.5 / 3.5
3

3 / 3.5 / 3

4 / 3.5
3 / 3
3 / 3
3.5

3 / 3.5

46
21
67
2

11,250

AAlltteecc  LLaannssiinngg
251

5.1
60
25
7
7

35 Hz–18 KHz
✖

✖

✔ / ✔ / No / ✔
3

✔ / ✔ / ✔
2

3 / 2.5
4

2.5 / 3.5 / 2.5

3.5 / 3
3 / 3.5
3 / 3

4
3.5 / 3.5

45.98
15.5

61.43
2

7,000

CCrreeaattiivvee
Inspire 5700D

5.1
78
30
21
7

35 Hz–20 KHz
✔

Wireless

✔ / ✔ / ✖ / ✔
4

✔ / ✔ / ✔
4.5

3.5 / 4
4

3.5 / 4 / 4.5

4 / 4
4 / 3.5
4 / 3.5

4
4 / 4

53.35
27.35
80.7

1
23,999

AArrttiiss
X10

5.1
210
100
22
22

140 Hz–22 KHz
✖

Wireless

✔ / ✔ / ✔ / ✖
4

✔ / ✔ / ✖
4

4 / 4.5
4

2.5 / 3 /2.5

4.5 / 4
4 / 3.5
4 / 4
4.5

3.5 / 4

56.23
21.55
77.78

1
18,000

* Scale of 5
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TTyypphhoooonn
Acoustic 5.1

5.1
100
20
16
16

30 Hz–18 KHz
✖

✖

✔ / ✔ / ✖ / ✔

✔ / ✔ /✖
2.5

2 / 2
2.5

2.5 / 3 / 2.5

2.5 / 2.5
2.5 / 2.5
2.5 / 2.5

3.5
2.5 / 3

36.97
14.15
51.12

3
3,100

5.1 SPEAKERS 

CCrreeaattiivvee
Megaworks 550

5.1
500
150
70
70

25 Hz–20 KHz
✖

Wired

✔ / ✔ / ✔ / ✔
4

✔ / ✔ / ✖
4.5

4 / 4
4.5

4 / 4 / 3.5

4.5 / 3.5
4.5 / 4

4.5 / 3.5
4

4 / 3.5

56.98
20.95
77.93

1
23,999

OOddyysssseeyy
ODY 5.1

5.1
NA
NA
NA
NA

20 Hz–20 KHz
✖

✖

✔ / ✔ / ✖ / ✖
2.5

✔ / ✔ / ✖
2.5

2.5 / 2
3

3 / 2.5 / 2.5

3 / 3
3.5 / 3.5
2.5 / 2.5

3.5
2.5 / 3

39.33
14.75
54.08

4
2,800

PPhhiilliippss
A5.600

5.1
100
50
10
10

40 Hz–20 KHz
✖

Wireless

✔ / ✔ / ✔ / ✔
3.5

✔ / ✔ / ✖
4

3.5 / 3.5
3

3.5 / 3/ 2.5

3.5 / 3.5
3.5 / 3.5
3.5 / 3.5

3
2.5 / 3

42.89
23.8

66.69
1.5

8,995

PPhhiilliippss
A3.610

5.1
200
100
20
20

40 Hz–20 KHz
✖

Wireless

✔ / ✔ / ✔ / ✔
3.5

✔ / ✔ / ✖
4

3 / 3
2.5

3 / 3 / 4

3 / 3
3.5 / 3.5
3.5 / 3.5

4
4 / 3.5

47.82
21.85
69.67

1
13,995

CCrreeaattiivvee
Inspire 5200

5.1
47
17
6
6

40 Hz–20 KHz
✖

Wired

✔ / ✔ / ✖ / ✖
3.5

✔ / ✔ / ✖
4

3.5 / 4
3.5

4 / 4 / 3.5

4 / 4
4 / 3.5
4 / 3.5

4
3.5 / 4

53.35
19.05
72.4

3
5,300

CCrreeaattiivvee
PCWorks LX520

5.1
46
16
6
6

40 KHz–20 KHz
✖

✖

✔ / ✔ / ✖ / ✖
3.5

✔ / ✔ / ✖
4

2.5 / 3.5
3.5

3 / 3 / 2.5

3 / 3
3.5 / 3

3.5 / 3.5
4

3 / 3.5

45.79
14.35
60.14
2.5

4,800

CCrreeaattiivvee
Inspire GD580

5.1
47
17
6
6

40 Hz–20 KHz
✔

Wireless

✔ / ✔ / No / ✔
4

✔ / ✔ / No
4

3.5 / 3.5
3

4 / 3.5 / 4

3.5 / 4
3.5 / 4
4 / 4

4
3.5 / 4

50.56
25.45
76.01

1
16,000
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Root Mean Square (RMS): The sustained power in Watts that an
amplifier can output at any given time.
Peak Music Power Output (PMPO): It’s the maximum power
that an amplifier can output for a short period of time.
Frequency Response: It is the range of frequencies that the
device is set to operate within.
Dolby Digital 5.1 (Dolby AC-3): Developed by Dolby, this system
has five discrete sound channels, in addition to Low Frequency
Effects (LFE) that are directed to the sub-woofer. 
Dolby Pro Logic: An older standard, this packs in information for
a centre and surround channel in the normal stereo channel.
Essentially, there are no discrete left and right channels for the rear
or surround speakers. 
Dolby Pro Logic II: Audio encoded with Pro Logic II carries five
channels of sound in a traditional two-channel stereo audio signal,
which is then decoded back to five speakers using a Dolby
Surround Pro Logic II decoder. This technology can be used on
any console that does not support Dolby Digital 5.1. The
advantages of using it in game applications include minimal
latency, full frequency range, compatibility with existing cables
and backwards compatibility with mono, stereo and legacy Dolby
Surround Pro Logic equipment.
DTS: Short for Digital Theatre Systems, this is a standard invented
by Steven Speilberg and made its debut in Jurassic Park. It uses a
sampling frequency of 96 KHz with 24 bits allocated to each of

the six channels. Collector’s edition DVD movies normally feature
two soundtracks featuring both, Dolby 5.1, and DTS.
Dolby Digital EX and DTS ES: These are comparatively new
standards that add an additional channel, which is the rear centre
channel and is implemented in 6.1 speakers. Both the standards
implement the rear channel somewhat similarly. For Dolby Digital
EX, a special Dolby Pro Logic decoder is added to the surround
channels creating a rear centre channel. This decoding method first
came to light with the theatrical release of Star Wars Episode 1. For
DTS ES, an additional rear centre channel is supplemented to the
two surround channels.
Dolby Pro Logic IIx: This is a spanking new technology developed
by Dolby Laboratories and is the first and only technology to
process native stereo or 5.1 signals into 6.1 or 7.1 channel output.
Different modes such as movie, music and game are available with
this technology with the music mode featuring additional user
controls such as Dolby centre width, Dolby panorama, and Dolby
dimension.
THX: This is an abbreviation for Tomlinson Holman’s eXperiment.
It’s not a surround sound standard but a seal of approval that is
granted to audio equipment and theatres that meet its standards.
This standard is further divided into THX Select (for installations
upto 2000 cubic feet) and THX Ultra (2000-3000 cubic feet).
Sony Dynamic Digital Sound (SDDS): This proprietary Sony
format provides up to eight channels of discrete sound. Sony
designed this exclusively for motion picture theatres.

Jargon Buster

Ease of use
While most of the speakers were easy to set up, the Creative 
GD580 and the 5700D took a little longer as they had various 
input options, and we couldn’t resist trying each one out. The 
Creative 5700D took the longest—it has a complicated decoder 
configuration. The other speakers were literally plug-and-play,
and the average time taken per set was about 15 minutes—
including unpacking the speakers from the box!

The Odyssey and the Typhoon definitely need to provide a
remote. The Artis has bass and rear controls on the back, but the
remote feels like it would shatter if you dropped it. The Megaworks
remote remembers settings if you leave the speaker on, and leave
the remote on standby. However, the settings are reset if you power
down the speakers. Resetting every time you power up just eats into
precious time that could be better utilised lazing on the couch!

After all the trials and tribulations were over, we finally settled
down to choosing the winners. The Odyssey walked away with the

Value for Money prize, for a decent performance, reinforced by a
killer price of just Rs 2,800. Deciding on the performance winner
was  much tougher. After hours of heated debate, we decided that
the Creative Inspire 5.1 5700D deserved to win. The Creative Mega-
works and the Artis X10 were way ahead in terms of raw power, but
it was the clarity of the Creative 5700D that grabbed it the title.

This (Creative Megaworks 550) is a powerful PC sound station.
If you like to listen to loud music, then this can handle about
500 W RMS output. Because of its steady and powerful bass, it
does not give the clear picture of sound. Needs more pre-
emphasis to increase the highs in the range of 3 KHz till 15 KHz to
get clearer sound. Playing games and watching action movies on
this will be a great experience.

— NISSAR ALI CHIKATE

““
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Creative’s Inspire 6600 speakers are a treat for sound enthu-
siasts. The set consists of six plastic-bodied satellite speak-

ers and a ported, wooden sub-woofer. The extra rear centre
speaker brings an amazing audio realism to DirectSound 3D
games, Dolby Digital EX DVD movies and digital music over
a standard 5.1 speaker set. 

If you have a 5.1 sound card, the up-mix control switch
on the sub-woofer allows you to create a 6.1 sound environ-
ment. The speakers have an aesthetic appeal that adds value
to the decor of the room—for a change, the woofer doesn’t
need to be hidden away. The stand for the centre-channel
speaker is designed specially to be placed on the monitor, so
that the speaker aims downwards. It also comes with a
replacement stand. Colour-coding makes speaker installa-
tion a breeze. Wires are long enough for you to place your
speakers conveniently as per your preference. 

The game test saw the speaker give a reasonably good
audio output. The highs and the bass were reproduced per-
fectly without much distortion. The speaker set holds all the
thuds well up to 70 per cent of the total volume range, after
which distortions are hard to miss. However, the Inspire
6600 reproduces effects perfectly providing immersive game
play. In the DVD video test, the effects were good, but some
how the sub-woofer felt under-powered as compared to
other high-end sets from Creative. Music test proved to be
easy going on these speakers and it reproduced most of the
audible spectrum perfectly. The boom from the sub-woofer
has good depth, and does not turn annoying by being too
loud. Vocal clarity was commendable, so was the distinct-
ness of the instruments.   

At Rs 8,600, the speakers are reasonably priced.
Utilising them to their full potential will require you to
upgrade to a 6.1 channel sound card. 

Creative Inspire 6600 6.1
speakers
Big boom

Price: Rs 8,600
+ Excellent reproduction of
effects
– Needs a better remote control

Creative Inspire 6600 6.1

Performance
Features
Build quality
Value for money

BB

1/2 pg VAD
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The Creative T7700 is the first 7.1 speaker set, and the
only one to take part in this comparison. It comprises

seven satellites and one wooden sub-woofer for a deep
punchy bass. The front three satellites are two-way speak-
ers, with a tweeter and a separate mid-range, whereas the
rest make do with just a full-range speaker. A sleek wired
remote control featuring bass, master volume/on-off con-
trols,  a line-in and a headphone jack is provided. Apart
from these, a new connector, M-port, which allows you to
connect a Creative MP3 player such as MuVo-NX, etc, to the
speakers directly, also makes its way on this cute remote. 

To test these speakers, we used the Creative SoundBlaster
Audigy 2 ZS Platinum Pro since it offers a 7.1 output jack. An
extensive setup guide helps you get the set up without any fuss.
The rear and side satellites have cables long enough to be
placed according to your listening preferences. 

The performance was a mixed result. The highs and
mid-frequencies were reproduced excellently. However, at
24W RMS, the sub-woofer lacks depth and punch. Bass was
clean and undistorted, as long as the volume knob did not
cross the 70 per cent mark. Thereafter, distortions were
clearly heard. 

In the game tests, the speakers reproduced excellent

sound in AquaMark 3, but Quake III sounded rather dull. The
effects are sure to make you jump out of your skin on a
quiet, silent night!

Results in the music tests ranged from average to good.
Sound reproduction is good, but becomes sharper at high
volumes, indicating the tweeters going overboard. It’s a
pleasure to watch a DVD movie—the sound just wraps
you like an envelope, but only if the speaker placement is
properly planned.

Priced at Rs 11,900, the Inspire T7700 is reasonably priced.
However, you need a 7.1 capable card to exploit its full poten-
tial. We recommend this speaker set to those who like watch-
ing DVDs with full effects and aren’t bothered by the lack of a
thundering bass. If you are a gamer or a music lover though,
give this set a miss.

Creative Inspire T7700
Seven for the big blow

Price: Rs 11,900
+ Good build quality
– Subwoofer lacks punch,
effects not reproduced properly

Creative Inspire T7700

Performance
Features
Build quality
Value for money

BB

You’ve just received your dream system—for which you scrounged
and scrimped every single naya paisa—and you’re on cloud nine.
However, as you open the box, your ecstasy quickly dies away, as all
you can see besides the speakers is a large bunch of wires with pins
at their ends, and a bunch of tiny holes to stick them into. What
goes where? 
Analog cables: These connectors are the most common
interconnect links, primarily used to carry analogue audio

signals. They connect low-end soundcards, as
well as televisions, VCRs and CD players to the

speakers. At times, one end of an analog
cable sports an RCA connector that’s
generally smaller than the standard
analog connector. This may occur in

a powered sub-woofer.

Coaxial cables: Coaxial cables are a
combination of two cables—one running
through the centre of the other—separated by a non-
conducting jacket. Coaxial signals carry digital signals very efficiently,
and hence, are used in the newer 5.1 and above sound cards. All
coaxial cables feature an F-connector at one end. Similar to a cable-
TV connector, it is usually linked in tandem with a DIN connector. 
Optical cables: This is the latest type of connector, and utilises
fibre-optic technology to
transmit audio signals. Though
very thin, these cables are very
efficient in carrying digital audio
signals. These are commonly
used to connect DVD players,
and game consoles.

Wired for Sound

Though there are seven speakers in total, they do not have
impressive sound quality. They do not create surround sound at all;
They sound muffled at certain low frequencies. There are better
sounding speakers in 4.1 and 5.1, why do I need 7.1?

— NISSAR ALI CHIKATE

““

➜
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Conclusion
With the sound wars done with, not to mention the loss of hear-
ing that we continue to suffer, it’s time to reflect on the results.

Sound is a very personal, and subjective thing. What may
sound harmonic to one, may be another’s nightmare. These
tests, and their results, give you an insight on each speaker’s
quality and overall performance. The lesson learned: A good
speaker always sounds better when compared to others. How-
ever, that does not mean that the rest are bad! There are a lot
of components involved in the whole scene such as the sound
card, your room and the speaker placement that are conducive
to a good experience.

A surround setup consisting of at least 4.1 speakers is neces-
sary to watch movies, or listen to music. However, that’s being
phased out as all the channels are mixed to provide the surround
experience. 7.1 systems have yet to come of age, and can be con-
sidered an overkill, while 6.1 are still being eyed skeptically.
Media that will take advantage of such features is yet to be avail-
able in the market. And by the time it is, there will be more play-
ers in the same segment, and fiercer competition too. The 5.1
setup, at this point of time, is more than enough for your aural
senses. Currently, this setup is a point of reference for all home-
theatre manufacturers. Thus, it makes sense to opt for a 5.1 today.
For the future, there is a lot more to come.

Decision Maker

You need 

Look for

Our pick

Price

Price conscious

A reasonably good speaker set that offers
surround sound functionality with a good
balance between performance and price

A 4.1 setup that will provide you with an
engaging experience without being
tough on your pockets

Creative Inspire 4400, Artis S400

Upto Rs 4,500

Prudent

You want an extremely good sound
experience without splurging a lot
of money

A 5.1 setup that will please your
senses but may pinch your budget
just a little bit

Altec Lansing 251, Creative Inspire
5200, Odyssey 5.1

Upto Rs 10,000

Enthusiast 

A system with no-holds-barred performance
and state-of the art features plus support for all
the latest consumer audio standards. Price no
bar; Experience? Out of this world!

A setup that will simply amaze you with it’s
clarity and power

The Creative Megaworks 550, Altec Lansing
X10, the Creative Inspire 5700D, GD580, or
Creative Inspire T6600 6.1

Above Rs 15,000

If you are the only person using the system, make sure
that you sit equi-distant from the left, centre and right
speakers. If you always have friends over, then arrange the
speakers in a straight line. Avoid placing the centre
speaker closer to the listeners than the left and right ones.

The left speaker should make an angle of 25 to 30
degrees from the centre, with respect to the listener, as
should the right speaker. We recommend a wider angle,
with the left and right speakers further apart, if you use your
system mainly to listen to music. Also, the three front
speakers should be as close as possible to ear-level.

Place the surround speakers alongside and slightly to the
rear, but not exactly behind the listener. The surround
speakers should be at least about 2 to 3 feet above the
listener’s head.

As for room acoustics, make sure that there are not too
many smooth or hard surfaces that cause reflections. This
harshens and muddles the sound. Carpeting and draping is
a solution. Avoid rooms that are perfectly square, since they
have a noticeable resonant effect. Increase the bass output
by placing the sub-woofer at corners formed by the
intersection of walls, ceilings and floors. 

Sound Spots

2 feet2 feet

2 feet 2 feet

2 feet

For 4.1, 5.1, 6.1, 7.1 connect this satellite
For 5.1, 6.1, 7.1 connect this satellite
For 6.1 connect this satellite
For 7.1 connect this satellite

Side left

Front left

Rear left

Front centre

Sub woofer

60o

Front right

Side right
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Zalman Real Surround 
Sound Headphones Theatre 6 

A heady thud

The Zalman 5.1 headphones are deceptively light, and the earpads are especially comfort-
able. There are three connectors for 5.1 sound—the front, centre and rear channels. The con-
nectors are 1/8-inch stereo jacks.

Sound-quality is decent. The immersive experience is something you simply can’t get with stereo
headphones. Do these headphones really sound like 5.1 speakers? Yes, and no. Though you do get

dimensionality and perspective, especially when watching a movie, it’s not like you’re
immersed in sound. Don’t even think of them as substitutes for 5.1 speakers.

Treble quality is mediocre, and you’ll need to pump it up. The mids and
bass are okay, although the bass can’t be called tight. It doesn’t crack at high
bass, but doesn’t deliver the punch either. They miss out totally on high
trebles and really deep bass. Classical music listeners will be disappoint-
ed. It’s a mixed story for gamers. Though airplanes do seem to whizz
from left to right and front to back, the effect isn’t good enough, peri-
od. A more expensive version would probably deliver the goods. 

These phones are worth the price if you’re not expecting audio-
phile-quality sound, and you’re content with the spectrum being
chopped off at the ends. What these phones are ideally suited for are

action movies. Do remember to use the equaliser, though.

Specifications: 50 Hz - 20 KHz frequency response, 89 db sound level, 0.15 W max power, 316.8 gms weight, three headphone jacks, 
300 cm long cord ■■  Price: Rs 2,995 ■■  Contact: Mediatech India ■■  Phone: 022-26361111 ■■  E-mail: info@mediatechindia.com 
■■  Web site: www.zalman.co.kr ■■  Overall Rating: ★★★ ✩✩ ✩✩

>> That Extra Zing

Home theaters have hit the Indian entertainment market, and
they’re here to stay. Very soon, you’re going to be stuck
with more remote controllers than you can manage—for

your TV, DVD, receiver, speaker set, etc. This is where a true
programmable, universal remote comes in. One unit that you can
control all your gadgets with, and
not sacrifice on functionality.
Universal remotes are
programmable and can
be made to learn the
signals of even the most
obscure features. So,
you can finally do
away with the heap
of remotes.

The universal
remote (marked with a red

circle) has a button that allows you to choose the device to control.
In order to program the universal remote, you need to place the
device’s remote and the universal remote with their IR sensors
facing each other. Now, you press the Learn key on the universal
remote, then the button you want to define, followed by the
corresponding key on the devices remote. An indicator on the
universal remote lights up to tell you that the signal has been

received. Repeat this procedure for all
the keys of the device’s remote that

you want the universal remote
to learn, and you’re done. 

You can even get
advanced universal
remotes that boast of
an LCD display and

better programming
features, to make life easier.

Control your Remotes
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The sleek-looking Samsung LS17E34C LCD TV is both—an
LCD monitor and a TV, with connector slots for TV
antenna, DVD, VCR, and any other A/V device. And it

comes equipped with Dolby surround sound, making the
audio experience as good as the video.

Setting up the TV function on the LCD is a simple, one-
step process—all you do is plug the cable into the back panel,
and start the channel scan. It lets you scan the available
channels and auto-store them. Of course, you can also man-
ually sort them in any order. It also lets you rename channels
with a mnemonic, which means you can name your sports
channel Tendulkar, or your movie channel, Shahrukh.

You can choose from four pre-defined picture standards—
Dynamic, Standard, Movie and Custom. Besides this, you
can also view it in the default 4:3 mode, or magnify it, or
even switch to the 16:9 wide mode. This is useful specially
while switching from TV to DVD mode. 

The Picture-in-Picture (PIP) function allows you to watch a
movie even as you work on the PC. The PIP feature comes with
three window sizes.

It would be worthwhile to mention a design hitch: The
LCD’s control buttons are provided on the top, making it cum-
bersome to reach and adjust. This is partly fixed by the multi-
function remote. It comes with a Kensington lock to make it
theft proof, a device sorely needed for an expensive lifestyle
product like this.

Samsung LS17E34C LCD TV
Two for the price of two

■■     Specifications: 17-inch screen, 140 x 125 viewable angle, 
1280 x 1024 at 75 Hz display resolution, built in TV tuner, HDTV, 
Virtual Dolby Surround, 58W power consumption, 7.7 kg with stand
■■     Price: Rs 74,990
■■     Contact: Samsung India Electronics Ltd
■■     Phone: 011-51511234 ■■  Fax: 011-51608818
■■     E-mail: digimax@samsungindia.com
■■  Web site: www.samsungindia.com
■■  Overall Rating: ★★★★ ✩✩

Philips Micro Hi-Fi System MC-i200
Music from the Net

■■  Specifications: 1500 W PMPO, 70 signal-to-noise
ratio, 50-16,000 Hz frequency response, RJ45
input jack, FM, AM, MW player, three-way bass
reflex system
■■  Price: Rs 34,990
■■  Contact: Philips India Ltd
■■  Phone: 022-5691-2331, ■■  Fax: 022-26879276 
■■  E-mail: r.datta@philips.com 
■■  Web site: : www.philips.com
■■  Overall Rating: ★★ ✩✩ ✩✩ ✩✩

The Philips Micro Hi-Fi system MC-i200 plays streaming media
live from the Internet, apart from AM or FM radio and the
mandatory audio and MP3 CDs. It has a five-line display, a

neat button layout and one-touch keys such as PC link, CD, Tuner,
Connect, etc. It needs Internet connectivity to play streaming
music with the help of the LAN connector. A simple process helps
you configure networking details such as IP address, subnet mask,
etc without much of a hassle. Choose one of the many streaming
Web sites that its panel displays to listen to music of your style.

You can also configure its MyStreams section at my.philips.com to
suit your musical tastes. 

The audio player can also play streams sourced over your own
LAN network using Philips PC-Link software. Sans the LAN, you
end up paying more for features you are never going to use. 

Quality-wise, this system is as good as any other audio player.
However, the maximum volume level seems to be a little low. At
this price tag, you may be better off buying a full-featured music
system or a home theatre, or even a PC with a 5.1 speaker setup.

✩✩



The DVD-equivalent to a VCR, the Samsung DVD-H40S
plays DVDs, and stores programs, images, etc, on its
inbuilt 40 GB hard disk. It has a friendly GUI that lets

you choose between two storage modes—40 hours of video, 
250 MP3s and 10,000 JPEG images, or 30 hours of video, 
2,500 MP3s and 10,000 JPEG images. It comes with 
a huge full-function remote that needs both hands
to control it. 

The DVD-H40S is a great advantage over conven-
tional VCRs—you can record a series of TV programs,

and start watching stuff while it’s still recording. Record videos
at 2, 4 and 6 Mbps. The video output is excellent. It has 
optical and co-axial digital output ports, plus input ports for a
camcorder, VCD, VCR and sound system. The only drawback is

the lack of CD or DVD-writing support, and an interface to
transfer data to and from a PC—something one would
expect at Rs 45,000.

Samsung DVD HDD Recorder DVD-H40S
Move away VCR

■■  Specifications: DVD, VCD, MP3 and CD playback,
Dolby Digital and DTS support, 40 GB hard disk,
video-in/out jacks, component video-out jacks, S-video
in-out jacks, one digital optical audio out, one digital
coaxial audio out, RF antenna input and output
■■  Price: Rs 44,990
■■  Contact: Samsung Electronics India Ltd
■■  Phone: 011-51511234
■■  Fax: 011-51608818
■■  E-mail: digimax@samsungindia.com
■■  Web site: www.samsungindia.com
■■  Overall Rating: ★★★ ✩✩ ✩✩✩✩
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MSI entertainment and gaming appliance (MEGA) are 
series of small form factor bare-bone PCs. Mega PC 180
is a complete new product, re-defining the future of 

bare-bone PCs. 
The Mega 180 is encased in an elegant, jet-black casing. The

front bezel incorporates a colourful LED panel, similar to ones
found on a consumer audio product. What differentiates the Mega
180 from other bare-bones is the fact that you can use it as a stand-
alone audio appliance that can play audio CDs, MP3 CDs and
AM/FM radio without switching on the PC. 

The play, pause, forward, reverse and mode buttons are provid-
ed just below the LED panel for easy access. Two buttons let you tog-
gle between the Hi-Fi mode and the PC mode. A 6-in-1 card-reader
is placed below the LED panel. A push button smoothly opens a
plastic flap to reveal two USB, two Firewire and an SPDIF optical-in
ports at the bottom of the front bezel. The optional TV-tuner card
can be controlled by the accompanying system remote.

The Mega 180 is based around an nForce2 chipset support-
ing AMD Athlon XP 3000+ and DDR 333 via two memory slots.
It offers a dual-monitor out to connect two monitors. The board
offers an 8X AGP slot and a PCI slot for add-on cards. Installing
current-generation video cards will leave no space for any PCI
card to be plugged into the PCI slot. The back panel has four
USB ports, an Ethernet connector and six-channel audio with
SPDIF optical-out. For efficient cooling, MSI has provided cus-

tom-made full copper heat sink with two
lateral fans. The sides of the casing are per-

forated for better air circulation. The interiors are cramped, and
installing drives is a cumbersome job.   

The nForce2 does not disappoint and like all MSI mother-
boards handles system-intensive applications very well. Priced at 
Rs 19,000, the Mega PC 180 is definitely expensive, but it’s the only
one of its kind available in the market today and this exclusivity is
what the price is about.

MSI Mega PC 180
Mini-entertainment-gaming-arsenal 

■■  Specifications: nForce2+MCP-T chipset, six USB ports, two Firewire
ports, AM/FM tuner, MP3 player and optional TV-tuner card  
■■  Price: Rs 19,000
■■  Contact: Cyberstar
■■  Phone: 080-51144075 ■■  Fax: 080-22236781
■■  E-mail: narend@cyberstarin.net ■■  Web site: www.msi.com.tw
■■  Overall Rating: ★★★ ✩✩ ✩✩✩✩



The MSI DR4-A DVD writer can write DVD±R, DVD±RW, CD-R and CD-RW, and read them all.
Bundled along are the Nero CD-writing software, Sonic MyDVD, PowerDVD, Showbiz video-edit-
ing software, an audio cable and manuals.

This drive burns data at the speed of 4X on DVD-R in around 13 minutes, making it a fast burn-
er. Record more than five hours of content on a single DVD that will otherwise take up at

least three VCDs. An advantage of DVD media is that movie-quality is much better than
on the VCD, since there’s more space to fit the content. 

The drive burns DVD-RW at 2X. It just took 23 minutes to burn 4.5 GB of data
on a DVD+RW, at a speed of 2.4X—23 seconds more than the Lite-On 811s. 

The MSI DR4-A Dual Writer erases data just as fast. It wiped data off 
the DVD+RW in just 24 minutes 6 seconds—36 seconds lesser than the 
Lite-On 811s.

Affordably priced at Rs 10,000, it makes a good investment if you watch a lot
of DVD movies, burn tons of data, archive images and songs and convert camcorder

tapes to digital content.

MSI DR4-A Dual DVD-Writer
Burn those DVDs

■■  Specifications: 8 MB buffer,
HD-Burn support, EIDE
interface, speeds: 
CD-RW: 10X, CD-R: 24X,
CD-ROM: 40X, DVD: ±R 4X,
+ RW 2.4X, - RW 2X, 
DVD-ROM: 12X 
■■  Contact: Cyberstar 
■■  Phone: 080-51144075  
■■  Fax: 080-22236781 
■■  E-mail: narend@
cyberstarin.net 
■■  Web site: ww.msi.com.tw 
■■  Overall Rating: ★★★ ✩✩ ✩✩✩✩
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Philips DVD Video Digital Surround System MX5700D
Just like the movies

The Philips MX5700D is a five-DVD and CD home entertainment system, comprising five
speakers and twin tower sub-woofers plus the main unit. The system plays DVDs, VCDs,
SVCDs, DVD+RW, audio CDs, MP3s and mixed mode CDs. An interesting feature is the

provision of a media slot that reads MP3s or JPEGs off memory cards using a PCMCIA adapter.
The front two speakers are clipped on to the top of the twin tower sub-woofers. The sleek

centre and rear speakers definitely have the flair to add that extra bit to your décor. They are
provided with long colour coded wires, making the installation foolproof and fuss-free. 

The main unit has five flimsy individual disc trays placed vertically on the left side. Cen-
trally placed is a display-dial for speaker output. The system status dial displays information
on active media source, volume level, clock, etc. Next to it are nine buttons that enable one
to control various features such as FM tuner, surround sound, playback control, etc. Two large
backlit knobs for volume control and source selection are provided at the extreme right.      

All standard playback features are available for DVDs, including sub-title selection, slow
motion, fast forward, reverse, and title search. Use the media slot to view captured images on
the TV directly. You need a 4-in-1 PCMCIA adapter to use Compact Flash (CF), memory stick,
Smart Media (SM), Secure Digital (SD) or MultiMedia Cards (MMC) with the system. You can
also play MP3 files off memory cards.

Performance-wise, the Philips MX5700D delivers crisp and clear picture quality accompa-
nied by great sound. Though bass is a tad weak, the overall
sound quality is great. The MX5700D is a good home
entertainment package, especially if you consider its fea-
tures and ease of use. 

■■  Specifications: 5-DVD/VCD
changer, media slot, FM-
tuner, Dolby Digital and
7200-watt PMPO surround
speakers
■■  Price: Rs 34,990
■■  Contact: Philips India Ltd
■■  Phone: 022-56912331
■■  Fax: 022-26879276
■■  E-mail: r.datta@
philips.com
■■  Web site: www.philips.com
■■  Overall Rating: ★★★ ✩✩ ✩✩✩✩

DIGIT TEST CENTRE

testcentre@thinkdigit.com
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The best products in different 
hardware and software categories

Motherboard
MSI 875P Neo
+ Terrific performance and equally
good features
- Bad component layout
Contact: Cyberstar
Phone: 080-2276986
E-mail: narend@cyberstarin.net
Price: Rs 15,000

Primary Storage
Maxtor 250 GB MaxLine
Plus II
+ Tons of space
- Gets heated
Contact: Cyberstar
Phone: 011-6438216
E-mail: yogi@maxtor.com 
Price: Rs 20,100

Secondary Storage
Combination Drive
Sony CRX 300A
+ Top performance, 
vertical mountable, 
half height, Mt. Rainer support
- No CD-R or CD-RW media
Contact: Rashi Peripherals
Phone: 022-28260258
E-mail: ho@rptechindia.com
Price: Rs 3,800

Input Devices
Microsoft Multimedia
Keyboard
+ Great feel
- Expensive
Contact: Microsoft Corporation 
Phone: 011-26294600
E-mail: connect@microsoft.com
Price: Rs 1,498

Graphics Card
Gainward GeForce FX 5950
Golden Sample
+ Extremely good performance
- Expensive
Contact: Mediatech India
Phone: 022-56396696
E-mail: sales@mediatechindia.com
Price: Rs 34,975

Sound Card
Creative SoundBlaster
Audigy 2 Platinum 
+ 6.1-channel output
- Expensive
Contact: Creative Technology Ltd
Phone: 9820357713
E-mail: rajshekhar_bhatt@
ctl.creative.com 
Price: Rs 15,199

Speakers
Creative Inspire 5700D
+ Crystal clear sound reproduction
- Will not be able to shake the
room
Contact: Creative Technology Ltd
Phone: 9820357713
E-mail: rajshekhar_bhatt@
ctl.creative.com 
Price: Rs 23,999

Display
LCD Monitor
SONY SDM-N80 18.1-inch
+ Stylish, great performance
- External power supply takes up
extra space
Contact: Rashi Peripherals
Phone: 022-28260258
E-mail: ho@rptechindia.com
Price: Rs 1,47,000

The A-List

Microsoft Wireless
IntelliMouse Explorer
+ Optical Mouse, USB interface,
two extra buttons
- Expensive
Contact: Microsoft Corporation
Phone: 011-26294600
E-mail: connect@microsoft.com
Price: Rs 4,278

Products that topped
our performance tests

Laptop
IBM T40
+ Great design, 
excellent performance
- Expensive
Contact: IBM India Ltd
Phone: 080 2063199
E-mail: sanmenon@in.ibm.com
Price: Rs 1,69,990

Branded PC
Zenith Premium PC
+ 3.2 GHz, 17-inch LCD
- No Operating System
Contact: Zenith Computers Ltd 
Phone: 022-2837 7300
E-mail: one-up@
zenith-india.com 
Price: Rs 60,000

Multi-functional
Device
Xerox WorkCentre
Pro 412
+ Fast printing, excellent 
quality
- Expensive
Contact: Xerox Modicorp Ltd
Phone: 0124-2561930/ 940
E-mail: kuldeep.malhotra@
ind.xerox.com
Price: Rs 72,500

Laser Printer
Samsung ML-1710
+ Extremely fast
- Does not support USB 2.0
Contact: Samsung Electronics 
India Information and
Telecommunication Ltd 
Phone: 011-51511234
E-mail: farrukh@ 
samsungindia.com 
Price: Rs 13,990

Inkjet Printer
Canon S530D
+ Supports direct printing 
from digital cameras
- Expensive
Contact: Canon India Ltd 
Phone: 011-26806572
E-mail: rajeev.singh@
canon.co.in  
Price: Rs 24,995

Scanner
HP Scanjet 4570C
+ Excellent scan quality
- Heavy and bulky
Contact: HP India Ltd
Phone: 011-26826000
E-mail: ashwini-k_aggarwal@
hp.com
Price: Rs 17,999

PDA
Sony CLIE PEG-TG50
+ Runs Palm OSS and has a
320 x 320 TFT LCD display
- Rapid battery consumption
Contact: Solar Systems
Phone: 022-56916834
E-mail: solarsystems@vsnl.net
Price: Rs 27,000

Mobile Phone
Sony Ericsson P800
+ Easy and intutive navigation
- Blocky design makes it bulky
Contact: Sony Ericsson Mobile
Communications International
Phone: 011-26180808
E-mail: sudhin.mathur@
sonyericsson.com 
Price: Rs 34,995

Digital Camera
Canon IXUS 400
+ Cerabrite body, better 
buttons layout, wide shutter
speed range
- Ultra compact body 
hampers handling
Contact: Canon India Pvt Ltd 
Phone: 011-26806572
E-mail: shyam@canon.co.in 
Price: Rs 49,995

MP3 Player
Apple iPod
+ Hard-drive based, FireWire
cable bundled, line-out socket
- Very expensive
Contact: Apple Computer
International Private Limited
Phone: 080-25550575/ 73
E-mail: indiainfo@
asia.apple.com
Price: 30 GB-Rs 45,000

CPU
AMD Athlon64 FX-51
+ Great performance with multi-
media applications
- Expensive
Contact: Tech Pacific
Phone: 022-55960101
E-mail: pratik.chube@
techpacindia.com
Price: Rs 45,000
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Secondary Storage
CD-Writer
Benq CRW5224W
+ Cheap
- Data cable not bundled
Contact: BenQ India Pvt Ltd
Phone: 022-25705231
E-mail: salesenquiryin@benq.com
Price: Rs 2,300

Speakers
Frontech JIL-1870 
+ Good sound at an affordable
price
- Cannot handle high
volumes
Contact: Jupiter International
Phone: 022-22001211
E-mail: frontech@bom5.vsnl.net.in 
Price: Rs 1,750

CPU
AMD 2400+
+ Sufficient power for normal
desktop use
- Cumbersome installation
Contact: Tech Pacific
Phone: 022-55960101
E-mail: pratik.chube@techpacin-
dia.com 
Price: Rs 4,900

Motherboard
Mercury KT400FDSX
+ Good configuration 
- No onboard sound
Contact: Kobian India Ltd
Phone: 080-25566624
E-mail: india@kobian.com
Price: Rs 2,800

Primary Storage
Samsung SV1203N 120 GB
+ Noise Guard and ImpacGuard
- 5400-rpm drive
Contact: Samsung Electronics
India Information
Telecommunication India Pvt. Ltd
Phone: 011-515111234
E-mail: marketing@
samsungindia.com
Price: Rs 7,200

Display
CRT Monitor
LG StudioWorks 700S
+ High resolutions, 
great performance, anti-static,
anti-glare, anti-reflection surface
treatment
- No extra accessories
Contact: LG Electronics India 
Pvt Ltd
Phone: 0120-2560900
E-mail: response@lgezbuy.com
Price: Rs 6,200

Branded PC
HCL EzeeBee
+ Winner of Best Value and
Best Performance
- Needs a better graphic card
Contact: HCL Infosystems Ltd
Phone: 0120-2520977
E-mail: raman@hclinsys.com
Price: Rs 27,490

Laptop
ACI Ethos 4
+ Good configuration for
the price
- Hampered ergonomics
Contact: Allied Computer 
International (Asia) Pvt Ltd 
Phone: 022-56943260/
26733124/ 56407000
E-mail: sales@aci-asia.com  
Price: Rs 54,000

Multi-function
Devices
HP PSC 2110 
+ Good print quality
- No fax capabilities
Contact: HP India Ltd
Phone: 011-26826000
E-mail: seema.dawar@hp.com
Price: Rs 9,999

Laser Printer
Samsung ML-1510 
+ Good image quality
- Slow print speed for combo
document
Contact: Samsung Electronics
India Information and
Telecommunication Ltd
Phone: 011-51511234
E-mail: farrukh@
samsungindia.com 
Price: Rs 11,000

Inkjet Printer
HP 3325 Deskjet
+ Very small form factor
- 765 KB of buffer memory
Contact: HP India Ltd   
Phone: 011-26826000
E-mail: ashwini-k_aggarwal@
hp.com 
Price: Rs 2,999

Scanner
HP 2300 Scanjet
+ Low warm-up time
Contact: HP India Ltd  
Phone: 011-26826000
E-mail: ashwini-k_aggarwal@
hp.com
Price: Rs 3,499

PDA
Palm Zire 71
+ Affordable, good battery life,
comprehensive PIM applications
- No Palm Universal Connector,
no backlight, no expansion slots
Contact: Tech Pacific Technology
(India) Limited 
Phone: 022-55960101
E-mail: aparna@corvoshandwick.
co.in
Price: Rs 7,250

Digital Camera
Kodak DX6340
+ 3.1 megapixel camera with 
4X optical zoom
- Only 16 MB memory 
Contact: Neoteric Infomatique
Phone: 022-24172600
E-mail: rajeev@neoteric-info.com 
Price: Rs 23,000

Mobile Phone
Sony Ericsson T200
+ Light-weight, perfect grip,
WAP 1.2.1 browser and 
43.2 Kpbs GPRS, PIM features
- Keys are hard and noisy, 
unusual socket for the charger
Contact: Sony Ericsson Mobile
Communications International
Phone: 011-26180808
E-mail: sudhin.mathur@
sonyericsson.com 
Price: Rs 5,995

MP3 Player
Ennyah Digisound II
DS601
+ Fast data transfer, feature-rich
Contact: Great World Tech 
Pvt Ltd
Phone: 022-23892828
E-mail: sales@gtechworld.com
Price: Rs 6,250 (approx)

Graphics Card
Compro Paladyne FX 5600
128 MB
+ DirectX 9.0 compatible
- Very expensive
Contact: Mediatech India
Phone: 022-56396696
E-mail: sales@mediatechindia.com
Price: Rs 11,275

Products that are 
the best value buy

Input Devices
Samsung PC Keyboard
+ Unmatched value for money
- No multimedia buttons, wrist
support not bundled
Contact: Samsung Asia Pvt Ltd
Phone: 022-22814886
E-mail: marketing@samsungindia.
com
Price: Rs 300

Logitech Scroll Mouse
+ Ambidexterous design
Contact: Rashi Peripherals
Phone: 022-28260258/ 59
E-mail: ho@rptechindia.com
Price: Rs 475



The 6600 from Nokia is a
successor to the 7650
and 3650 models, and

is much better designed. It’s
smaller, lighter, oval shaped
and uses a Series 60 platform.
It has a dual-tone finish. The
five-directional joy-
stick is flanked by
two customisable
soft-keys. The cam-
era sits in the cen-
tre of a circular
panel at the rear.

It has a 176 x
208 pixel active
matrix TFT display
which supports
65,536 colours;
MIDI is supported.
The internal memo-
ry is 6 MB, but a 32
MB MMC card is included
for additional memory. The
integrated camera captures
video clips at 176 x 144 or 128
x 96 pixels. Standard messag-
ing features are supported. You
can connect to other devices
using Bluetooth or Infra-red.
GPRS and High Speed Circuit
Switched Data (HSCSD) data
transfer speeds reach 40.2 Kbps
and 43.2 Kbps respectively. It
has voice dialling, voice com-
mands, a voice recorder and a
hands-free speaker.

Voice clarity is excellent,
you’ll have no problems, even
in a noisy environment.

The startup time is quite
long, and even the backlight
takes time to come on. How-
ever, when it does, you see a
clear and bright screen. Screen
visibility reduces in direct sun-
light, but is usable. Still pic-

tures captured using
the camera come out
fine in good lighting
conditions. There’s
no flash.

The video-cap-
ture quality is plain
acceptable; The
audio captured with
the video is better. A
sore point is the
length of captured
clips—just about
nine seconds. The
included BL-5C bat-

tery offers a couple of
days’ life with normal usage.

The 6600 is definitely a
phone to consider buying,
especially if you can afford the
price. However, there are not
many compelling reasons for
existing Nokia 7650 or 3650
users to switch to it.

Price: Rs 23,799
Contact: Nokia India
Phone: 011–26779000
Fax: 011–26779147
E-mail: nokia.ebag@nokia.com
Web site: www.nokia.co.in
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The blue-grey Treo 180
from Handspring rolls
the functionality of a

PDA and a cell phone into a
single device. 

It features a 160 x 160
greyscale screen with a lid. The

glass window
on the lid lets

you see who’s
calling. There’s

no graffiti input

mode, but the QWERTY mini-
keyboard is quite handy when
typing long SMSes.

The device can’t read SMS
messages off the SIM card, but
offers to move them to its own
memory when you install the
SIM. The SIM Book module
can read phone numbers
stored on the SIM. Voice clari-
ty is quite good, and there’s an
inbuilt speakerphone option.
The phone supports GPRS, and
you can surf the Web using the
installed Blazer Web browser.

As a PDA, the Treo 180
offers standard Palm applica-

tions such as the Calculator,
Date Book, Memo Pad,
World Clock and To Do. The
Phonebook works as the con-
tacts manager, and integrates
nicely with the phone for
direct dialling.

The device connects to a
PC through the bundled USB
cable; there’s no cradle. Sync-
ing is extremely simple: Just
install the provided software,
and press a button to begin
syncing data.

The inbuilt lithium-ion
battery lasts for just about a
couple of days with standard
phone and PDA usage, though
this period can stretch to about
three weeks if you switch off
the wireless mode and use the
Treo as a plain PDA.

The Treo 180 can work
nicely for you as an integrated
solution. The lack of a colour
screen and a camera at this
price point could be a deter-
rent, though, and there are
newer models in the market
that you can consider.

Price: Rs 14,500
Contact: Pitroshni Corporation
Phone: 022-22000013
Fax: 022-22070143
E-mail: pitronsys@yahoo.com 
Web site: www.handspring.com 

Handspring Treo 180
Digital phone assistant

Nokia 6600
Chubby cheeks, dimpled chin

Handspring Treo 180 BB
Performance
Features
Usability
Value for money

SPECIFICATIONS

33 MHz Motorola Dragonball 
VZ processor, 16 MB RAM (non-
expandable), PalmOS 3.5, 4.2 x
2.8 x 0.8 inches, weight: 147
gms, dual-band GSM 900/1900
MHz, backlit monochrome dis-
play, Infra-red, GPRS, Windows
and Mac compatible

SPECIFICATIONS

Tri-band (GSM E900/1800/
1900), Symbian OS 7.0, dimen-
sions: 108.6 x 58.2 x 23.7 mm,
weight: 125 gms, integrated 640
x 480 camera with 2X digital
zoom, video recorder, 32-note 
polyphony, GPRS, WAP, HSCSD  

Performance
Features
Ergonomics
Value for money

Nokia 6600 B+B+
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Intel has finally announced
the launch of its new
Prescott line of processors.

The Prescotts are the first
desktop processors to be
based on the 90 nm
manufacturing process.

The new processor core
competes directly with AMD’s
Athlon 64 line, but will also
help phase out the Northwood-
based Pentium 4 processors by
the end of 2004. The new
processors will be available
from 2.8 GHz to 3.4 GHz, for
now—Intel estimates that they
will cross the 4 GHz mark by
the end of 2004. For processor
speeds above 3.4 GHz, a new
chipset and socket is under way.
Current Prescott processors
have the same pin count as
Northwood, and are compati-
ble with the Socket 423 moth-
erboard. Most motherboards
supporting 800 FSB processors
will be able to take the
3.4 GHz Prescott, though a
BIOS upgrade from the
board manufacturer
might be required in
certain cases.

The new manu-
facturing process
will help Intel better
the yield per silicon
wafer, thus lowering
the price per proces-
sor. However, it will
be some time before
Intel can pass on
the benefits to
consumers. 

The new Prescott
processors have a
host of new develop-
ments at the manufacturing
level, such as the use of
‘strained silicon’—atomic level
changes in the silicon lattice—
and smaller gate transistor
lengths. All of this helps make
the transistor work faster, and
allows for more transistors to be
cramped on to a chip.

Other improvements, such
as the inclusion of seven layers
of copper interconnect, as

opposed to 6 on a normal
Northwood Pentium 4, help in
designing a complex logical
block, but without increasing
the core area. One particular
disadvantage of the 90 nm
technique is current leakage,
which results in higher voltage
requirement and thus, higher
heat dissipation.

Unlike the Pentium4 EE,
where Intel just added an addi-
tional L3 cache to the existing
Northwood core, the Prescott is
an entire new processor, with
heavy revisions done to the
NetBurst micro-architecture—
the term introduced for Pen-
tium 4 design architecture. The
idea behind this architecture
was to increase CPU perform-
ance by increasing the clock fre-
quency; but increasing the fre-
quency calls for lengthening of
the execution pipeline—a line-
up of ‘to do things’. This again
means improving the branch
predicting unit, so that it results
in proper predictions, saving

time lost due to wrong predic-
tions. Thus, an improved
branch predicting unit is under
the hoods of the Prescott. 

The most noticeable
change is the increase in cache
memories. The L1 cache has
gone from 8 KB to 16 KB, and
the L2 has also doubled to 1
MB. The introduction of 13
new SIMD instructions also
improves graphic rendering

applications. 
Our test system

comprised an Intel
875PBZ motherboard,
ATI Radeon 9600 Pro
Graphic Card, 512 MB
DDR400 RAM and
a 120 GB Seagate
SATA hard drive.
Windows XP with SP1
and all necessary
drivers were loaded.

In the Content
Creation 2004 test, the
Prescott could only out
perform the Athlon XP
3200+. Even the older
Northwood-based Pen-
tium 4 3.2 GHz beat
it—this is due to the
longer pipeline in the
Prescott, which
increases the latency.
This is only temporary,
and will vanish as
processor frequencies
increase.  The Business
Winstone test saw
similar results. 

In UT2003, the
Prescott lost
to the 3.2EE by 3
fps—scoring 80.39
at a resolution of
640 x 480. In the
other gaming
tests that we put
it through, it
was always a
hair’s breadth
behind the
3.2EE. 

In the PovRay
3.5 OpenGL test—a render-

ing benchmark—the Prescott
lost badly to the 3.2EE and the
Athlon XP 3200+. Though the
Athlon FX was the slowest, we
suspect this is due to PovRay’s
problem with the 64-bit Athlon
FX processor. 

In the Super Pi test, the
Prescott returned better scores
than the 3.2EE and Athlon XP
3200+. This can be attributed to
the improved execution unit
within the processor.

The Prescott 3.2 GHz is

temptingly priced at Rs 14,000,
but for now, is too immature a
line to recommend. It’s a good
performer, but doesn’t really
offer any significant advan-
tages, yet. We suggest you wait
for the Prescott’s migration to
the different socket and chipset,
where the advantages will be
more visible.

89

Intel Prescott 3.2 GHz processor 
A little too new

SYSTEM REQUIREMENTS
Socket 478, 1 MB L2 Cache, 
90 nm fabrication Process, 
800 MHz FSB, HT enabled

Price: Rs 14,000  
Contact: SES TECH Ltd 
Phone: 022-26824141
Fax: 022-26824581
E-mail: kp@sesindia.com
Web site: www.intel.com

Intel Prescott 3.2 GHz
processor
Performance
Features
Build quality
Value for money

A-A-

* Lower is better

* Lower is better
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The Centri-
no-based
Wi-Fi 5x

makes a mark in
the looks depart-
ment with a silver-
grey body and the
subtle use of
chrome. The key-
board is comfortable,
while the touchpad is super-
sensitive. The optical drive and
the battery can be easily
swapped. Build-wise, the lap-
top is rugged.

It has a Pentium M 1.4
GHz, 128 MB DDR RAM, 30
GB hard disk and a combo-
drive. We tested using 256 MB
of RAM—and we recommend
the upgrade. The Audio DJ lets
you listen to CDs without
switching on the laptop. 

The hard disk per-
formed below par, affect-
ing the overall system
scores. In Business Win-

stone, 5X scored 24
uni t s—three

units short
of the IBM

T40, our win-
ner in the Thin and

Light category in the
January tests. The graphics

sub-system was a disappoint-
ment: The 5x was able to
extract only 42 fps in Quake
III Arena at 1,024 x 768. The
batteries lasted about five
hours, posting the best scores
to date by any laptop. At 
Rs 84,000, the Wi-Fi 5X is a
decent buy.

7,200-rpm IDE
drives. In the file
transfer test, this
drive outclassed all
the other external
disks we’ve ever tested. It
took just 54.54 seconds for
the 1 GB write test, as com-
pared to 58.33 seconds for
our performance winner, the
Freecom FHD-1 40 GB drive.
The read speed was also the
best amongst all external
drives—it took just 47.12 sec-
onds to read a 1 GB file from
this drive, as compared to
53.66 seconds for the
Freecom. In the CPU utilisa-
tion test, it logged 20.3 per
cent, the highest we’ve seen.

The drive comes bundled

with Dantz Retrospect, a
backup and disaster-recovery
software. At Rs 19,500
excluding taxes, it’s the
cheapest external drive in
terms of price per MB.

Price: Rs 19,500 + taxes 
Contact: eSys
E-mail: yogi@maxtor.com
Web site: www.maxtor.com

SPECIFICATIONS

250 GB, 7200 rpm, 8 MB
buffer, 1.38 Kg, USB 2.0 
and Firewire interface, 
OneTouch hotkey to launch
an application

Maxtor OneTouch 250
GB external hard drive
Perfrormance
Features
Build quality
Value for money

AA

This keyboard-mouse com-
bination retains nearly all

the features of its more expen-
sive brethren, except for a
palm-rest. It has a grey-and-
white finish. The keyboard
ergonomics are good and the
mouse design is ambidextrous.
Two AA batteries make the
mouse slightly heavy.

The keyboard has multi-
media and one-touch
access keys for My
Music, My Docu-
ments, etc. The func-
tion keys can be tog-
gled using [F-lock] to
double up as shortcut
keys for Copy, Paste, etc. Other
features include a logoff but-
ton and a recessed Sleep key.

The combo connects to a
PC via a small radio receiver.
The mouse has USB and PS/2

connectors, but the keyboard
only has a PS/2 connector.

At Rs 4,590, it’s an excel-
lent, but expensive product. 

The elegant-looking
OneTouch external
hard drive is the

answer for any storage needs
you may have. It has a per-
formance-enhancing 8 MB
buffer. The drive

sports a metallic silver and
blue body, with a customis-
able onboard button.

The drive turned up
good scores as compared to
other external drives, in
terms of performance and
features. It has both, USB 2.0
and Firewire ports. In SiSoft
Sandra 2003 Pro, it scored an
impressive 21,428 KBps. It
also logged a low 6 ms access
time, and got to a sequential
read speed of 27 MBps—this
matches that of internal

Maxtor OneTouch 250 GB 
External Hard Drive  
Touch and store

SPECIFICATIONS
Customisable button, sleep
and log-off hotkey, PC and
Mac compatible, ambidextrous
mouse

Price: Rs 4,590 
Contact: Microsoft Corporation
(India) Pvt Ltd 
Phone: 011-26294600
Fax: 011-26292650  
E-mail: connect@microsoft.com 

Microsoft Basic 
Wireless Optical Desktop
Performance
Features
Build quality
Value for money

A-A-

* Lower is better

Zenith Premium Wi-Fi 5x 
Notebook 
Copy cat

Price: Rs 84,000 (Rs 2,000 extra
for an additional 128 MB of RAM)
Contact: Zenith Computers ltd
Phone: 022-28377300
Fax: 022-28364859
E-mail: laptops@zenith-india.com 
Web site: www.zenith-india.com

SPECIFICATIONS

Pentium M 1.4 GHz, 128 MB
DDR RAM, Wireless LAN
(802.11b), 30 GB hard drive,
15-inch TFT, IR port, card read-
er, TV-out

Zenith Premium 
Wi-Fi 5X Notebook
Performance
Features
Ease of use
Value for money

B+B+

Microsoft Basic Wireless 
Optical Desktop 
A good combination
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The ScanMaker 3840 from
Microtek scans at an opti-

cal resolution of 2,400 x 1,200
pixels at 65,535 colours, in
software interpolated mode.
The scanner has a USB inter-
face with three hotkeys for
scan, mail and print.

The provided TWAIN driv-
er is not as intuitive as those
that come with other scanners;

also, values are predefined.
However, there is an advanced
mode, from where you can cus-
tom-define the resolution, and
set brightness and contrast. 

The build quality is solid,
and performance was decent.

Scanning our text doc-
ument at 300 dpi
took 24.78 seconds. It
took a little over three
minutes for the same

Based on the Intel 865G
chipset, the Shuttle SB62G2

XPC is a miniature power-
house. It has a brushed alu-
minium finish, and stands no
taller than half a mini-tower.
The screwless cabinet houses
an 865G chipset-based custom-
made motherboard, which
supports a Pentium 4
processor up to
3.2 GHz, and
has two memo-
ry slots for 400
MHz DDR
memory. Cool-
ing for the
processor is via a specially
designed heat-pipe cooling
technology. The bracket that
holds devices such as the hard
disk is detachable. The neces-
sary cables are provided, and
the detailed manual illustrates
the cable layout procedures
clearly. There’s one AGP slot
and one PCI slot. The back
panel has an onboard LAN
connector, four USB 2.0 ports,
one Firewire port, one onboard
VGA connector and a serial

port. The front has additional
USB and Firewire ports. The
XPC comes with support for
six-channel sound, and optical
In/Out for SPDIF connections.

In the Content creation
and Business Winstone test,
the XPC nearly outperformed
several recently tested mother-

boards. The video
encoding test took
72 seconds—similar
to other 865-based
boards. Gaming
performance, too,
was comparable to
that of most 865-

based boards.
The XPC is priced at 

Rs 16,500—an expensive
proposition, considering that
it’s basically just a motherboard
in a space-saving cabinet.

SPECIFICATIONS

865G chipset motherboard,
support for DDR 400 MHz, 
six USB 2.0 ports, two Firewire
ports, SPDIF-In/Out, proprietary
heat pipe cooling, 220 W
power supply

Price: Rs 16,500
Contact: Mediatech India
Phone: 022-26361111
Fax: 022- 26312222 
E-mail: info@mediatechindia.com
Web site: www.shuttle.com 

SB62G2 Shuttle XPC

Performance
Features
Build quality
Value for money

BB

SB62G2 Shuttle XPC
Bonsai powerhouse

This 2.5-inch form factor
drive gives a much needed

boost to laptop performance.
We tested the drive with a
Zenith 5X Premium notebook,
and the scores were compared
with those of the 4,200-rpm
drive within the laptop. The
Travelstar scored much higher,
as we expected.

In the SiSoft Sandra 2004
Pro drive benchmark, the
Travelstar managed 25,592
drive-indexes, as compared to
just 11,724 for the 4200-rpm
drive. It also logged 37 MBps
sequential read speed and 7
MBps sequential write speed,
as compared to 16
MBps and 4 MBps
respectively for the
4,200-rpm drive.

This drive is
best suited to note-
books that use desk-
top processors, and also have
better graphics chips on
board. The Travelstar is also
suitable for slim form-factor
desktop PCs such as the Dell
Optiplex series.

The price—Rs 20,500 plus
taxes—makes the Travelstar
an expensive upgrade, but if
you use your laptop for disk-
intensive computing needs,
this is the drive we recom-
mend. The Travelstar carries a
three-year warranty.

SPECIFICATIONS

60 GB, 7,200 rpm, 2.5-inch
form factor, ATA6 interface

Price: Rs 20,500 plus taxes 
Contact: Spectra Innovations Inc
Phone: 011-25737668
Fax: 011-25737668
Web site: www.hitachi.com

Hitachi Travelstar 7K60
(60GB 7200rpm laptop
hard drive)
Performance
Features
Build quality
Value for money

BB

Hitachi Travelstar 7K60 
(60GB 7200rpm laptop hard drive) 
Faster, and how! 

document at 1,200 dpi. It
read the scanned newspaper
image using OCR software
without a glitch.

The scanner also passed
the image quality evaluation
test with above-average results.
It disappointed in the smooth-
ness test, where the image was
a little on the dark side; also,
the colour blend in a shad-
owed area appeared blocky.

The scanner is priced at 
Rs 4,990, and makes for a good
buy wherever scanner use is
occasional. We recommend it
for document scanning, but
not for images.

SYSTEM REQUIREMENTS

1,200 x 2,400 dpi, A4 scan
area, USB interface, 48-bit
colour depth

Price: Rs 4,999 
Contact: Rashi Peripherals  
Phone: 022-28221013
Fax: 022-56916609
E-mail: ho@rptechindia.com  
Web site: www.microtek.com 

Microtek ScanMaker
3840
Performance
Features
Ergonomics
Value for money

B-B-

Microtek ScanMaker 3840
Cheaper, faster, better 
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developers can extend the
existing functionality.

On the performance
front, the software handles
voice commands exceeding-
ly well, but when it comes to
dictation, it doesn’t get every
word right. This performance
lag is only for a short while,
though. However, there are
times when the software
doesn’t understand a word,
even after one repeats it as
many as four or five times.

This professional version
costs Rs 44,995—consider it
only if your workload is 
very large.

Price: Rs 44,995  
Contact: ScanSoft International
Phone: 011-26207477
Fax: 011-26207495  
E-mail: sameer.dania@scansoft.com
Web site: www.scansoft.com   

SPECIFICATIONS

Intel Pentium III 500 MHz or
equivalent processor, 256 MB
RAM, 300 MB hard disk space,
Microsoft Windows 98, Me,
XP, 2000, 95C or NT4, with
SP-6 or greater, Creative Labs
Sound Blaster 16 or equivalent
sound card supporting 16-bit
recording, Microsoft Internet
Explorer 5 or higher, CD-ROM
drive, ScanSoft-approved
noise-cancelling headset
microphone (included), speak-
ers (for playback of recorded
speech and for text-to-speech
features)

Dragon Naturally
Speaking 7 Professional

Performance
Features
Ease of use
Value for money

B+B+

AverMagic Pro Plus is
an image-editing tool

that lets you retouch old
or damaged images,
revive them, do digital
mixing, create visiting
cards and so on. Using
the software, you can turn
black and white images to
colour; you can define the skin
tone in photographs, and even
smoothen wrinkles.

The digital mixing feature
is most commonly used in
wedding albums. The process
requires patience, though. Text
can be added for effect. There
are several pre-defined tem-
plates that allow you to quick-
ly create frames for the front of
albums, select a canvas with a
texture of choice, place objects
such as flowers into your pho-
tographs, and so on. 

The features this software
offers are all there in Photo-

shop; however, AverMagic Pro
has been specifically developed
for tasks such as the ones
above, and the learning curve
is therefore reduced.

It is worth its price of Rs
3,750 as it is customised to
do a niche job, and do it
more efficiently.This is the latest version of

the popular software.
There’s a new Vocabulary
Optimiser, which analyses
the documents on your
machine, to under-
stand your writing
habits. The provid-
ed handbook
explains all valid
voice commands,
such as "start Inter-
net Explorer",
"click control
menu", etc.

The software provides
good functionalities, such as
integration with Word,
Internet Explorer, playback

of dictations, voice con-
trol of Windows, cus-
tomisable vocabular-
ies, and more. There’s
support for additional
input devices such as
a digital recorder,
Pocket PC, cordless
microphone, etc.

The software pro-
vides a set of APIs so that

Dragon NaturallySpeaking 7 
Professional 
Hands-free typing

SPECIFICATIONS

Windows XP or 2000, PII or
above processor, 64 MB or
more of RAM, 2X or a faster
CD-ROM drive, 15 MB hard
disk space, SVGA video card

Price: Rs 3,750 
Contact: Aver Software 
Technologies Ltd
Phone: 022-26732955
Fax: 022-26732956   
Web site: www.avermagic.com

AverMagic Pro Plus

Performance
Features
Ease of use
Value for money

B+B+

The DG-210 features 2.1
megapixels, 3X optical and

2X digital zoom, and a 16 MB
Compact Flash memory card.

The camera looks rather
bulky. There are several incon-

veniences that are apparent:
you need to press the shutter
button for about two seconds,
and wait for a sound
before the image gets
clicked. The flash takes
over three seconds to
charge. The lens moves
in and out very slowly,
making it difficult to capture a
moving object and refocus on
the fly. The images we clicked
were dark, both indoors and
outdoors. Colours such as

orange were too bright, and
green, too dark.

The camera is targeted at
photo studios, and so comes
with Photoshop 5 LE, which
can be used to generate mul-
tiple passport size images.
The DG-210 allows exposure
settings from +2EV to -2EV in
steps of 0.5EV. Regular users
need to have knowledge of
how to adjust this in differ-
ent conditions for decent
photographs.

At Rs 10,000, the camera is
cheap, and will appeal to those
migrating from film to digital
cameras. However, we recom-
mend spending a few thou-
sands more for a better camera.

DigiVue DG-210 2.1 MP Camera
When price matters

Price: Rs 10,000
Contact: Monarch Video Vision
Phone: 022-22619022
Fax: 022-22618706
E-mail: viren@bom2.vsnl.net.in
Web site: www.monarchvision.com 

SPECIFICATIONS

2.1 megapixels, 3X optical
zoom, 2X digital zoom, 16 MB
CF card, four AA battery

DigiVue DG-210 
2.1 MP Camera
Performance
Features
Ease of Use
Value for money

B-B-

AverMagic Pro Plus
Magician at work
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Recently, I was at a friend’s house for
a UT 2003 LAN party. Of course, this
friend is one of those people who

can deflate your ego in a nanosecond. He
has six gaming rigs, and one personal PC.
The gaming rigs are standard high per-
formance machines, made-to-order, for
one purpose only—gaming. His personal
computer, on the other hand, has the lat-
est and best hardware, a 19-inch flat mon-
itor, 7.1 speakers with bass that can knock
the breath out of you, etc. 

On my way home, after eight gruelling
hours of splattering and being splattered
by rocket launchers, I realised that I have
almost as good a PC configuration as
him—the difference between amazing
and average was just the sound power
and quality. While I was busy
scrounging, scrimping and saving
money to buy faster RAM, faster
and larger hard drives, faster CPU,
the best motherboard, a 9800 Pro
graphics card and a huge monitor,
my friend outsmarted me with
amazing audio. My mind was made
up—I would take a trip to Mum-
bai’s Lamington Road the next day
to get that perfect sound.

I walked into the first shop that
displayed speakers, and told them
that I wanted the best sound solu-
tion that my money could buy. He
suggested a Creative SoundBlaster
4.1 Digital sound card with Cre-
ative Inspire 4.1 speakers. The cost:
Rs 1,200 and Rs 3,000 respectively.
He suggested the Creative SBS 2.1 370 as
well, for Rs 1,550. I promptly demanded
more, and the best he came up with was
the Creative SoundBlaster Live 5.1 SE

sound card and Creative Inspire 5.1 speak-
ers—Rs 2,070 and Rs 4,700, respectively.
He told me that I could opt for Altec Lans-
ing speakers, but they were more expen-
sive and didn’t offer any performance
gains over the Creative sets. According to
him, Frontech and Mercury were just
cheap, but did nothing for the ears of even
the most amateur of audiophiles. 

From here on, almost every shop I went
into said exactly the same thing. Some

even suggested the Frontechs. Oblivious to
things such as frequency response and
RMS power, they insisted it was a good buy

just because it offered an FM tuner. “You
can listen to radio even when the PC is off,
what more can you want?”, asked one.
Frustrated, muttering under my breath
about morons selling onions and potatoes
instead of superbly crafted hardware, I
plodded on.

The next guy suggested a JBL PRO 2.1
speakers. “Nice,” I thought. “Only Rs
9,500", he added. “Umm, not so nice
after all. Breathe, breathe, must remem-
ber to breathe”, I told myself. “Nothing
in 5.1?”, I asked aloud. He shook his

head. Relieved, I darted for the exit.
I saw a guy walking out of the
smallest looking shop on the
road, carrying a large carton that
screamed Artis 5.1. I walked in 
to find a young man of about 
24 behind the counter. 

The shop had everything you
could dream of, all precarious-

ly stacked and balanced
right up to the ceiling. The
guy also seemed to know
his stuff. The store was
crowded with about two
people, so I waited my
turn politely. When he
nodded at me, I asked for
the best sound solution

available. “Depends, on your
budget”, he shot back. “The

sky’s the limit”, I replied. “OK then, how
about a Creative 7.1 solution?” he asked.
Now we’re talking! I asked to see it. “Have
you noticed some space in here that I
haven’t?” he asked, and with a smile 
started dialling four and eight digit 
numbers randomly.

He finally gave up and told me 
that there were none available off hand,
and there would be a minimum waiting 
period of 15 days. He wouldn’t give me
the price, saying, “Fifteen days is a life-
time in this business, the price could 
double, halve or remain the same. Give
me your phone number, and I will call
you as soon as they’re available.” I left the
number and went home. Now, I’m way
too excited in expectation of the 7.1s, and
terrified of the price he’s going to quote.
“The sky’s the limit indeed!”, me and 
my motor-mouth! 

■ Ensure that you have the 
requisite connectors on your
sound card or onboard audio,

before you buy a speaker set, 
especially if you are buying a 4.1 or 

a higher system. Basic speakers need 
only one connector, while the 4.1 and 
5.1 systems have three connectors. 
■  Make sure that you get the original
cords and connectors, as they also affect

the quality of the sound dramatically. 
■ If you are buying stands for the speak-
ers, ensure that the satellite speakers sit
on them rigidly. 
■ Insist on a demo before buying, and if
possible, at the place where you are going
to install it.
■ Buy noise-cancellation headphones—
similar to those used in airlines—if you
plan to use headphones in a noisy area. 

Mahesh Benkar

Aural Aura
Agent 001 mulls over hitting the right note
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Gaming is no longer a geek thing!
From bored secretaries playing
Solitare and Bejewled to self-pro-

claimed gamers drooling over the scenery
in Serious Sam II, everyone has a favourite
game. We all love to boast about the
scores we’ve achieved in the games we’re
obsessed with—this week’s games at least.

Blame it on the competitive world we live
in, and the rat race we’re all trying to
win—the fact is the thrill of a ‘High
Score’ is like a drug. This substance abuse
is no longer limited to teenagers, or the
teens-at-heart—my mother, who can just
about check e-mail, has developed a
dependence on Dynomite, a game from
Pop Cap Games.

Of course computer manufacturers are
making the most of all this, and coming
out with ‘Gaming rigs’ for those who need
really high frames per second (fps) rates,
aniscopic filtering, etc., while playing
Halo, Quake III, Serious Sam, etc. Even gam-
ing consoles such as Microsoft’s Xbox and
Sony’s PS2 are gaining popularity, in turn
making multi-player gaming more popu-
lar. How many of you out there with kids
in the family have been bugged to chap-

erone an outing to McDonalds,
more for the PS2 than the

burgers? The ris-

ing Internet penetration also helps, as
there’s tons of competitiveness when play-
ing multiplayer games. The thrill of play-
ing a game against someone as far off as
Iceland or Argentina is also addictive.

There are basically two different types
of games—browser-based games and
stand-alone games that connect to game
servers. Browser-based games need no
additional software to be installed on 
your machine, and are usually quite 
simple and straightforward. These include
games from Yahoo! Games (http://games.
yahoo.com) and MSN Gaming Zone
(www.zone.com); both feature single as well
as multiplayer games. Stand-alone games
such as the Quake series, Halo, Half-Life,
Counter-Strike, etc., need you to run the
game and then connect to Internet game
servers to participate in a game.

Nothing but e
Browser-based games are popular for two
reasons. First, you don’t need a high-end

machine to play them, as
they run within a browser

window. Second, you
don’t need to install
any major software.
Most games use the

Java Run Time Environ-
ment, Macromedia Flash

or Macromedia Shockwave
players, you can install

these from www.java.com
and http:// www.macrome-

The Internet is the ideal arena for gaming challenges. But
which games and where do you find them? Read on...

PHOTOGRAPHER: Mexy Xavier IMAGING: Solomon Lewis
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dia.com/downloads/. 
Perhaps the first name that one thinks

of when going online to play a game is
Yahoo! Games. It provides many Java-
based single and multiplayer games. If you
are playing a multiplayer game, you can
choose a room to play in. After you have
joined a room, you can join an existing
game, create your own game, or just watch
a game. The best part of Yahoo! is that it
comes up with new games frequently—
addictive games that are easy to learn. 
The bad part is that not all games are free.
Keep an eye out for the words ‘All-Star’,
these require you to pay Yahoo! a small fee
to play. It’s also hard to figure out which
games are single player and which 
are multiplayer. 

Another thing to keep an eye out for
is the attitudes of players. Yahoo! has a
ranking system: when you first join, you
are given the rank of ‘Provisional player’.
Based on your performance in successive
attempts, this ranking improves. The
problem is that higher ranked players tend
to treat a Provisional player as an amateur;
they might even refuse to play. If this hap-
pens, simply ignore them and find other
players and games to join.

MSN Gaming Zone (www.zone.com)
from Microsoft offers 71 free single and
multiplayer games. The games are
designed well, and you may need to load
some software before you can play. When
you get the software install security warn-
ing, insure that it’s from Microsoft, click
Yes, and you’re ready to play. Though
there are paid games available, the free
games section is clearly demarcated on
the home page. However, you will have
to endure many advertisements, and
ensure that you click on the correct link
to start playing. Also, remember that
there might be problems if you use a
browser other than Internet Explorer 5
and above. 

Playsite (www.playsite.com) offers many
interesting and addictive Java-based single
and multiplayer games. The emphasis of
this site is on winning virtual cash by play-
ing games. When you register as a ‘Free
player’, you’re given 500 ‘Playing bucks’.

Depending on whether you lose or
win, playing bucks are added or sub-
tracted from your account. This adds the
feel of playing with real money, and can
get quite addictive. You can keep asking
for more until your request total up to
500 playing bucks. All the games are con-
veniently arranged in categories—Card
Games, Billiards, Puzzles, Word Games,
Board Games, etc.

Miniclip (www.miniclip.com) features
around 150 free Macromedia Flash and
Shockwave games, and more games are
added frequently. You will find many
unique games here such as Snowboarder,
Golf, Trial Bike, Table Tennis and
Couronne. The only drawback is that
since they’re all based on Flash or Shock-
wave, the games might take a little long
to load, especially if you’re on a dial-up
connection. Some games are totally 
free, while others are demo versions of
paid games. If you are playing a demo
version, you can only play each game for
15 minutes a day. 

SkyLords found at www.skylords.com, is
a massive multiplayer strategy game,
which is played using only your browser,
totally free! It includes many interesting
features such as diplomacy, trading, pira-
cy, espionage, space battles, custom space-
ship model designing and clan warfare.
This server can support thousands of play-
ers at a time, and each round lasts a
month—starting on the first of every
month, but you can join in anytime.
When you signup, you have to undergo a
training session to learn how the game
works. This game is recommended for
those who love strategy games. Another
game similar to SkyLords is Fate Lords
(www.fatelords.com), and they’re many
more online. To learn more about these
MMOGs (Massive Multiplayer Online
Games), go to MassMOG (www.massmog.
com), a site dedicated to gaming and 
development news, articles and a 
discussion forum.

Everything but e
Though browser-
based games don’t
require fast con-
nections and
servers, software-

based games
such as the Quake series
do. Even if you have a fast con-
nection, but use a slow server, or use
one that’s just too far away from you, be
prepared for jerky frame rates and a thor-
oughly uninspiring gaming experience.
When playing software-based games
online, remember the golden rule of
Ping. The ping command is your friend,
and will help you have a better gaming
experience. The ping application is used
to verify the existence of an IP address.
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Before joining a server, make sure to ping
it to see whether it’s worth joining. Go
to Start > Run, type ‘command’ and press
[Enter]. Ping the game server by typing
‘ping <IP>’ or ‘ping <URL>’ depending on
whether the server you have is in IP or
URL format. 

The average value is what
you should look at, the lower it
is, the closer or faster the server
is. An average of 300 ms or more
is bad, and you definitely don’t
want to be on such a server. Also
remember that data loss should
be as close to 0 per cent as possi-
ble. For India, games servers
located in the US are just too 
far away; instead look for servers
in Singapore, or within
India itself. 

There are three differ-
ent ways to find the serv-
er that is nearest to you.

The first is to use the in-game
browsers. Many games, such as
Halo, Call of Duty, IGI2, etc., have
in-built browsers to find the
servers. Normally, to access these,
you have to go to your game’s Mul-
tiplayer > Internet menu option.

Here you’re pre-
sented with a list
of available game
servers, the num-
ber of users, ping
times and other infor-
mation. Arrange the 
list in ascending order
by clicking on the 
‘ping’ tab, and join the
server with the lowest
ping time. 

Another method is 
to use third-party game-
server browsers. These

browsers are like the in-game browsers,
except that they support many games.
One of the most popular browsers is
Game Spy Arcade—download it from
www.gamespyarcade.com. Not only can you
find servers for most games, you can also
use the inbuilt Web browser for some
browser based fun.

Qtracker (www.qtracker.com) is a server
browser with additional functionalities
such as LAN game server browser, server

launcher, MP3 streaming audio browser,
HTM server list generator, etc. It keeps
track of where a particular player is play-
ing, and shows you an image of the map
the player is playing on. You can change
skins, and also search within Asia for a
game server—thus providing you with
faster servers.

Another game server browser called
aGSM (www.agsm.net), allows you to find

Thousands of people play the browser-based multi-player
strategy game SkyLords

You can ping yourself by typing ‘ping 127.0.0.1’ or ‘ping local host’

Use your in-game browser to find the game server with
lowest ping

Web site
Yahoo! Games

MSN Gaming Zone

Miniclip

SkyLords 

Game Spy Arcade

Qtracker 

Frag-shak

Kawabonka 

URL
http://games.yahoo.com

www.zone.com

www.miniclip.com

www.skylords.com

www.gamespyarcade.com

www.qtracker.com

www.frag-shack.com

www.kawabonka.com

Pros
Addictive and easy to learn games.

Clearly demarcated section for Free games

A lot of unique games

Interesting MMOG game with many interest-
ing features such as diplomacy, trading, pira-
cy, espionage, space battles, custom space-
ship model designing and clan warfare
Has a huge number of supported games. You
can also play browser-based games

Can search for LAN games. In-built MP3
streaming audio browser can generate HTML
server list

Servers in Mumbai

Free servers in Delhi

Cons
Many games are not free
You may need to install some software to
play certain games. Most games are large,
and take time to load
Demo versions can only be played for 15
minutes a day

Not everyone likes MMOGs

None

Doesn’t support as many games as Game
Spy Arcade

Paid service; doesn’t support many games

Doesn’t support many games
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and monitor multiplayer game servers
for many popular online games. Those
who run Linux can use XQF (www.lin-
uxgames .com/xqf/), a game server browser
and launcher that supports many popu-
lar games such as the Quake series, Unre-
al Tournament, Half-Life, etc.

You can also use your Web browser
and go to specific sites to find the near-
est servers. Web sites such as Moritt
(http://www. morritt.tv/UT2003), which are
dedicated to a specific games—Unreal
Tournament 2003 in this case—maintain
a huge list of game servers. You can get
the IP address and port from the site and
use the game’s multiplayer option to
connect to it. You can also visit Game-
Servers (http://gameservers.net/overview_
clans.php) to find a list of such servers.
However, none of these sites provide a
region-wise list of servers. 

Desi game servers
Multiplayer online gaming is still in its
nascent stage. There aren’t many game
servers in India, but hopefully this will
change soon. Frag-Shak (www.frag-
shak.com) is one server that is located in
Mumbai. Players from Mumbai can get
ping times as low as 10 ms here. Howev-
er, this service is not free—you need to
pay a small fee of Rs 70 a month. It sup-
ports games such as Quake III, Counter-
Strike, etc. You can download a client
that tells you the currently available
servers and their ping times.

For those living in North India, there
is a site called Kawabonka (www.kawabon-
ka .com) that has servers located in New

Delhi. Dedicated servers are available for
many First Person Shooter games such as
Unreal Tournament, Quake III Arena,
Counter-Strike, etc. Non-dedicated servers
for many other games are also available.
The best news: these servers are free!

Play it slow
Not all games need high FPS rates,
or even have real-time capabilities.
Chess, for example, is a game that many
people love to take their time with, and
some can take upwards of an hour to cal-
culate a move. For such games, a slower
paced interaction is quite sufficient. This
is where Play By E-mail (PBeM, or just
PBM) comes in. You can play chess by e-
mailing your move to your opponent,
and he e-mails his counter move back to
you. Many other games can also be
played this way. Sites such as PBeM
(www.pbem.com) and PBM  (http://www.
pbm.com/~lindahl/ pbm_list/) are dedicated
to them.

When a new strategy game is started,
the situation, surroundings and options
are announced by the game master. To
join a game, you have to send an e-mail
to the game master, and describe the
character you want to play. After your
request is approved, you can e-mail what
you want your character to do in the
given situation. After all the players 
have made their moves, the game 
master e-mails each player the current
situation and all the players then make
their next move. These sort of games are
perfect for those who can’t afford to
spend more than a few minutes at a time
playing a game.

Summing up
The best thing about the Internet is 
that it has something for everyone: if
you’re an avid gamer, you can play
almost all of your favourite games with
players around the world; if you only
play occasionally, there are tonnes of
browser-based games for you out there;
you can also play games with your
friends using the IMVironments of
Yahoo! Messenger and MSN Messenger
6; and if you only have e-mail access,
you can still play PBeM games. So go on
out there, get rid of that boredom and
play TicTacToe with your friends on
MSN Messenger, or frag some dude in
Quake III. There’s just one rule… Have
fun! Happy gaming!

UPENDRA SINGHAI

upendra_singhai@thinkdigit.com

MARCH 2004

1 col AD

You have two choices for multiplayer
online gaming—browser-based games
and stand-alone games. Browser-based
games are those played within your
browser, e.g., the games you play at
Yahoo! Games. Make do with these if you
have a low-end system, or aren’t
interested in big games. What’s more,
you can minimise them in a fraction of a
second, and bring up your work
document if the boss passes your desk!
On the other hand, if stunning graphics
and great sound is what you’re looking
for, and you have a high-end machine to
boot, then play stand-alone games such
as Halo. Do keep in mind that browser-
based games are the only option if you
have a slow Internet connection.

What’s for Me?
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The desktop is at the centre of most
computing today. This is the exact
opposite of what proponents of

Ubiquitous Computing, or Ubicomp,
envisage—they believe that computers
should become invisible, blending into the
fabric of our daily lives. We should not need
to know what they’re like, or how they
work—no more than you need to know
about printing technology, how paper is
made and where ink comes from. The goal
of Ubicomp is silent computers every-
where, not thrusting their presence upon
us as today’s desktops and laptops do.

With computers all over the place,
communication is the imperative. It seems
obvious that each machine would require
us to learn something new in order to
communicate with it—pushing buttons
on a telephone, typing on a keyboard, etc.
But it’s not obvious at all that the machine
should dictate how we behave. Intuitive-

ly, it should be the other way round. We
should be able to communicate with our
machines the way we do with people. Ubi-
comp is a lofty proposition, but its ideals
drive development, albeit not overtly—
think PDAs, cell phones and Bluetooth. As
a first step towards Ubicomp, we expect
that our basic means of communication—
speech and writing—should be easily
interpreted by our machines.

Today’s best speech recognisers
approach 99 per cent accuracy, but they
often fail when facilitating our interac-
tion with computers. Why? Because the
interfaces aren’t transparent. Speech
recognition (SR) is most visible today in
dictation software. The setup involves a
headset, which restricts freedom of
movement. Next comes the training of
the software, and training oneself to
speak in such a way that the software
understands. Dictation is a skill, not a

natural mode of speech, and worse, small
errors can be frustrating; when an error
needs correction, you have to switch
from speaking to typing. Infusing the
software with AI capabilities is not the
answer. For a computer to routinely
understand natural commands such as
“no, not ‘t’, make that a ‘d’”, it needs to
understand natural language—a far hard-
er problem than voice recognition.

We can’t yet talk with our machines;
we can only instruct them to do specific
things. The problem is that we live and
talk in ‘conversational’ mode, within
which people understand us. A computer
requires us to get into ‘command’ mode.
Experts expect that this will soon change;
the state of the art of SR is much more
promising than it was just a decade ago.
Accuracies have improved, dictation
speeds have increased and costs have 
fallen dramatically.

Advances in
speech and
handwriting
recognition
promise to
move us
away from
the desktop
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What you say
Spoken sentences can be broken into three
basic levels: the phoneme level, the word
level and the sentence level. A typical SR
system analyses speech essentially by
identifying phonemes, and looking at
how they are strung together. Three steps
are required to extract a complete sen-
tence from a speech waveform: identify-
ing the phoneme, the word and the
sentence. Most SR systems model these as
Hidden Markov Models (HMMs) (See box
‘Hidden Markov Models’ on Page 100).
Alternatives to HMM systems include
hybrid systems that use both artificial neu-
ral networks (ANNs) and HMMs.

When an HMM is used, the system is
constantly making guesses as to what was
said. For an English SR system, all the
phonemes used in English would be mod-
elled as HMMs. This modelling is done
with extensive training from sound dic-
tionaries—for instance, from newspapers
and books, spoken by different people
with different accents, at different times.
After training, the system has a good idea
of what each phoneme sounds like. Hav-
ing heard the letter ‘F’ thousands of times,
spoken at different times by different
speakers in reference to different words,
the HMM that the system constructs for
that sound accounts for variations
amongst speakers, and is sufficiently dif-
ferent from the HMM for the sounds of
the letter ‘S’. Besides, if an SR system is
trained by the user, it modifies its
phoneme dictionary to reflect the user’s
speech peculiarities.

After recognising phonemes, the sys-
tem needs to put these together into
words. This again involves guessing: faced
with a sequence of sounds, the system

guesses what phonemes must have been
uttered to make the sequence. HMMs may
again be used in this step. Once the
sequence of phonemes has been guessed, it
must be constrained into a valid word, for
which purpose a dictionary is used. Some
systems use HMMs to model the gram-
maticality of sentences. Such a system
would interpret ‘he read a book’ correctly,
instead of as ‘he red a book’—because the
latter is not a valid sentence, even though
the two sound identical.

The written word
Intuitively, it seems that handwriting
recognition (HR) is harder than recognis-
ing speech. After all, most people pro-
nounce the letter ‘s’ pretty much the same
way, but most people don’t write ‘s’ the
same way, especially doctors! In fact, the
immense variation in the way people
write is one of the biggest problems in HR.
Writing a letter at a time, carefully, with all
the right strokes, is not an option we’d
like; we want to write in quick scribbles,
the way we normally do.

HR technology is driven, in large part,
by the emergence of portable devices, and
the focus of computing shifting away from
the desktop to cell phones, PDAs and tablet

PCs. HR can be notoriously bad on some
devices, if we write the way we want, with-
out following the rules; And if we do fol-
low the rules, we know how confining it
feels. The lists of rules is long—write on the
line, write in mixed upper and lower cases,
leave a good gap between words. And
when an error occurs, use the keyboard to
correct it—which, if it happens too often,
defeats the whole point of HR. Systems still
need to get to the point where they don’t
require you to write to their convenience.
But how exactly does HR work, and what
can we expect in the future?

Recognising handwriting
HR systems vary in the way they detect
words, and several methodologies are
being explored. In HR, unlike in SR, the
basic unit is the word, since there’s always
a space between words. Some systems
work upon the movements the writer
made in the process of writing; some work
upon the shape of the letters produced.
Within the latter category, some systems
try to guess a word as a whole, while oth-
ers try to break apart a word into letters.

Many systems, such as the Tablet PC,
use ANNs as part of their recognition
engines. ANNs have the advantage of
being trainable. To get a feel for how ANNs
can be taught simple characters, check out
the Java applet at http://members.aol.com/
Trane64/java/JRec.html. An executable pro-
gram demonstrating the same idea, devel-
oped at Carnegie-Mellon University
(CMU), USA, is available at http://www.
andrew.cmu.edu/~jgo/hwrecog.htm.

The input to the system—say a typi-
cal system that uses a neural net, and
breaks apart a word into letter segments—
is an image of the handwriting to be
recognised. This image needs to be pix-
elised and digitised before it can be used.

The first step the system would perform
is the pre-processing of the image-detecting
where the handwriting is within the image,
removing ‘noise’ such as stray marks, and
possibly the application of algorithms that

One of the most studied problems in HR is that of segmentation: finding the boundaries
between letters.

HR: The Segmentation Problem

Phoneme: A phoneme is a basic unit of
spoken sound: for example, the sound of
the ‘f’ in ‘father’, or the sound of the ‘ee’
in ‘sleep’.
Artificial Neural Network (ANN): A
layered network of computing units, each
of which can perform only a very simple
operation. The computational utility of
the network comes from the way the
units are connected.
Handwriting recognition: The technique
by which, for example, words written on
a PDA using a stylus, are analysed and
converted to text.
Dyslexia: A condition characterised by

difficulty in reading, spelling and so on.
This makes it a learning disability.
Sometimes, it is accompanied by difficulty
in writing as well.
Dysgraphia: A condition characterized by
severe difficulty in writing by hand.
Natural Language Processing (NLP): The
processing, by a machine, of everyday
speech and writing, resulting in the
machine getting at the meaning of what
was said or written.
Machine learning: The discipline dealing
with techniques that enable machines to
learn from past experience and data, and
possibly predict future data.

Jargon Buster

In contrast, when the word is
written this way,
segmentation is more difficult

In the text here,
segmentation is relatively
easy

Advanced algorithms make
use of heuristics to guess the
correct segmentation points



give a uniform size to the text, straighten
slanted lines in cursive writing, etc.

The most difficult part of the process is
segmentation, i.e., breaking up the image
into meaningful components, often single
letters. Letter boundaries are hinted at by
features such as changes in thickness, a
change in slant, a small gap, etc. Using
these, the segmentation process tries to iso-
late the letters in a word. The isolated letters
may later be analysed according to their
overall structure, or by individual features.

Segmentation is helped if the input is
online—that is, if writing and recognition
are being done simultaneously—because
the system then has additional parame-
ters to work on such as changes in pres-
sure, small time gaps and so on.

After the letters have been demarcated,
each letter or character is recognised by the
ANN. The features that the system looks at

are essentially the building blocks of written
text—vertical and horizontal strokes,
curves, circles, etc. Contextualization comes
in here: isolated characters are usually not
fed to the ANN—it’s usually small groups.
This improves accuracy. For example, when
writing the word ‘her’, say the ‘h’ looks
more like a ‘b’; the word will still be recog-
nised correctly as ‘her’, because ‘ber’ isn’t a
word. After recognition, dictionary-based
correction completes the process: if a word
that’s not a valid dictionary word turns up,
it’s replaced by the closest match. Several
HR systems can learn, and thus get person-
alised to one’s writing peculiarities. This
leads to better accuracy.

Where theory ends and problems
begin
The applications of speech recognition
extend far beyond dictation software. As

we move away from the desktop and
towards ‘computers everywhere’, we also
move towards ‘speech recognition every-
where’. However, there is no one-size-fits-
all SR application: the demands of
different areas are different.

Consider voice recognition in a car.
Hands-free mobile phone use is one thing,
but what about voice-controlled, auto-
mated steering and guidance? Here, accu-
racy is of paramount importance, and
there is very little space for ‘ums’ and ‘ers’.
The speaker must conform to speech-qual-
ity standards, and the software must be as
accurate as possible. Fortunately, in such
applications, the vocabulary the system
needs to have is limited, making the task
somewhat easier.

Background noise is a common prob-
lem with SR, and will remain so—even
when partially remedied by noise-can-
celling microphones. Consider the applica-
tion of SR in labs, or in classrooms, where
researchers take down notes while working
with equipment; or where a lecturer’s
speech is automatically transcribed and pre-
sented to students after the lecture. Elimi-
nation of background noise is essential to
good reproduction in these scenarios.

An interesting application is where
software trains students to speak a lan-
guage properly, with the correct accent
and nuances of pronunciation. This
poses a unique problem—a trade-off
between how much the software should

100

insight ■
■ technology

MARCH 2004

Typical stages in handwriting recognition using a neural net

The word to be
recognised may be
cursive

Pre-processing may
straighten letters

Segmentation finds
letter boundaries

Normalisation allows all letters
to be treated the same way

Feature extraction looks at
hand strokes, fills, etc.

ANN recognition looks at
the features and maps them

Dictionary search
eliminates bad candidates

HMMs are used to model what might be
happening in a system, when there are
both known and unknown parameters. In
speech, the known parameters are the
sounds that are heard, and the unknown
parameters are what the speaker actually
said. We need to try and guess the latter
from the former. A simple way of
understanding HMMs is via the urns and
balls model. Think of two urns, each

containing both red and blue balls. A
genie keeps jumping back and forth
between them. Each time he stops at an
urn, he picks out a ball, and calls out
what colour it is. We can hear him say
the colour, but we don’t know what urn
he’s calling out from. So, the urns are the
unknown parameters, and the colour of
the ball is the known parameter.

Say the probability of the genie
jumping, or transitioning, between urns A
and B, is as below:

This means that the probability of the

genie staying at urn A is 0.1, of going to B
from A is 0.2, and so on. Assume that the
initial probability of the genie being at A is
0.4, and of being at B is 0.6.

Now, suppose that the probabilities of
red and blue balls being in urns A and B
respectively is as follows:

Say we’ve heard the genie call out,
in succession, "red", "blue" and "red".
What sequences of moves by the genie
could have produced this utterance,
and with what probabilities? These can
be calculated.

The probability that the genie was at
urn A all three times, is 

0.4*.3 + .1*.7 + .1*.3 = 0.22.
This means that the sequence was ‘AAA’

with a 22 per cent probability. The
probability that he jumped from B to A and
then back to B, is:

0.6*.6 + .3*.7 + .2*.6 = 0.69.
This means that the sequence was ‘BAB’

with a probability of 69 per cent, and so on.
Thus, given a sequence we can estimate,
using an HMM, the underlying sequence
that produced it.

Hidden Markov Models

Probabilities of the genie jumping between,
or staying at, urns A and B

URN A B
Probability that a ball is red 0.3 0.6
Probability that a ball is blue 0.7 0.4
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compensate for the speaker. If it com-
pensates often, students may never dis-
cover that they pronounced a word
badly; if it compensates too little, there
would be too many errors.

The application of SR towards helping
people with disabilities such as dyslexia
or dysgraphia, is yet another challenge.
Those who cannot use a keyboard, or
notepad, can benefit tremendously from
SR technology. However, the software
would need to be tailored to individual
cases, because of variations of the condi-
tions amongst sufferers.

Among the many commercial appli-
cations of SR, is the automation of call
centres and the like, as well as voice sys-
tems that take orders over the phone. A
problem area here is the variability in tele-
phone microphones, along with, of
course, a caller’s telephone habits—such
as how far away from the mouth he or she
holds the mouthpiece. Such difficulties
are not insurmountable, but they go to
show that research that merely attempts
to improve accuracy is not enough.

What’s being done
Although SR has been around for quite a
while, it’s only recently that it’s taken off.
One reason is that processor and memo-
ry requirements are relatively high, and
it’s only now, when memories and proces-
sors are more powerful and affordable,
that powerful SR applications have been
made possible.

Research into good models of how we
construct our speech will continue. SR
technology may benefit from research in

other areas—Natural Language Process-
ing, and Machine Learning, for example.
The phonemic model of speech has been
very successful, but it is by no means the
only model. At CMU, alternatives such as
the modelling of speech based on sylla-
bles are being studied. Also being devel-
oped at CMU, are language models that
automatically detect, and adapt to,
changes in the form and the content of
what is being spoken—the speaker’s pro-
nunciation and vocabulary, and even
what he, or she, is talking about. 

Yet another problem being addressed
at CMU is that of the transcribing of 
pronunciations for thousands and thou-
sands of words: in the training phase of an
SR system, a linguist needs to read out vol-
umes of text, in a consistent tone, 
volume, etc. Methods of automatically
generating pronunciations for new words,
from training examples, are being devised.

What we should see
Speech and handwriting recognition
technologies can only get better each year.
The fact that Microsoft bundles dictation
and handwriting software with Office XP
2003, is an indication of how ubiquitous
they will become.

It is expected that pen input systems
will replace some, if not all, keyboards.
Devices such as the SmartQuill hold 
special promise.

Pen computing may have other impli-
cations as well. The Roman alphabet has a
special status in the world today. More
ubiquitous speech and handwriting recog-
nition could change that. As things stand,
people who don’t use the Roman alphabet
are on the other side of the ‘keyboard

divide’: using computers entails acquiring
keyboard skills that don’t come intuitively.
Consider someone who speaks an Indian
language, he or she needs to press three
keys on a QWERTY keyboard to get a char-
acter, and think of what pen-based input
could do for him or her.

Also, it’s natural that translation serv-
ices, together with natural-input recogni-
tion systems, would bridge international
computing boundaries.

Peter Fleming, president of Aristotle
Systems, a speech-technology consulting
firm, has some realistic predictions for SR
in the years to come. He predicts, “Greater
‘programmed understanding’ of grammar
and syntax will improve accurate recog-
nition… Keyboards, mice and electronic
pens will become more closely integrated
with speech recognition… Microphone
positioning and usage will become more
natural; more use will be made of com-
mon sense in choosing the correct word
for a particular context.” However, he also
says, “Dictation speech recognition will
never become the universal and exclusive
data input method.”

As we inch towards transparent com-
puting—and eventually Ubicomp—one
small step at a time, two things are clear:
advances in speech and handwriting
recognition will drive much of the transi-
tion; and, as we learn to communicate
more directly with our machines, there
must be a compromise. Until NLP and
other AI problems are solved, we will con-
tinue to compensate for what the machine
lacks. And hope that, as time advances, this
needed compensation will diminish.

RAM MOHAN RAO

ram_mohan@thinkdigit.com
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Flight and combat: The British Eurofighter
Typhoon is the first combat aircraft to have
speech recognition as a standard part of
the input system. The pilot can issue voice
instructions, and have spoken questions
answered by the system. This way, the
pilot need not look down at buttons, dials,
LCD screens, etc., and is free to navigate in
a more natural manner.
Automated surgery: AESOP 2000 is a
surgical robot that takes commands that
tell it where to hold a particular
instrument. This is used in keyhole surgery,
which involves the surgeon looking
through a tiny opening in the skin, as
happens in endoscopy.
Translation: Automated translation has

been researched for long, and translation
systems for PDAs will soon hit the
market. The speaker speaks in his native
language into the PDA, which then
translates the text into the chosen
language, and speaks it aloud.
Household appliances: Sensory
Incorporated sells their VoiceDirect Speech
Recognition Kit for less than $50
(approximately Rs 2,300). The kit comes
with everything one needs to speech-
enable household appliances and devices
such as remotes and telephones. One
simply needs to wire up the devices
according to the setup procedure, and
train the system with commands, such as
‘power on’.

Areas Of Application

www.technologyreview.com/articles/
rnb_121903.asp: A system whereby a
speaker speaks into a PDA in one lan-
guage, and the PDA speaks out a transla-
tion in another
www.india-today.com/ctoday/19991201/
marvels.html: A description of how speech
recognition is incorporated in the
Eurofighter Typhoon
http://research.microsoft.com/news/
msrnews/smartquill.aspx: A page about the
SmartQuill, a device that captures hand-
writing strokes in its own memory
www.pencomputing.com: A perspective on
pen computing, current and future
www.ubiq.com/hypertext/weiser/
UbiHome.html: Mark Weiser’s page on
Ubiquitous Computing, with several
write-ups and papers
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Wouldn’t it be easy if you could
search the Web directly, with-
out waiting for the Web page

of a search engine to load? It is, given the
right tools. You can set the toolbar of the
search engine of your choice (Google,
Opera, Netscape, etc.) on your desktop,
and search from there. 

Download and install Google tool-
bar from http://toolbar.google.

com/. Double-click the Internet Explorer
icon on the desktop to load IE. Next,
right-click on any of the toolbars, you will
see additional options such as Links,
Addresses, Standard Buttons, etc. Click on
‘Google’ to load the toolbar. The toolbar
has a text field, and buttons—‘Search the
Web’, ‘Navigate the Google News site’, a
graphical button to block pop-ups, an
Autofill tool for Web forms, a blog
updater and a button that enables or dis-
ables the highlighting of search words on
the resultant page. 

To search, just enter the search
string into the text field of the

Google toolbar and hit [Enter]. You can
also specify Boolean text searches in the
same text field area.

The Google deskbar
The Google Deskbar (http://toolbar.
google.com/deskbar/) is an add-on to your
taskbar from where you can initiate any
search directly. It displays the search
results in a small window on the desktop

itself. The results window retracts after
short periods of time. To amend this,
right-click on the taskbar and select Tool-
bars > Google Deskbar. A small
text search field appears on the
right-hand corner of your Win-
dows Taskbar. You can also con-
figure it to open the search link
inside a separate browser win-
dow. Click on the arrow beside
the binoculars, and in the menu
that pops up, click on Options.

Here, under the
Mini-viewer tab, check the
‘Display search results within
mini-viewer’ box. Check the
‘When clicking on results,
open a browser’ box, to open
results in a separate browser
window. Enable the ‘Automatically
close the mini-viewer when you leave
it’ option to close the Deskbar search
pop-up when your mouse cursor leaves
the pop-up window area. Uncheck ‘Use
animated open and close’ for disabling
animation displays.

Other tools
Copernic Agent is another popular search
tool that integrates into search engines and
produces results available to them. 

Download and install Copernic
agent from http://www.copernic.

com/en/products/agent/download.html.

Start Copernic Agent, click on
the left-hand pane and select
Advanced. A small window
pops up for  you to enter your
search. Click on ‘Modify
search engine settings’ to open
a small window that lists all
the search engines it uses as
reference engines—AltaVista,
AOL, etc. Select all for more
results, or deselect those you
do not want to use. Click OK
to exit.

Copernic spreads a
wide array of search

engines at your disposal. The
results are listed relevance-wise, which is
indicated in percentages.

Click on the link displayed on the

right-hand bottom half of the pane to
browse through the results. This loads the
Web site in the default browser. 

Change the default browser by going
to Tools > Options > Browser. Here, you
can also specify a browser of your choice
by clicking on Alternate, and specifying
the path to that browser. Click on OK to
close the window. 

With so many search tools at your dis-
posal, it shouldn’t be difficult to find the
information you require! 

MOULY ARUN PRABHU

mouly_arunprabhu@thinkdigit.com

Searching by bar

Use the Google toolbar to search Google directly

Use Copernic to select the default search engines you
want to use to perform your searches

The Google Deskbar displays search results in its mini-viewer

Using search engines to look for information is passé. Tap the power of search tools 
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Planning, strategy and venom—your
boss’s favourite topics when a project
goes asunder. So, you sit down all

over again to plot and plan. You’d like to fly
off to Ibiza; instead, you fly helter-skelter
with strategies on your mind. “Do whatev-
er it takes to stimulate that pea-sized brain
of yours,” he growls. Then you remind
yourself of taking into account outcomes
that just might not be savoury. Oh damn,
your thought process is complication per-
sonified! Well, you need to sit back, organ-
ise and structure it out. 

Mind mapping is a technique that
organises your thoughts in a representa-
tive way using words, symbols and pic-
tures, and goes a step further by letting
you manage all the content associated
with these thoughts. It works on the prin-
ciple that the eyes and the brain focus on
the central image on the screen or a paper.
This central image is the main idea of the
thought process in mind mapping. From
this central image, arise branches, repre-
senting the main themes that relate to the
central idea. These have sub-branches that
go to many levels, making a tree-like struc-
ture. Thus, a mind map is a flexible, pleas-
ing, easy-to-understand and easy-to-
memorise document. 

Creating your first mind map
Though there are numerous tools to create
mind maps, we will focus on Mindjet’s
MindManager. The reason? It’s one of the
best. Install the latest version—Mind-
Manager X5—from our Mindware CD or
download it from www.mindjet.com. 

The interface is quite intuitive and sim-
ilar to that of Microsoft Office products.
Placed just below the Menu bar, the Tool-
bar has buttons for common functions
such as Save, Edit, etc. Move your mouse
pointer over the button and a balloon tip
displays its function, and its keyboard
shortcut. Below the toolbar lies the Action
Bar that has buttons such as Map View and
Outline View, to switch between different
map views. Use buttons such as Brain-
storm, Review and Presentation to switch
between different modes. 

Change fonts, colours, line types and
shapes in the map using the formatting
toolbar that’s, by default, placed at the bot-
tom. The export toolbar, also placed there,
allows for integration of MindManager
with Microsoft Office. To the right are icons
for the task pane that let you access Library,
Search, etc., while you work on a map.

To chart a basic map, fundamental ele-
ments needed are the Central Topic, Main
Topics, Sub-Topics, Floating Topics and
Callouts. The first three elements form the
tree-like structure of the map. Floating top-
ics are not attached to any branch, and call-
outs are used for comments. Create a blank
map (File > New > Blank Map), click ‘Central
Topic’, enter the title of your map and press
[Enter]. Press [Enter] once more to key in
the main topic, and hit [Enter] again.
Sounds confusing? Here are two rules to
dissipate those baffling mists—Rule 1: Press
[Enter] after typing any text; Rule 2: Select
any particular topic, and press [Enter].
Voila! You have a topic at the same level as
the one that was selected. To create a topic

at a lower level, you
need to press [Insert].

Click on empty
space, and type to cre-
ate a floating topic.
Mouse-clicks are a lit-
tle tricky in Mind-
Manager—click and
hold the left mouse
button down to
change the mouse
pointer to a hand that
you can use to drag

MapyourMind
Think your thoughts are adrift? Here’s how you chart ramblings to plan, organise and execute

The structure of a typical mind map looks something like this

Step 5: Project completed
Now your Mind Map is ready to be
used to track progress. When individual
tasks are completed, you can put an
icon to show so. When all the tasks are
completed, you will see checkmarks all
over the map.

Step 4: Further
planning
Now look at the
tree carefully, and
delete the
unwanted ideas,
finalise the tasks
and allot them
to people in
your team. On
each task, you
can enter
information such as
the date when the
task was alotted and
the person in charge of
it. You can update this
information at will.
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the map. A rectangle appears if you click
and drag immediately; left-click and
release it instantly, and you have a little
triangle. These are spaces where you type
your thoughts. Move this floating topic
anywhere by simply dragging it.

As for callouts, click the topic you
want to create them for, press [Ctrl] + [Shift]
+ [Enter], type in the text and press [Enter].

You can also insert these components
using the Insert menu, and the buttons
on the standard toolbar.

Reorganising your mind map
The biggest advantage of using software
to create mind maps is flexibility. You can
do just about anything in a mind map—
move topics and sub-topics, make a topic

Step 1: Identifying the
central idea
The central idea is the goal or the
problem, which occupies the centre in
a Mind Map. Here the idea is ‘To create
the company Web site’.

Building the
company
Web site

Step 2: Brainstorming
The next step is to gather ideas.
Just think and enter all of them in
boxes. Don’t bother about the
inter-relations at this stage. Since this
project involves more than one person,
all the ideas are just jotted down at
random.

Step 3: Organising
Now is the time to put these
ideas in sequence, and ponder
over them individually. For
example, the ideas related to
the design aspect of the Web
site go under one category, the
ideas related to the database
form another category, and so
on. Once you have segregated
the ideas into categories,
arrange these into a tree like
structure. The first draft of your
Mind Map is ready.
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a callout and a callout a topic. Moving the
focus between the components of a map is
also very easy. Use [Tab] to jump to the
next topic in the clockwise direction, and
[Shift] + [Tab] to move counter-clockwise.
You can also use the arrow keys to move in
the respective direction.  You can even
move the entire map. Click on the back-
ground, hold the left mouse button till the
pointer changes to a hand, and then drag.

To reorganise the map, click the topic
you want to move, and drag it to the new
location. A visual clue shows you the posi-
tion where this topic will be placed. If you
press and hold [Ctrl] while dragging and
dropping, a copy of that topic is created and
placed at the new location. Delete a topic
with all its sub-topics, by selecting it and
pressing [Del]. If you wish to do away with
just the topic, press [Ctrl] + [Del] instead.

Formatting
your mind
map
Make your
maps visually
distinct to
enhance their
appeal. Use the
inbuilt styles,
or create and
use your own
style. Go 
to Format > Style
> Assign from
Template Orga-
nizer…, choose
a style and click
OK. Individual-
ly formatted elements won’t be touched.
Format them using the Formatting toolbar

at the bottom of MindManager. Change
fonts, colours, add shapes, boundaries and
lines. Use the Library tab to insert an image
that links to a topic, or just floats freely. 

Fine-tuning maps
To make your maps easy to comprehend—
which is their intent—keep topics as short
as possible. Use notes to attach additional
information to a topic. Notes come in use-
ful when exporting maps to Web pages or
a Microsoft Word document. Select the
topic and press [Ctrl] + [T], or go to Insert >
Notes. This opens the Topic Notes window
for you to type your notes, which can con-
tain formatted text, links and images. Top-
ics with notes attached, display an icon
next to them in the map view. Move your
mouse over this icon to read the note. 

Another useful component is Task
Information, which helps to schedule, pri-

Mind maps are used for two things—
memory and creativity. Though
managers and students make the most
out of it, mind maps can be useful to
anyone. Here are some areas where you
can put these to use.
Self-analysis: Use it to analyse your
needs and future goals. Long-term
decisions such as career switches
are taken effectively using this tool.
Look at the direction the thoughts in
your map take you, and you have a
decision at hand!
Diary: Unlike a conventional planner, a
mind map diary can be used for time
management—write little notes
pertaining to the time at which you
need things done. It can also be used

to record events in a memorable
and interesting manner—map your
holiday trips, for example, and attach
your anecdotes to the ‘places’ where
they occurred.
Group study: It has been found that,
together with group study, the Mind
Map Organic Study Technique (MMOST)
increases the pace, understanding,
effectiveness and efficiency of learning.
Visit http://www.mindmapping.co.uk/
studying. htm and http://www.happychild.
org.uk/acc/ tpr/features/0109mmap.htm
for more information on MMOST.
Creative Writing: Arrange and re-
arrange your thoughts before you begin
to write using this tool. Students will find
this technique very useful to write essays,

just as this writer did for this story.
Exam preparations: Make notes while
studying, so that you can review them 
later. You can also map your answers 
to cover all points. 
Teaching: Plan lessons, presentations,
projects and examinations. 
Speeches or lectures: Mind maps can
also be used to structure your thoughts
before you give a speech. 
Meetings: Ideas generated by meetings
and brainstorming can be very well
arranged in a mind map. You can collect
ideas and arrange them into logical
groups, for an easy analysis. 
Business: Structure a complete company
with this tool. It is also a very powerful
marketing and planning tool.

Draw on Mind Maps

Insert images using the Library task pane to create visually appealing maps

Here is a list of software that you can use
to create mind maps:

Windows software
MindGenius Business (http://www.
mindgenius.com/website/home.aspx):
Plan those business moves as you move
up the ladder. Different versions of this
software let you chart your education,
and even daily chores. 
Visual Mind 5.01 (http://www.
visual-mind.com/wv2.htm?335351): This
software closely competes with Mind-
Manager in terms of simplicity. 

PDA Software
MindManager 2002 Mobile Edition
(http://www.mindjet.com/us/products/com
pare.php ):
Here’s a PDA version of the software:
Idea Pad for Palm
(http://www.palmgear.
com/index.cfm?fuseaction=software.show-
software&prodid=53084): Use it to create
a work pattern in the Palm of your hand!
Free Software

FreeMind: (http://freemind.sourceforge.
net/) Prioritise your goals and draw up
an action plan with FreeMind, written
in Java.

Sites to Visit
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oritise, assign and group tasks. Click the
Task Info tab to open the Task Info task
pane. Now select the topic, and fill in the
details such as Priority, Start Date, Due
Date, Completed (%), Duration, Resources
and Categories. Special icons appear in the
topics to denote task information. Use this
information to view parts of the map with
specific task information. This can be done
using the Map Markers tab.

Integration with Office
A feature that has made MindManager pop-
ular is its seamless integration with Word,
Project, Powerpoint and Outlook. Import a
Word or Project document by opening it in
MindManager using File > Open. Ensure that
you choose the appropriate file type. The
map thus created uses the formatting of the
Word document. It creates a hierarchy of
topics based on the headers in the Word
document. The remaining text is imported

as notes. MindManager cre-
ates two buttons in Out-
look—one to export selected
items, the other to export the
folder. In Word and Project,
it’s just the ‘Send to Mind-
Manager’ button. 

You can also use the
Export toolbar to export maps
to Office applications. Here,

the topics are arranged according to hierar-
chy in the map, and formatted using the
Word style sheet. PowerPoint creates slides
based on the map structure. If you want to
export only selected topics, you can do so
by going to File > Send To, and then choos-
ing the application to which to export. 

Integration with Outlook provides a
two-way communication that lets you
synchronise tasks. First, you need to either
import Outlook tasks into MindManager
by going to Actions > Import Outlook Tasks…
or export MindManager Maps to Outlook
tasks. Synchronise your tasks by clicking
the ‘Synchronize Outlook tasks…’ button
on the Export toolbar.

Mind maps are a great way to get your
thoughts to walk the line of order and
method. Have second thoughts? Float them
too into position. It’s as simple as that. 

UPENDRA SINGHAI

upendra_singhai@thinkdigit.com
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Mind Mapping flexibility lets you move any topic or sub-topic
by simply dragging and dropping
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Written in Borland Delphi, KeyNote helps
you organise textual information. This
notebook, or information manager, has an
extremely configurable tabbed interface, an
RTF editor and a hierarchical tree outline.

Available only for Windows, KeyNote is
useful in situations wherein you open
several text files, and later have trouble
organising and then searching for
information in them. With KeyNote, you
can have many notes within one file and
multi-level, nested pages within a single
note. It also encrypts your data. Some of its
features, such as virtual
nodes, per-file
configuration settings,
multiple backups or
WordWeb integration,
are generally not found
in this type of software.

Go to File > New File
to create a new
KeyNote file with a
single note. Add more
notes by going to Note

> New Note. In the ‘New Note’ dialog box,
choose ‘Multi-level tree’ in the Type drop-
down list, and click OK. Once you give a
filename, it’s saved automatically, so you
don’t have to bother about saving it
repeatedly. 

A tree-type note is similar to Windows
Explorer. Its interface comprises a tree panel
to the left, and the normal editor to the
right. Add more nodes to your file by right-
clicking the node and choosing ‘Add Node’.
Arrange the nodes by dragging and
dropping them within the tree.

KeyNotes

Forget the text files, start using KeyNote for well-arranged notes
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The flexibility, stability and the
power that Linux offers makes it a
unanimous OS choice for business

applications throughout the world. How-
ever, a long-established notion is that you
need specialised software to get a grip on
accounting, payroll and such taxing tasks
when using Linux systems. And perhaps
advertise for an ‘experienced system
administrator’ who, though glum, is quite
glib at keeping the system going. 

Meet Nola, a software that helps you
makes sense of all that moolah math with
minimum effort. The best part is that it’s
PHP Hypertext Preprocessor (PHP)-based,
so once you set it up on the server, all
client machines can access it, irrespective
of the OS they are running. Further, PHP
lets you customise it in minutes, with just
the basic knowledge of this famous server-
side scripting language.

What you need 
Nola is an open-source software that’s
written in PHP, and uses MySQL as its
database. Distributed under General Pub-
lic License (GNU) license, and developed
by Noguska Management Systems, it’s
approximately 5 MB in size. Download it
from http://nola.noguska.com/. 

It takes quite a while to install, cour-
tesy its many dependencies. Here’s a
detailed list of them: Apache 1.3.21,
OpenSSL 0.9.6b, Mod_SSL 2.8.4, Libjpeg
6b, Libpng 1.0.11, Tiff 3.5.6-beta, GD
Library 1.8.4, Mhash 0.8.9, LibMcrypt
2.4.15, Mcrypt 2.5.7, PDFLib 4.0.1, Zlib
1.1.3, PHP 4.0.6 and MySql 3.23.4.1.
That’s pretty exhaustive, but in normal
cases, you won’t have to worry about
anything except PHP, Apache and
MySQL—all of which you need to con-
figure before installing this suite. 

Let’s get started
Ensure that you have PHP, Apache and
MySQL installed on your Linux system.
If you did a complete install, these com-
ponents are already installed. Check this
in Red Hat Linux 9 by going to K menu >
System Settings > Add / Remove Applications
to start the Package Manager. Under the
Server, check Web Server and click
Details. Enable all the checkboxes, 
and click OK. Now, enable the SQL
Database Server and click Details. Click
OK after enabling all the checkboxes. To
finish, click Update. Enter the Red Hat 9
installation CDs when it asks to com-
plete the update. Don’t worry about the
other components, since they are
installed by default.

Nola comes as a tar ball named 
nola-1.1.2.tar.gz. Extract this file to
/var/www/html—the default root directo-

■ linux works

BusinessBusiness
Be it accounts, stock-taking, or the all-important payrolls, Nola can take ‘em all on
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ry for the Apache server. Verify this infor-
mation in the /etc/httpd/conf/httpd.conf file
that specifies this path as DocumentRoot
“/var/www/html”. To uncompress Nola, go
to K menu > System Tools > Terminal and type
‘tar zxvf nola-1.1.2.tar.gz/var/ www/html/’.

Next, change the ownership of this
folder so that Apache can access this
directory. When installed, Apache creates
a user, called apache, who is a member
of the group apache. Enter the ‘hown -R
apache:apache /var/www/html/nola/’ com-
mand to change the ownership to the
user apache.

After this, enter ‘service mysqld start’
and ‘service httpd start’ to start the Apache
and MySQL services. It’s now time to
configure MySQL by creating a database
that can be used by Nola. For this, Nola
has SQL scripts that you just need to exe-
cute. At the terminal, type ‘mysql -p <
/var/www/html/nola/documentation/scripts/
MySql/database.sql’ to create a database
named Noguska. Now, you need to 
fill up this database with basic data 
such as default user, etc, so that Nola
runs properly. Type ‘mysql -p  noguska
</var/www/html/nola/documentation/scripts/
MySql/filldata.sql’ to do so.

Now, update the MySQL login infor-
mation in the /var/www/html/nola/includes/
define.php file. Change the default values
of username and password to those speci-
fied for MySQL. If you have not changed
the default values while installing MySQL,
you don’t need to change anything in the
defines.php file. 

Add the following lines in the

/var/rc.local file to ensure
that the mysqld and httpd
services start every time you
boot up your Linux system:

service mysqld start
service httpd start
sleep 8
clear
The last two lines guar-

antee that the services start
in the background without
distracting you.

That’s it! Now, type
‘http:// localhost/nola’ in the
address bar of the Web
browser, and the login
prompt greets you. Log in
using the default admin
account with ‘password’ as
its password. You will see
the navigation bar on the
left, and the main pages in
the middle. At times, images

just don’t appear, leaving you with 
nothing to do. In this case, you may 
disable them and switch to text mode.
To do so, open the file /var/www/html/
nola/includes/defines.php and look for the
section named ‘* Menu section’. It
should have these lines:
//show menu items as images
define(‘MENU_SHOW_AS_IMAGE’, ‘1’);
//show explain items
define(‘EXPLAIN_SHOW_AS_IMAGE’, ‘1’);
//show icons on explain* sub-
menus
define(‘EXPLAIN_SHOW_PIC-
TURES’, ‘1’);

Change all the ‘1’s in
the above entries to ‘0’s.

Now, when you
refresh the Nola start page
in the browser, it displays
only text for navigation.
Thus, the page takes lesser
time to load, and the inter-
face is simpler than before. 

Setting up Nola
Before using Nola for
your business operations,
you need to set up certain
things. First, go to the
Admin section and edit
the company name (by
default, it is ‘My Compa-
ny - Edit Me’) by clicking
on Client Companies.
Click the ‘Edit Selected
Company’ button to
enter your company’s

information. If you create multiple com-
panies, these are listed at the top of the
navigation bar as a drop-down list.  

Next, change the default admin pass-
word by clicking Users and Rights. Create
a new user by clicking on ‘Add new user’.
If you enable the Supervisor checkbox, the
user gets administrative rights. Check the
other checkboxes to assign users the rights
to view, write and set up Nola modules
such as Accounts Payable, Accounts
Receivable, General Ledger, Payroll and
Inventory.

The Admin section also has options to
create document categories. Here, you can
specify the categories that users can
upload. This is helpful when a user wants
to upload a document such as a product’s
image that pertains to a particular trans-
action. Finally, this section also lets you
import a customer list from a Comma Sep-
arated Values (CSV) file. The file structure
should be as specified in the Help section
of this page. 

General ledger
Create financial accounts once you are
through with the Admin section. By
default, the basic account types such as
Capital, Expenses, Sales, etc, are inbuilt.
To create accounts of a different kind, go
to General Ledger > Setup Function for Gener-
al Ledger. However, Nola cautions you
that “this should only be done under the

Create uses with specific rights, under the Admin section of Nola

If you are using Red Hat Linux 9, then you can easily add the
components using the Package Management tool  
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direction of Noguska Support staff as
how these are entered affects all General
Ledger reports and postings.” To create
new accounts, go to General Ledger > Edit
Chart of Accounts, and click on ‘Add new
GL account’. 

Start with the journal entries once
the accounts are created. There’s a two-
step process to enter the credit and debit
values when making a new journal entry.
Remember to enter all the credit entries
as negative values and debit entries as
positive ones.  Save the entry into the
database by clicking on the ‘Voucher
<vouchernumber> Complete’ link where
‘<vouchernumber>’ is the one that you
assign while making the entry. 

In the General Ledger section, you
will also find such self-explanatory
links as Edit Journal Entries, Post Journal
Now, Reverse Journal Entries, Profit
and Loss Statement, Balance Sheet,
Budget Variance, Journal Reports, My Pie
Charts, Edit Chart of Accounts, Chart
of Account List, Add Update Budget
and Budget List.

Vendors
Next, create a list of ven-
dors by going to Vendors >
Vendor Maintenance. You
have options to create
new vendors, as well as
modify existing ones. A
useful link under the Ven-
dors section is Vendor List
/ Labels, where you can
create a CSV file of the
data that can be imported
into spreadsheet applica-
tions such as MS Excel.
You will also find options
that let you view a sum-
mary of all vendors and

create mailing labels in PDF format. 
Use the Purchase and Payables sections

to view and enter information related to
purchasing and payables respectively.

Placing orders
Access functions related to customers and
their orders from the Order Entry section.
Click the ‘Add/Update Customer’ link to
add new customers to the database. Enter a
new order using the ‘New Order Standard
Items’ link. Under the Order List menu
option, you will find links to view different
orders and a link to view your Performance
Statistics. Order Processing, present in the
Order List, lets you Check In and Check
Out orders, i.e., details about who took the
job and when was it taken, and when it was
returned. When that user starts working on
the order, you can start the order by going
to ‘Fill Order Start / Stop’. Here a red button
indicates that work is in progress. The 
button is marked ‘Stopped’ when clicked. 
A green button implies the reverse. You 
can also view the shipping status, and 
mark orders for shipping in this section.

Billing information
can be viewed and
entered by going to
the Billing section.

Inventory
Nola has a power-
ful and feature-rich
inventory manage-
ment for items that
you manufacture.
Go to Inventory >
Setup Functions for
Inventory and enter
basic information
such as plant loca-
tion, item cate-
gories etc. Also, key

in inventory units, pricing levels and few
such essential fields. After you have entered
all these details, go back to Inventory 
section. Here you can read and enter all 
the information about your inventory.

Nola also has a full-featured Payroll
section for Payroll management. Here,
you can enter employee database, calcu-
late salaries, deduct taxes and lots more. 

The last word
Thus, Nola lets you say a cheery hola! to
the nitty-gritty of your company’s
finances, payrolls and stocktaking, 
etc., which is just a bit surprising for a
Linux application. If you like the way it
goes about accounting money, then you
might like to try Nola Pro, its advanced
version.  Download the trial version from
www.nolapro.com, and have fun with those
moneyed calculations!

UPENDRA SINGHAI

upendra_singhai@thinkdigit.com

Work faster: Throughout the Nola
interface, you will notice three types of
icons, next to text boxes: the calendar
icon, the lens icon and the plus 
sign icon. 

Click on the calendar icon to open a
small window displaying a calendar.  

Use the lens icon to search for items,
vendors, etc. 

The plus icon lets you add items.
Click Date to insert the same into the
appropriate textbox.

PDF blues: Nola presents documents
such as Vendors’ Mailing List in the form
of PDF files. if you encounter errors
while creating PDF files, download and
install the latest version of PDFlib 4.0.1
from www.pdflib.com.

Path to path: The paths mentioned
here assume that you are running Red
Hat Linux 9.0. If you use some other
version, you need to specify the path
where Nola is installed, in the
DocumentRoot section of the httpd.conf
file. Normally, this is located in the
/etc/httpd/conf/ folder.

Help on demand: Most Nola interface
pages have a Help link just below the
Noguska logo. Click this link to view
related help topics in a pop-up window.

Quick Tips

You can create any financial account under the preset 
account types

You can print order forms with bar codes in just a few clicks
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Where’s my L2 gone?
I want to know what the L2 cache

memory is, and why it is marked as 0 MB
on my system. I have an Intel Celeron
1.7 GHz, 128 MB SDRAM, a 40 GB
Seagate hard disk, a Mercury KOB82845
G/GL NDSMx motherboard with the
Intel 845 GL chipset, onboard VGA 
and sound.

According to your October issue, a
Pentium 4 has 256 KB of L2 cache, but
my machine has 0 MB. I asked my com-
puter vendor, but he knows nothing

about it. My friend’s PC, a Pentium 3,
shows 256 KB of L2 cache. The perform-
ance of his computer is good. 

I used the ‘trial-and-error’ method
on the external cache option provided in
the BIOS, but there was no performance
difference. My friend’s PC has DDR RAM.
Is the L2 cache dependent on the type of
RAM? Please help.
Gaurav Malji

All CPUs have an inbuilt L2 cache, and
it isn’t dependent on the type of system

memory you have, or
anything like that.
The L2 cache, which
increases the CPU’s
performance, is
inbuilt in the proces-
sor.

A Celeron 1.7
GHz processor
should have 128 KB
of L2 cache. There
are two possibilities:
the first is that the
L2 cache in disabled
in the BIOS, in
which case you’ll
have to enable it.
The other possibility
is that the program
you’re using reports
the cache status
incorrectly. To verify
this, press the

[Pause] key when your system’s hard-
ware information is displayed. This
information appears as a table just after
you’ve switched on your PC, and just
before Windows starts. You’ll need to be
a little quick, or you’ll miss the screen.
Look at this table, and you’ll be able to
view the correct system information.

Unhandled Exception while
installing

I have a Pentium III 450 MHz com-
puter with Windows 98 SE. The problem
is that recently, I tried to install the demo
version of Clive Barker’s Undying. The
installer for the game comes with the
Install Shield Wizard—the newer one,
with the soft-blue icon. The installer
showed that it was reading the packages.
Then, a box popped up showing that
setup was preparing the Install shield wiz-
ard, along with the progress bar. Every-
thing was fine until this point. Then, a
message box popped up saying, “Unhan-
dled Exception”. The exact error message
said: “Error number: 0x80070725
Description: Incompatible version of the
RPC stub Setup will now terminate”.

Another interesting fact is that this
now happens for every installer that uses
Install Shield. I’ve installed the game 
before, and It ran fine then. Also, the disks
I installed from were clean, so the error is
not with the source.

I updated my drivers, and reinstalled
DirectX9. There was no change. The one

MIssing L2 caches, installer problems, Explorer crashes, Firmware upgrades,
DOOMed installers, etc. You’ve got a problem? We’ve got the solution

➜
This chart shows the different combinations of processor and cache
that are available
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thing I could not do, is use an older back-
up of the registry, as I’d just taken the
backup that very day. I tried it out
though, but it didn’t help.
Kaisar

This error is caused by an incompat-
ible version of a DLL that was installed
on the system, such as Oleaut32.dll,
Olepro32.dll, Asycfilt.dll, or
Stdole2.tlb. For example, version 3.50
of Oleaut32.dll is installed and used
only by Windows XP. So, you get this
error if it is installed on a machine run-
ning any other operating system.

There are three fixes you can try. Choose
the appropriate for your computer:

If you have Microsoft Office or an
Office 2000 component installed,
install the Office 2000 Service Release 1.
You can use this solution for any oper-
ating system.

If you do not have Office 2000 or an
Office 2000 component installed, down-
load and install the mcrepair.exe tool
from http://download.microsoft.com /down-
load/msninvestor/patch/1.0/win98/en-
us/mcrepair.exe. When it prompts you to
overwrite newer files, make sure you
click ‘Yes’ for each file. You can use this
solution for any operating system.

If you’re using Windows 98 or 95, the
error is due to a bad version of

oleaut32.dll. To correct this problem,
follow these directions to remove the
old file and reinstall it. First, download
the file appropriate to your operating
system to your desktop, but do not exe-
cute it. The download locations are:

For Windows 98: http://support.install-
shield.com/ kb/files/Q108188/dcom98.exe

For Windows 95: http://support.install-
shield.com/ kb/files/Q108188/dcom95.exe

Now go to Start > Shutdown > Restart in
MS-DOS mode. At the command prompt,
enter the following commands on sepa-
rate lines as shown: 

CD c:\windows\system 
rename oleaut32.dll oleaut32.old 
exit
Now Windows will restart. Ignore the

error message: “A required .DLL file,
C:\windows\system\oleaut32.dll, was
not found.” Double-click the file you
downloaded to your Desktop earlier.
Click Yes at the dialog that opens. The
dcom.exe file installs a new oleaut32.dll
file. After DCOM has been installed,
restart the system.

If this procedure results in your PC 
getting even worse, simply go back to
the MS-DOS prompt, and rename the
oleaut32.old file back to oleaut32.dll.

You’re mistaken, mister

You gave the Linux version of DOOM
in the previous CD, but I’m new to Linux,
and don’t know how to install it on 
Red Hat Linux 9.0.
Hira Nand Prasad

The version of DOOM supplied on
the CD in the February issue is neither
for Windows nor for Linux. It’s for a
Mobile, i.e., the Symbian Platform. It’s
a Java-based application; you need to
attach the mobile phone to the com-
puter, and transfer the application to
the mobile, in order to use it. But this
version is meant only for the Symbian
platform, so you’ll be able to use it only
if you have a mobile running the
Symbian OS.

I need a service centre
I stay near Charni Road, Mumbai.

Could you please recommend a good
service centre or technician who won’t
insist on me signing a yearly contract to
make home visits?

My system is three years old, and it’s
been showing the wrong time for the
past two months. I believe this problem
can be solved by replacing the CMOS
battery. But according to my vendor—my
system is assembled—this is a crystal
oscillator problem. Is that true? Can a
motherboard fault cause the wrong time
to show up in the system tray?

I’ve not signed a yearly contract with
my vendor, so he won’t send a technician
for inspection of the fault.
Ashar Bhavesh

Firstly, sorry: We can’t recommend
any company or individuals to you.
But regarding the CMOS battery, you
can boot your machine without the
CMOS battery. The only difference
would be that the machine will gener-
ate a CMOS checksum error, and you
would have to press [F1] each time 
you restart. Also, if CMOS battery is at
fault, it will not be able retain the
changes made to the time.

Replacing the battery is not difficult.
Open the cabinet, locate the old bat-
tery, remove it, and insert the new one. 
A CMOS battery costs around Rs 20. 
If the problem is not rectified after
replacing the battery, then it might be
due to the oscillator, in which case
you’ll have to take the motherboard to
a service centre.

Windows Explorer keeps crashing

User discipline
I have five PCs running

Windows 2000 Professional
connected over a LAN. I cre-
ated user accounts with group
membership as Guests so as to
prevent users from installing
software without my permis-
sion, though they should be
able to download software,
MP3s, video, etc. However,
users can still install software
at will. I run a cyber café, and
it’s really difficult to spy on
each and every person who
walks in.
Hari

If your file system is NTFS, then
the simplest way about it is to provide
write permission for the entire C: drive
to the administrator only. Right-click
the C: drive, select Security, and here
remove all groups with the exception
of the Administrators group. Check
the ‘Inherent to sub-folders’ checkbox,

and press OK to set the new permis-
sion. Now, the guest user won’t be able
to install any software. Next, create a
common folder wherein users can
download software. This folder should
have read and write permissions for
all, and can be on the C: drive or any
other partition. Alternatively, you can
get the users to download software
onto a floppy disk.

Illustrations: Mahesh Benkar
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My Windows Explorer keeps crashing
whenever I do a search, or use Explorer
for a long time. I’m running Windows XP
+ SP1. To zero in on the problem, I mon-
itored Task Manager to see the cause of
crash, and disabled all startup programs,
including antivirus software. I found a
program, Dr. Watson, which starts imme-
diately and causes Explorer to  freeze, and
then it crashes, and closes all Explorer 
windows, including Windows Explorer. 
I’m really frustrated. I tried searching 
the Microsoft XP online database for 
a patch, but none was available. What’s
the solution?
Shankar

It’s not necessarily Dr. Watson that’s
causing the problem. When an
error is reported, Windows starts
Dr. Watson, which creates a log file.
This log file comprises the current
state of the machine. This file can then
be sent to the Microsoft technical
support for help. Alternatively, you
can configure Dr. Watson to create
a crash dump file, a binary file that
can be analysed with the help of
a debugger.

By default, the log file created by Dr.
Watson is named Drwtsn32.log, and is
saved in the C:\Documents and Settings\All
Users. WINNT\Application Data\Microsoft\Dr 
Watson\ folder.

Check the log file for the program
that’s causing the error. If it’s Windows

Explorer that’s causing the problem,the
fastest fix is to re-install Windows.

Help on the Internet
My first question is whether it’s possi-

ble to download attached e-mail files
directly from the server—Hotmail or
Sify—using FTP commands from within
Windows, using the e-mail ID and pass-
word, without using a browser?

Second, is it possible to use a 40 GB
hard disk on a 486 system? If yes, how?

Lastly, is there a Web site I can go to,
for suggestions on these matters?
Manoranjana Mohapatra

For your first question, if you mean
downloading attachments from e-mails
in your Hotmail or Sify mailbox, then
you can’t. You can download attach-
ments only after logging in via the
usual interface. You can, however,
download your Hotmail e-mails direct-
ly using  e-mail clients such as Outlook
Express or Outlook.

Now for your second query: Yes, you
can, with the help of utilities you can find
on the hard disk vendor’s Web site. For a
Seagate hard disk, go to www.seagate.
com/support/disc/drivers/, and for Samsung
drives, go to www.samsung.com/Products/
HardDiskDrive/utilities/index.htm.

To answer your last question: We
have a forum at http://www.thinkdigit.com
/forum/viewforum.php?f=2 to discuss such
issues. You are more than welcome to
join us.

Firm wary
I have three questions: What is a

firmware update, and what does it do?
Which of the following needs regular 
driver and firmware updates for optimal
functionality: Motherboard, chipset,
graphics card, sound card, hard disk,

Fan in another fan?
I have a 1.5 GHz

CPU with an Intel
845GBV mother-
board, a 40 GB hard
disk, an nVidia
GeForce4 MX 440
graphics card and
a Creative Sound
Blaster Live DE
5.1 sound card.
Can I use anoth-
er fan for the
graphics card
instead of its
own fan? If so, what kind of fan should I
use? Will it enhance my card’s perform-
ance?
Udayan

The fan that comes with the card is
more than enough! You need not
change or add any more fans to it.

However, you can increase the number
of fans in the cabinet, as it might
improve the cooling system, and there-
by increase the lifespan of the compo-
nent. Make sure you have a better fan
to keep things cool in case you wish to
overclock your graphics card for better
performance.

At http://www.thinkdigit.com/forum/viewforum.php?f=2 you will find the QNA section where
you can discuss your problems



processor, modem, monitor, or the TV
tuner card? 

Lastly, I intend buying a PC, primarily
to play games. Which OS should I opt 
for—Windows XP Professional or Windows
XP Home Edition?
Akhil Bahri

Firmware is software that’s embedded
in the hardware. It’s accessible through
specially written applications that can
write or read from the ROM chip, where
the firmware resides. For instance, the
BIOS on the motherboard is the
firmware. As and when manufacturers
discover bugs in the hardware, they put
up specific updates to overcome them.
Firmware updates can also help overcom-
ing hardware limitations. 

Assume that your current AMD board
supports a 166 FSB processor. Later, if AMD
releases a 200 FSB CPU, then the mother-
board manufacturer may release a firmware
update so that your board also supports it.

In the case of such cards as TV-tuners, the
manufacturer may release an update to sup-
port a new motherboard. Motherboards
often require firmware updates for sup-
porting newer features and hardware.

Finally, load Windows XP Home on
your PC if gaming is your main need. It
shores up to the needs of most games and
is easy on the pocket too.

Dreadfully blue
I have an Intel Pentium 4 1.7 GHz

with a VIA P4M266-8233 motherboard,
an S-Media GFX 5200 128 MB DDR
graphics card, a 40 GB hard disk with dual
operating systems—Windows 98 and
Windows XP—and 256 MB SDRAM. I get the
following blue-screen error message when
uninstalling Realtek AC ‘97 for VIA audio driv-
ers in Windows 98 to update them: “A fatal
error has occurred at 0028:ff066a7b in vxd
portcls(05) + 00003afb, the current applica-
tion will be terminated.” What do I do?
Neelonjon Goon

Looks like driver corruption is at
play here. Here’s what you do: Hold
down the Windows key and [Pause] to
access the Properties of My Computer.
Flip over to the Device Manager. Here,
right-click Sound, select Properties and
choose Update drivers. If this does 
not even allow you to overwrite the
newer drivers, then restart your PC, 
go to the BIOS, disable Sound and 
then uninstall the old drivers. Restart
again, enable sound in the BIOS and
then reinstall the drivers. 
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sos@jasubhai.com
E-mail us your
computing prob-
lems, and we may
answer them here!
Since we get more

mails per day than we can handle, it may
take some time for your query to be
answered. Rest assured, we are listening!

Read carefully
My CD-ROM drive is driving me nuts.

It reads every software CD as an audio
CD. How do I put some sense into it?
Yudhveer Singh

Such drives can be so irritating! The
problem lies with the CD-ROM lens
that is functioning erratically. Clean
the CD-ROM lens using a lens-cleaner
disc. Get it serviced at the nearest repair
centre if the problem  persists.

Boot out the choice
I have Windows XP Professional

loaded on my C: drive. Some time back,
I installed Windows 98SE on the D: drive.
This gave me a dual boot option. How-
ever, recently I formatted the D: drive
and created a new partition after remov-
ing all traces of Windows 98SE. In spite
of that, I still get a dual-boot screen 
asking me to choose between Windows
XP and Windows 98. How do I get rid 
of that?
Tehseen Ali

Open the boot.ini file using
Notepad, delete the following line:
C:\=“windows 98” and then save the
file. The option will not appear the
next time you boot your PC.

Restoring data
I am using Windows XP Professional

on a Pentium 4 system. Recently,
my display and sound drivers were
acting nasty. Hence, I reinstalled them,
but to no avail. I then restored the
system to an earlier time, and lost
valuable software that I installed
after the restoration point. There was
no point available for the restoration
when I tried to undo the changes.
I don’t have the CDs of the aforemen-
tioned software, so I can’t reinstall
them either. Is there any way to get back
that software?
Shailesh

Whenever you restore the system to
an earlier point, Windows XP creates a
restore point, and then proceeds with
the restore. To undo the change, go to
Accessibility > System Tools > System Restore
and select ‘Undo my last restoration’. If
the restore point is not present then you
might have disabled the system restore
functionality. If so, then, pal, you have
our condolences! You won’t be able to
go back to the said state. 

Try using recovery software such as R-
Fat, but it’s doubtful whether you will ever
retrieve the files since recovery is possible
only until the physical location where the
files are stored remains unused.

FAQs

As the name suggests, ‘Undo my last restoration’ helps you recover data that is lost due to a
prior restoration
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To be a
Writer...

Atul Deshmukh

contents
18 Web toolkits

20 Blogging

21 Accessibility

23 Resources 

For those smitten by the writing bug, but facing
the writer’s block, we’ll make a writer of you
yet…
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1st Page 2000
1st Page 2000 (www.evrsoft.
com) is a simple HTML editor
with loads of features to help
you create some dramatic
Web sites with little effort. 

Working around
The coding workspace com-
prises tabbed windows. By
default, the Edit window is
displayed, followed by the
Preview and Reference panes.
Click on the Reference pane
to access a copy of several
HTML guides, including the
W3C HTML Reference. 

Moding around
1st Page 2000 lets you access
various modes, depending on
your familiarity with the 
software. You are in the Easy
or Normal mode, by default,
when you start off for the 
first time. The page will 
show you large icons and 
simple controls, with all the
advanced features within the
respective menus. Once you

are familiar with the tools at
hand, you can go to Options
and switch to the Advanced
or Expert mode. 

Quick work
To access simple spell-check-
ing, press [F7] for all textual
content; use LiveSpell (Tools >
LiveSpell) to mark out incor-
rectly spelled text; use the the-
saurus by pressing [Shift] + [F7]. 

Tagging
Find all assorted tag shortcuts
for start, end, bold, italics, etc.,
under the Tag menu. Click to
insert them into the HTML
document. In the same menu,
are the common font faces,
font colours and font sizes. 

Cleaning up
TidyHTML, a nifty customis-
able tool that comes with 1st
Page, helps you clean and
tidy up your HTML code of
all its errors—go to Tools >
TidyHTML Format and Fix.
Warnings are generated for

any problems that TidyHTML
cannot solve. 

Quick and tidy
Use TidyHTML’s quick-fix fea-
tures (Tools > TidyHTML Quick
Tools) to apply source-format-
ting, upgrade to a style sheet,
or convert to XML or output
tags in uppercase. 

Insert
The Insert menu eases
the task of adding
material onto the page.
Whether it’s adding an
anchor to another Web
page or another service,
an e-mail link, images,
tables or Java applets,
etc, you can do it all.
For instance, should
you want to add in a
table to the page, click on

Insert > Tables…, and key in the
formatting as desired. 

Perls of wisdom
1st Page 2000 comes with
loads of features to jazz up
your Web pages. Go to Script-
ing > Full Featured Perl Scripts,
and choose from countdown
timers, credit card validators,

etc. Your server
should be running
a CGI service, in
case you wish to
use the script. 

JavaScript
magic
Go to Scripting >
Instantz Scripts to
access a list of
JavaScripts, such

as Audio Effects, Background
Effects, Buttons,
Calendars, Clocks,
Menus, Passwords
and so on; click on
any of them to get
further options.
Choose the kind
of effect you want
to display, and
click Insert.
Selecting Scripts >
Commonly Used
JavaScript Wizard

■ tips and tricks

Use TidyHTML's powerful features to clean
up your HTML code

WEB TOOLKITS

Illustrations: Farzana Cooper

Use the Insert menu's numerous options to
insert lots of little HTML code with ease

The Instanz JavaScript wizard has lots
of easy-to-use JavaScripts

Your own Web site is one of the best ways to
display your art. These site creation tools will
help you bring forth your creativity online…
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lets you access JavaScripts 
for several common 
applications such as drop-
down menus, document
fade effects, browser type
and so on.  

Rollover Images
One really cool effect you
can add to your page is the
rollover image effect. While
in the Easy mode, click on
the palette icon on the tool-
bar, and select Insert

Rollover Image. In the applet
that opens, specify the
anchor and the ALT text to
be inserted, and the image
name as well. Click OK when
you’re done.

FrontPage 2002
FrontPage 2002 is
Microsoft’s standard HTML-
editing and Web site cre-
ation tool that comes with
Office 2002. 

Creating your sites
FrontPage 2002 comes with a
host of templates for all sorts
of Web sites. Setting up a sim-
ple personal Web site is just a
matter of minutes. Start
FrontPage, go to File > New
Page or Web, and select Per-
sonal Web from the right-
hand pane. Select Personal
Web again and click OK.
Thus, FrontPage creates a
directory structure, as well as
all the pages that you imme-

diately need for
your Web site. 

You can
edit the page
content direct-
ly in the Nor-
mal pane. The
HTML pane
shows you all

the HTML content for
that page, while Preview
gives you a preview of the
page in Internet Explorer.
Finally, publish the page
by going to File > Publish
Web wizard. You may
upload the pages directly
to your Web site using the
File Transfer Protocol
(FTP). Note that you need a
Web server with the
Microsoft FrontPage 2000
Server Extensions turned

on, or else the pages will not
display accurately. 

Creating database-
driven sites
FrontPage 2002 lets you build
nifty database-driven Web
sites that work with your
business even if you don’t
know how to work with data-
bases, HTML, or ASP. Here’s
how you can, for example,
capture e-mail addresses and

phone numbers in a data-
base. Go to File > New Page or
Web. In the right-hand pane,
select Database Interface Wiz-
ard and click OK. Choose
‘Create a new Access database
within your web’. Click Next,
and set a name for
the database con-
nection. Specify
the names and
types (whether
string, numbers,
etc.), of the data-
base fields in the
next screen. Click
on Next, and the
database is created.
In the next screen,
specify the pages
you want created; by default
a submission page and a
results page are already
selected. Finally, click Next
and then Finish. Upload the 
database and the pages to a
Web server that supports
Active Server Pages (ASP),
ActiveX Data Objects,
Microsoft FrontPage 2000
Server Extensions or Share-
Point team Services. 

Creating all sorts
FrontPage also lets you create
Web sites that provide a cor-
porate façade, or Web-based

customer support.
Go to File > New
Page or Web, and
choose Web site
Templates from
the right-hand
pane. This opens
up the Templates
applet for you to
make a choice.

Views
You can employ

FrontPage to inspect your
Web pages too. Use the
Views panel on the left-
hand side of FrontPage to
see various parameters on
your Web site. For instance,
clicking on Page lets you see

the entire page in the work-
space; Folders shows the
folder structure; Reports
builds up a site summary
that details various Web site
parameters such as pictures,
unlinked and linked pages,
broken hyperlinks, etc. Nav-
igation shows you see a tree-
like layout of the entire Web
site, where you can add,
delete or link in more pages.
Hyperlinks shows you
hyperlinks or anchors for
each page in the folder list.
Finally, Tasks shows you any
listed tasks for the Web site.

JavaScript for rollover images is now
very easily inserted into your code

FrontPage 2002's menu-based interface sets
up database and front-end HTML in a jiffy

The Views menu lets you inspect and change
your whole site schema
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Live Journal 
Live Journal (www.livejournal.
com) is an excellent Web site
to start your blogging

odyssey. It lets you set up a
simple blog with images. Reg-

istration is very
straightforward.
After logging in,

go to Journal
and choose
Update… This
opens the
Update page,

where you can key in your
thoughts, adventures, experi-
ences, etc., into the text field.
Additional options let you
put in access levels to make
posts public, private or acces-

sible only to friends. You 
can also disallow comments.
You can define pictures you
want to use, as well as click
the Pictures link to add new
pictures. Finally, click on
Update Journal to load the
entry onto the blog. 

Customisation
Live Journal allows
for limited cus-
tomisation within
the page. Click
Manage > Customize.
Here, the settings
let you choose
between S1, the old
system and S2, the
new system. 

S1
S1 lets you customise your
blog page layout using the
Page Layout Style that has a
number of listed styles. Lay-
out customisation is possible
with recent events and views.
Also, set colour theme
options here. A cool feature is
Style Override that
lets you tweak spe-
cific things about
your page layout.
These are valid at
the beginning of a
document, and are
limited to <title>,
<base>, <style>,
<link>, and
<meta>. Finally,

change the look
and feel of your
Mood icons and
save the changes. 

S2
The layout cus-
tomisation in the
S2 system lets you

change language and themes.
Choose to blog in English, six
other languages, or opt for a
customised language. Finally,
click Customize, under Indi-
vidual settings, to set colour,
font, presentation and text
options. Even more detailed

presentation styles are possi-
ble with their style system
language, also known as S2. 

Adding friends
You can add friends who will
be able to access specific sec-
tions of your blog that are

Add in tasks from Edit > Tasks
>  Add Tasks… Use the Tasks
view to track these. 

Page options
Fine-tune compatibility
options for your HTML proj-
ects so that they are accessed,
either by several browsers, or a
specific one. You can even

host them on Apache or
Microsoft IIS Web servers. Go
to Tools > Page Options. Flip
over to the Compatibility tab,
and select the browsers that
you want to provide access to.
Likewise, choose the appro-
priate version of the browser
you’re targetting. Servers lets
you choose between Apache

and IIS. For example,
select Microsoft IIS for
pages that are dynam-
ically generated with
ASP. Be sure to check
the ‘Microsoft Front-
Page Server Exten-
sions’ checkbox for
projects that need it.
You can also select the
appropriate settings
from the remaining,
such as ActiveX 
controls, VBScript,
JavaScript, ASP, the
CSS version, etc. 

BLOGGING
Blogging is a neat way to get your work online,

as well as a channel to communicate with
other people of similar interests. Let’s look at

two popular Weblogs—Live Journal and Blogger 

Set the custom page options from the
Page Options applet

Live Journal lets you interact with a vast
community of bloggers

S2 lets you customise your blog’s layout, and
even has a style system language called S2

The Friends tool lets you read your friend’s
posts, and lets them read all yours
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not available to
the general public.
You can also view
their posts on 
the Friends page.
Friends have to be
Live Journal users.
Go to Manage >
Friends to edit, add
and filter friends.
Finally, click on
Save Changes and
access the updated
Friends page there.

Blogger 
Blogger (www.blog-
ger.com) is another
popular blog spot. It has now
tied up with Google. Posting
is simple—all you need to do
is click on your blog name.
Blogger immediately puts
you at the posting page,
where you can add new
posts by clicking on Create
New Post. Once done, click
on Publish Your Post. 

Getting personal
If you have Web space, you
can create your blog page,
using Blogger’s editing and
publishing tools. You need to
supply the FTP authentica-
tion details (username and
password), and create the
appropriate directory on

your Web server. Choose to
‘FTP it to your own server’
while setting up your blog,
and provide the necessary
details. Now you can add in
all posts at Blogger.com, and
view them on your Web site!

Settings, and more
Clicking on Settings lets you
access a lot of things about
the way your blog works.
Under Basic, you can
change titles and the
description of your blog.
Publishing lets you set all
your publishing details; For-
matting sets time, date, lan-
guage, etc.; Site Feed lets
you link RSS feeds to your

blog; E-mail lets you specify
other e-mail addresses to
route comments to, and
Members lets you add in
team members who can also
blog on the same page—
the best way to set up a
community blog.

ConTemplating
You can change templates,
from Templates > Blog
Template and tweak the
HTML code a bit. Choose
New Template lets you
select from a list of existing
templates.

Blogger is one of the most popular blog spots

Set the FTP details to blog directly to your
personal Web space

ACCESSIBILITY

So said Tim Berners-Lee,
W3C Director and inventor

of the World Wide Web, and
this aspect can be put into
practice with a little effort.
Once you have put together
your Web site, use these tips to
ensure that your pages are
accessible to all. 

Images
For those who do not use
graphical browsers, or cannot
access graphics in a browser, a
simple accessibility tip is to use
the ALT attribute and describe
the image. 

Detailed description 
With HTML 4.0, you can now

choose to put in full-picture
descriptions along with the
ALT text.  Use the LONGDESC
attribute to add this descrip-
tion. It can also take the form
of a separate page referenced
by a d (descriptive) link.

Quick images
Use the width and height
attributes for every IMG tag to
specify the dimension of an
image. This speeds up image
loading, and the text around
the images starts to fill in rap-
idly. Here’s their syntax: 

<IMG SRC=“coolcar.gif”
height=“200” width=“200”
ALT=“My concept car”  LONGDE-
SC=“car_detail.html” ALIGN=left>

“The power of the Web is in its universality.
Access by everyone regardless of disability 

is an essential aspect.”
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Flashing Java 
For all your efforts to make a
classy Web site with
Flash effects, it’s possible that
someone may be
accessing  it with a browser
sans a Flash player. Hence,
keep an alternative link that
lets people bypass such
effects. It is unreasonable to
expect people to download
an extra plug-in just to view
the information on your Web
site, especially when they can
find the same
elsewhere. 

Keep the
same in mind
while opting
for Flash
menus. While
the eye-candy
is pleasing,
with slow
I n t e r n e t
access, people
would prefer
to have a no-

fuss access to information.
The same argument goes for
using Java applets on your
Web site. It’s possible that
Net-surfers may not have the
Java Runtime Environment
(JRE) installed. Downloading
it from the Internet takes
quite a while. Hence, keep a
non-Java version too, and dis-
play a visible link to it.

Frames
Frames may make your Web

pages look organised and
neat, but they can be quite a
hassle for those using a
browser that does not sup-
port them. Hence, keep a link
to a version of your Web site
sans frames. This ensures
access to all, regardless of
frame compatibility.  

Here’s what you can do.
After ‘</FRAMESET>’, write
‘<NOFRAMES></NOFRAMES>’,
and include the HTML code
that you would want to dis-
play in a frame-disabled
browser within these two tags.

Testing
Testing each page on all 
the possible browsers makes
a lot of sense, as if your pages
are not in
strict con-
f o r m a n c e
of the W3C
standards,
then your
c o m p l e x
p a g e s
appear dif-
ferently in
d i f f e r e n t
b r o w s e r s .
Ensure that
your HTML toolkit has sev-
eral popular browsers, name-
ly, Opera, Netscape and
Mozilla. Also, consider test-
ing the page with the Lynx
text browser. 

Checking and validating
It doesn’t take too much
effort to have your Web
pages tested and validated.
With little effort, you can use
freely available services and
tools over the Internet that
will validate your Web pages
and Web sites. 

W3C’s check 
The W3C Web site
(www.w3c.org) offers you free
HTML and Cascading Style
Sheets (CSS) validation serv-
ices. Access the free HTML
validation service at http://val-
idator.w3.org/. It checks and
ensures that your HTML code
follows the W3C’s Web Con-
tent Accessibility Guidelines
(WCAG). Either submit the
URL, or upload an HTML file
for inspection. Access the
tweakable features for this
service by clicking on
‘Extended Interface’ or
‘Extended File Upload Inter-
face’ on the home page. Alter-
natively, gain access to them
at http://validator.w3.org/

detailed.html for a submitted
URL, or http://validator.w3.
org/file-upload.html for an
uploaded file. W3C’s service
depends on Document Type
Definition (DTD) to validate
the code. Lack of a proper
DTD would lead to non-vali-
dation of the page. 

Validating the page CSS 
Visit the W3C CSS validation
service (http://jigsaw.w3.org/ css-
validator/), and choose to
either validate by giving the
URL of the CSS, or uploading

Here’s a site with reasonable frames, which allow
for easy navigation through the site

W3C’s site offers a free validation check. Just enter
the URL to get the page validated

Standards of Access
The various accessibility standards ensure that the Internet and
the World Wide Web is accessible to all, irrespective of the surfer’s
mode of access or disabilities. There are two well-known stan-
dards and guidelines of accessibility. The first is the World Wide
Web Consortium (W3C) standard called the Web Content Acces-
sibility Guidelines (WCAG), under their Web Accessibility Initiative
(http://www.w3.org/WAI/). These guidelines have three levels of
specification that provide various priority levels. The other is the
US Government’s Section 508 guidelines (www.section508.gov),
which look at a relatively lesser level of accessibility guidelines,

concentrating mostly on basic accessibility,
whilst leaving out many other pressing issues.
Both services offer free accessibility testing
services and tools. 

Bobby is a free service that tests Web sites
for ease of use, adherence to standards and
accessibility by people with disabilities. Display
their endearing mascot on your Web site once
it’s Bobby-tested successfully. 

Get this mascot
to grace your
Web site once
you pass the
Bobby test
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Domain-ing it
With domain names 
available for as low as US$
9.95 (approx. Rs 448), it’s
easy to get yourself one 
from Web sites such as 
Network Solutions (www.net-
worksolutions .com). In fact,
you can also visit Web sites
such as GoDaddy (www.
godaddy. com) that has spe-
cial economical offers for
domain-name buyers. Once
you register your domain,
you can use free DNS servic-
es such as ZoneEdit (www.
zoneedit.com) that lets you
specify several sub-domains.
Finally, you need space on a
Web server. While most free
services give you decent
space, your Web site would
be listed under their
domain, and you will have
to suffer their ad banners on
your Web pages. Host your

Web site using space bought
from an ISP to use your
domain name. 

GeoCities
With GeoCities (www.
geocities.com) now a part of
Yahoo!, signing up for an
account is as simple as using
the one existing with Yahoo!.
GeoCities gives you 15 MB of
space. Set up your Web site
using their free Web site cre-
ation tools such as the Yahoo!
PageWizards and the Yahoo!
PageBuilder.

The PageWizard is a sim-
ple five-minute page set-up
wizard that lets you select a
page from the available page
themes, and then customise
the text, images and links and
personal information. The
PageBuilder wizard is a little
more detailed in its cus-
tomization. You will need JRE

it. You can also enter
the code of the CSS
within the text scan
area. There is also a
stand-alone tool
available at the Web
site for the same pur-
pose.

Bobby
Bobby (http://bobby.
watchfire.com/bobby/
html/en/index.jsp) is a
free service that vali-
dates and tests your
Web site, and ensures
compliance with accessibility
guidelines. Bobby checks for
W3C’s WCAG guidelines, as

well as the U.S. government’s
Section 508 guidelines. Enter
the URL of the page, and
choose to test it for Section
508 compliance, or for the
WCAG compliance. Use the
Customisation page (http://
bobby.watchfire.com/bobby/html/
en/advanced.jsp) to tweak
Bobby for better results.

Section 508 
The US Government’s Sec-
tion 508 guidelines require
all data in electronic format
to be accessible to people
with disabilities. At their

Web site, (www.section508.
gov), find  a free tool called
STEP508 (Simple Tool for

Error Prioritisation) that
looks at the severity of acces-
sibility errors as well as the
effort to fix them.

Customizing Bobby
In the advanced features,
select checkboxes for full 
text output, complete HTML
source for the lines, as well 
as the Analyze HTTP error
pages option. Finally, for
pages that respond differently
to different browsers, Bobby
impersonates a Netscape, IE,
Opera, or Lynx browser, as
well as AOL and WebTV.

RESOURCES

Use STEP to make more accessible
Web pages

Bobby offers check services for both, the W3C guidelines, as well as
the Section508 guidelines

If you are ready to host your Web site and
publish your work online, check out the

following tips on free and paid hosting, and
make it look absolutely professional
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installed to access it though.
Also, the PageBuilder takes a
while to open if you are 
using a dial-up connection.
For more customised pages,
you can create your
own page, then
upload the pages
and the associated
files into your
GeoCities account.
Upload files that
size up to 5 MB by
clicking on Easy
Upload in the
Advanced Toolbox
section of your
GeoCities account. 

Getting free space
Several Web sites offer 
free space to host your Web
site. Most of them have a
decent amount of space.
They also come with basic
Web site building tools 
and wizards to guide you
through such services. 

FreeServers
FreeServers (www.freeservers.

com) is yet another
place where you
can access Web
space for free. The
basic account pro-
vides you 12 MB
space, with an
upper file-size
limit of 256 KB.
FreeServers also
gives out free
W e b - h o s t i n g
space for any of
your domain
names. For that
though, the page
will have its ad
banners. 

Brinkster
The basic free account at
Brinkster (www.brinkster.com)
entitles you to a maximum
of 30 MB space. Brinkster

lets you run ASP pages that
interface with an online
database; the FrontPage
Server Extensions though
are available only for the
paid account. The file size
restriction here is 1 MB
(larger for databases). Use
their browser-based file
manager to upload files; FTP
is restricted to the paid
account. 

150m
Huge is definitely what you
call 150m.com’s (www.150m.
com) offer of 100 MB free
space—restricted to a maxi-
mum of 1 MB for individual
file sizes. 150m allows for FTP
access to your space on their
site. It also lets you redirect
your domain names to the
pages that you have put up
here. Finally, 150m.com itself
has a simple Web site creation
tool and additional tweaks for
your pages.

Space, more space
For those of you who would
like still more space, check out
O-F.com (www. o-f.com). The
free basic free account gives
you 100 MB of space, 150m.
com style. You are limited to a
daily bandwidth of 40 MB.
The user manager interface is
very similar to that of 150m.
com, so if you
have been look-
ing for lots of
space, try this
free web space
service as well.
Apart from a site
builder tool,
there’s a plus
point for using
this service—
their free FTP
services, just like
150m. com. This
way, when it
comes to
uploads, you are
not restricted to
some browser
based file manag-
er. Again, for all
the extras such as FrontPage
Extensions, you would need
to be a paid account user. 

Templates
Web sites 
Web site templates are a
great way to start working
with, since they come 
complete with images and
interlinked pages. Start 
with MyFreeTemplates
(www.myfreetemplates.com)
that hosts a variety of tem-
plates for personal as well as
business Web sites. 

Newsletters
Now that you have your
Web site up and running, 
it makes sense to let 
the whole world know, 
and what better way than 
a newsletter? Get free
newsletter templates at
MyFreeTemplates (www.
myfreetemplates.com), and
start working on despatch-
ing them. Of course, e-mail 
etiquette demands that you

give people the option of
receiving them, and not 
spam mercilessly.

MyFreeTemplates gives you an easy way of
making classy looking sites

Brinkster is free, has a clean interface, but
limited features

Set up your GeoCities site in a jiffy, and
experiment with the available styles



128 MARCH 2004

arcade ■
■ reviews

Flashback to Gothic: You find yourself
thrown into a penal colony,
sequestered from the rest of civilisa-

tion by a magical barrier—you can get into
the colony, but you can’t get out. After sev-
eral joyous hours of playing the game, you
discover that the secret to getting the bar-
rier down lies with a creature called The
Sleeper. By the end of Gothic, you have
slain The Sleeper, and in the process, got-
ten yourself trapped in the rubble of its
temple. The Sleeper, before being van-
quished, called out to like-minded crea-
tures to rally against the good folks of the
land. The fall of the barrier actually boost-
ed the Orcs, allowing them to spread all
over the mining prison colony, cutting off
the supply of precious ore. To make mat-
ters worse, the farmers are revolting
against the king, and refuse to sell their
harvest at a low price .

Despair echoes everywhere. The
world’s in quick need of a miracle, and this
is your cue. The solution seems to lie in an
ancient and sacred artefact called the Eye
of Innos. Innos is the God of light and fire,
and a brother to Beliar, the bad guy. 

Since your former home is besieged by
Orcs and Dragons, you’ll find refuge in the
harbour city of Khorinis. Three main
guilds are sprinkled around within the

city—the Militia, Mercenaries,
and the Monastery. The Militia
are in service to the king, and are
in the city on a secret mission.
The Mercenaries guild was
formed by the former convicts of
the new camp at the Penal
Colony—they’re out and out
fighters. In the Monastery,
you’re taught about Innos and
the Magic Circle of Fire by the
Fire Mages—the priests of Innos.
But you’ll need to join one of
these guilds and progress in their
ranks first. To join a guild, you
need to become a citizen of
Khorinis, and this is done by working with
any of the masters as an apprentice: There
is a hunter, an alchemist and a weapon-
smith from which to choose.

The land of Khorinis is home to some
very interesting characters—the pompous
Fire Mages, the do-good Paladins and the
cutthroat band of Mercenaries. Any of them
will help you get to your goal, but only for
their vested interests. The land is huge and
filled with lush forests, deep valleys com-
plete with waterfalls, and a ship-wrecked
treasure island. Access to various areas has
been restricted in an obtuse manner. Some
areas are guarded by monsters that you

can’t challenge until you gain enough
experience—or, you find a way around
them, or a trick to defeat them.

The game looks a lot better than
its predecessor. The forests are covered

with lush bushes, and rays of sunshine
peek through the dense canopy of trees.
Take a swim in the ocean, and you’ll be
greeted by lashing waves that froth at
the shore. For the kind of hardware
requirements the game demands, it
looks very good.

The controls might be a bit frustrat-
ing at first. Although this sequel has bet-

ter mouse support, it is designed only for
keyboard play. With time, the controls
become second nature, and you’ll come to
appreciate the simplicity of it all. Combat
is divided into two-handed and single-
handed. You have to time both—your
attack, and block—in order to win battles. 

The most obvious flaw is the transla-
tion from German to English. While not
completely bug-free, most bugs only look
bad and don’t interfere with the gameplay.
One irritating flaw is if you press the wrong
key at the wrong time during a conversa-
tion, the game gets stuck in a particular
camera angle—until you restart. 

If you really want to enjoy the game,
play it at an easy pace. It can be rushed
through, but you’ll miss a lot. Take it slow;
enjoy the beautifully created world and
the characters that call it home. All the dia-
logues in the game are spoken, so there’s
little chance of you ever getting bored
reading page after page of text. There are
some good moments in the game, some
funny, some emotional, some nostalgic. If
you’re a RPG fan and are dying to play 
a good game, this is it. Good RPGs are 
few and far in between, so don’t miss 
this opportunity.

Gothic II
RPG at its best

Genre: RPG ■■  Developer: Piranha Bytes ■■     Publisher: Atari ■■     System Requirements: 700 MHz CPU, 256 MB RAM, 32 MB video card, 
2.2 GB hard disk space ■■     Price: US$ 39.90 ■■  Web site: www.gothic2.com
Rating: ★★★★ ✩✩

Not a very intellectual conversation..

✩✩

Uh-oh. Better get out of here while I still 
have my legs
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Vietcong
Tour of duty

Vietcong is the story of a pla-
toon stationed right near
enemy lines while the war

between North and South Vietnam
was in full swing. If you’re a fan of
classic rock, buy this game just for
the sound track—the game kicks off
with you in a chopper and Hey Joe
by Jimi Hendrix in the background.
The game has good graphics, excel-
lent sound and very partial AI. The
enemy AI will outsmart you at
every turn, while your team can’t
seem to find its way around a rock.

Weapons are beautifully and
faithfully rendered. A nice touch is
the wound placement—if you
shoot someone in the arm, his arm,
and not his chest, gets bloodied. Voice
acting is impeccable and weapons are full
sounding—not tinny and off like in
some games. Ambient sounds, as you

wander through the jungle, are really
fantastic. Birds flapping, monkeys
screeching, numerous frogs in a swamp;
they’re all there. Another neat aspect of

the game is that natives speak
to you in authentic Viet-
namese. There are no English
subtitles. Your only hope is 
to find someone who speaks
both languages.

Vietcong is one of the most
carefully crafted and intricate
games on any platform. The
amount of history incorporat-
ed into this game, and the
amount of minute details draw
you into believing that you’re
actually a soldier in Vietnam.
There’s even a Quick Fight
mode, which you can play
through various multi-player
style levels against some good

AI. In the end there is a real sense of
accomplishment in beating Vietcong;
even on the easiest settings, this game
will still test your skills.

Genre: Action ■■  Developer: Pterodon ■■  Publisher: Gathering ■■  System requirements: 700 MHz CPU, 256 MB RAM, 1.8 GB hard disk space, 32 MB
video card, DirectX 8.1 ■■  Price: US$ 29.99 ■■     Web site: www.vietcong-game.com  
Rating: ★★★★ ✩✩

And we shall ride into battle on our steeds... - The new face of 
the US cavalry

Tony Hawk’s Pro Skater 4
Break all barriers

The major change in Tony Hawk’s
Pro Skater 4, as compared to ear-
lier versions, is the time con-

straint to the missions. In earlier ver-
sions, missions were available at the
onset of a level, and had to be com-
pleted in a given time. This time
around, you can freely skate the envi-
rons and have fun; until you trigger a
mission, and a timer starts ticking.
Missions are handed out by skaters or
bystanders. These can range from res-
cues and challenges, to races. Irre-
spective of whether you succeed or fail
a mission, the game continues and
you’re free to retry, hunt for other
challenges or just skate around without a
care in the world.

You can complete these missions,
which get difficult incrementally, to earn

cash and pro points. Cash can be used to
unlock several features in the game, and pro
points are used to unlock professional chal-
lenges. Vehicles can now be used to Grind,

Wallride and perform the familiar Car
Plant. What makes them really useful
is the ability to hitch a ride by hold-
ing onto the rear bumper—seen in
several skateboarding movies, and is
called ‘Skitchin’ in skater lingo. 

The game has certain enhance-
ments in the sound department too.
It includes a couple of great tracks-
Iron Maiden’s Number of the Beast
and AC/DC’s TNT. The soundtrack
now comes with a playlist, which
can be used to switch on or off cer-
tain tracks and also set the sequence
in which they’ll play. Iron Maiden’s
famous band mascot Eddie (Metal

Head) is featured as one of the secret
skaters! Those who’re going try this 
series for the first time, be prepared to 
be hooked! 

Genre: Simulation ■■  Developer: Neversoft Entertainment ■■  Publisher: Activision ■■  System requirements: 800 MHz CPU, 256 MB RAM, DirectX 8.1, 
32 MB GeForce2 or Radeon graphics card, 700 MB hard disk space ■■  Price: NA ■■     Web site: http://www.aspyr.com/games.php/pc/thps4  
Rating: ★★★★ ✩✩

A little help is always welcome

✩✩

✩✩
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The book starts with a rather bland
opening line: “Let’s talk I/O. No, no

come back. It’s not really all that dull.”
Come back, shouldn’t we? As a Java pro-
grammer, you cannot really be blamed for
putting I/O concerns on the backburner.
After all, JVMs make programmers fret on
extracting every ounce of CPU perform-
ance they could manage, thus relegating
I/O optimization to neglect. However,
with time, JVMs have evolved enough to
run bytecodes at speeds approaching
native code such as C/C++. This means
that the classic case of I/O being the major
performance bottleneck is now truer for
Java than ever. And here, Java’s I/O class-
es haven’t been of much help. 

This is where the New I/O (NIO)
framework of Java comes into picture.
NIO classes enable you to pack Java appli-
cations with efficient I/O routines for large

buffers, non-contiguous read-writes, chan-
nels, memory-mapped files, etc. Ron
Hitchen’s Java NIO gives you a compre-
hensive coverage of the topic. The book
makes for an interesting and
fruitful read.

It can be roughly divid-
ed into four sections: Chap-
ters one to four introduce
and elaborate the I/O con-
cepts, namely, buffers,
channels and selectors.
Chapter five deals with
Java regular expressions
Application Programming
Interface (API). Chapter six
talks about charsets,
another mystery for pro-
grammers deploying soft-
ware over multiple architectures. The
book also packs in appendices on NIO

and Java Native Interface (JNI), selectable
channel Shared Programming Interface
(SPI), and an NIO quick API reference. 

The book uses very focused
code examples to illus-
trate core topics, as well
as asides such as file
holes. Diagrams are intu-
itive and simple. Another
nice feature is simple Uni-
fied Modeling Language
(UML) class diagrams that
give you a quick overview
of various classes in the
NIO framework. 

The final word—Java
NIO is highly recommend-
ed to intermediate and
advanced Java developers

who want to keep abreast with the latest
without going through voluminous tomes.

Java NIO
It’s interesting to NIO

Publisher: Shroff Publishers and Distributors Pvt Ltd ■■  Authors: Ron Hitchens ■■  Phone: 022-27634290 ■■  Fax: 022-27683375
■■  E-mail: spd@vsnl.com ■■  Web site: www.oreilly.com ■■  Price: Rs 275
Rating: ★★★★ ✩✩

The SAMS Teach Yourself series of books
is widely popular because of the ease

with which they get you started
on the subject. SAMS Teach Your-
self Adobe Photoshop CS in 24
Hours treads the same path, and
is good enough at making you
understand what Photoshop
CS does. Photoshop CS is the
latest version of the premier
product from Adobe—the
sweetheart of graphic profes-
sionals across the world. This
book was one of the first few
written on Photoshop CS. In
fact, it was written on the
beta version of the product.

This 500-pages book is
divided into seven sections.

The first deals with basics such as 
opening, saving, selections,

etc. The second seg-
ment talks about
layers, masks and
paths, the third
about filters and the
fourth talks about
text and plug-ins.
The fifth part takes
care of photo-repair
and enhancements.
The sixth shows you
how to print your pic-
tures and use Photo-
shop CS for Web proj-
ects. A useful appendix
follows at the end.
You can download the

images used in the book from 
the publisher’s Web site. This makes
learning easier, as you can try out things
explained on the same photographs.
However, all the screenshots are taken
on a Mac PC. Windows users might not
be able to relate what they see in 
the book, and what they find on their
monitor screen. 

Another good aspect is the exercises
given at the end of the book. Trying 
out these ensures faster learning.
Though this book is in black and white,
there are 16 coloured, high quality pages
with some screenshots of what Photo-
shop CS can do. To sum up, here is a
decent book if you don’t know much
about Photoshop, and want an overview
of its features.

Publisher: Pearson Education (Singapore) Pvt Ltd  ■■  Author: Carla Rose ■■  Distributor: Pearson Education India ■■  Phone: 011-2146067 ■■  E-mail:
info@pearsoned.co.in ■■  Web site: www.samspublishing.com  ■■  Price: Rs 350
Rating: ★★★★ ✩✩

SAMS Teach Yourself Adobe Photoshop CS 
in 24 Hours
The clock is ticking…
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The folks at the Digit Test Centre 
are usually a quiet lot—they sit in 
their large quadrangle-type room,

where they tinker with motherboards,
RAM chips and monitors with the 
same delight of a kindergarten kid playing
with crayons. 

But imagine the delight of the Test
Centre folks when they asked several con-
sumer electronics and IT hardware com-
panies to send in their entertainment
products for testing. While comparing
their glee to giggly schoolgirls discussing
their latest plaything would be inappro-
priate, their excitement was nothing less
than what NASA scientists experience
soon after they see Mars Rover spacecraft.

Nevertheless, once the products
arrived—7.1 speaker systems, a Media
Center PC, DVD players, an Internet
radio, a 5.1 headphone set, a LCD TV, and
TV tuner cards - these guys got back to
their work with the seriousness of an
Andrew Wiles trying to solve Fermat’s
Last Theorem. 

... Or so it seemed
Mysteriously, they never came out to talk
to people, or lunch with them, or even
play table tennis—Digit’s favourite pas-
time whenever they are stressed or want
to escape the boss. Strangely enough,
some sounds began to emanate from the
usually pin-drop-silence TC zone. And
boy, were they sounds or what!

A U2 Live Concert DVD on a seven-
channel speaker system was by far 
the most popular entertainment option.
But not once did they ever say to us:
“Wish you were here.” And since they
were huddled around the speakers for
most part of the day (and sometimes 
well into the night), the others felt 
the TC should change its anthem to Good-
bye, blue sky, Pink Floyd’s most evocative
anti-war song.

But surely, the TC was indeed like a
war zone, with most Digit team members
trying a get piece of the entertainment
pie. One person wanted to watch Tom
Cruise’s Minority Report, while others
wanted the other Tom—the one who goes
around with the Hanks surname— in his
Oscar-winning Forrest Gump.

Those with a quiet demeanour settled

for the 5.1 surround headphones with
three jacks. One for the rear effect, one
for the front, and one for the centre
speaker. Even the traditionally-ignored
stereo headphones were in demand.

In between, the bigger audiophiles
among the group would switch on 
DVD audio, making music listening 
truly divine.

The story does not end here. There
were other interesting products being
tested this month—such as the Hand-
spring Treo 180 and the Nokia 6600, a
camera phone that can surprise the most
hardened cynics with its features. Deepak
Dhingra, who heads the Test Centre, and
who grew a natty French beard to com-
plement his ‘newly-acquired 6600’, went
around clicking candid photos that even
our in-house professional cameraperson
Mexy Xavier would be proud of.

Another phone, the flip-model BenQ,
was with Sachin Kalbag, who styles him-
self as this magazine’s features editor. As
a full-fledged, card-carrying member of

the Boys With Toys club, Sachin even
played a prank on his wife telling her 
he bought a Rs 10k phone just for the
heck of it. She promptly threatened
to not speak to him for an unspecified 
period. Thankfully, the said period was
just 10 hours.

Meanwhile assistant editor, Sumod
Hajela, went around flaunting the Hand-
spring Treo 180 for a day or two, until he
found out that Handspring has actually
discontinued the model in the US, but a
few importers have been bringing the
model to India only recently. He would
then strategically hide it, determined to
now flaunt a Treo only if the model num-
ber was 600, a current favourite in the US.

The month of February was an event-
ful one for most people at the Test Centre,
thanks to the consumer electronics and
IT entertainment products bonanza. We
already hear that the engineers in there
have put in a requisition for 72-inch
home theatre systems. Wait till they 
get that! 

Testing Mischief
Monkey business at its best at the DIgit Test Centre

Mahesh Benkar
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a. 5,50,000 degrees 
Celsius 

b. 5,500 degrees Celsius 
c. 550 degrees 

Celsius 
d. 55,00,00,000 degrees

Celsius

Which is the brightest star,
apart from the sun, visible to
the naked eye?
a. Sirius
b. Rigel
c. Vega
d. Procyon

After the sun, which star is
closest to us?
a. Alpha Centauri
b. Sirius
c. Proxima Centauri
d. Rigel

Galileo, NASA’s  probe,
was launched in 1989, and
spent 14 years charting
Jupiter and its moons. It was
pulled down in Sept 2003, due
to lack of fuel propellant. How
far did it travel?
a. 24 million Km
b. 3.14159 billion Km 
c. 0.07 light years 
d. 4.6 billion Km

The first human was
sent into space on April 12,
1961. Who was it? 
a. Neil Armstrong
b. Valentina Tereshkova
c. Rakesh Sharma
d. Yuri Gagarin

Which rocket launched all
the Apollo missions? It is one
of the most powerful rockets
ever built.
a. Saturn V
b. Jupiter II 

c. Apollo 17 
d. CAC-1

Who was the
first, and only, 
Chinese astronaut?
a. Ai Chin Liu
b. Yang Liwei 
c. Jackie Chan 
d. Taikonaut

Name the spacecraft
launched by China in 
October 2003.
a. Ananova
b. Yuhangyuan
c. Dragon Space 
d. Shenzhou V

What was the last Apollo
mission? 
a. Apollo 23
b. Apollo 17
c. Apollo 27
d. Apollo 15

What does the name of the
Russian space station, Mir,
which was brought down in
2001, mean? 
a. Peace b. Unity 
c. Freedom d. Water
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This month’s theme: Movies

Across
2. Based on comic, a team

fights for a world which
hates them

6. I’ll be back
7. The battle for Princess

Leia
8. Popularly known in their

circle as Hax0rs

Down
1. Bill Gates recruits a 

person to write software
to interconnect all 
multimedia devices 
on planet

3. "You are the one!"
4. Starring Captain Jean 

Luc-Picard
5. It’s fun to control that nuclear 

missile with my home PC.

■ qubit

What is the temperature on the 
surface of the sun?
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…that a teaspoon of neutron
star material weighs about 
110 million tons?

One is called Spirit;
what is the other NASA
Mars rover called?

4

a. Apollo 
b. Columbia  
c. Opportunity 
d. Lunakhod 

did you know

Got an interesting question? 

Send it in with the correct 

answer to quiz@thinkdigit.com

numberette

Powered by

A typical nova explosion

releases about as much

energy as the Sun 

emits in 10,000 years,

or as much as in

1,00,00,00,00,0
0,00,00,00,00,
000 nuclear bombs

1 to 5 Way to go...

6 to 10 Good, if you like
being mediocre 

11 to 15 Your next job could
be with us!

QUOTIENT

Quiz
1: b2: a
3: c4: c
5: d:6 d
7: d8: a
9: b10: d
11: b12: a

Crossword
Across: Down:
2. Xmen, 1. Antitrust, 
6. Terminator, 3. Matrix, 
7. Star Wars, 4. Startrek, 
8. Hackers. 5. War games

Answers

Which Indian 
cosmonaut was the
backup for Rakesh Sharma
on the Soyuz T-11 trip into
space?

6

a. Bahadur Shah
b. Rakesh Haryani 
c. Rakesh Malhotra 
d. Ravish Malhotra
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